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ADD I KALT

For some years, proponents of distance and online learning have touted the
efficacy of their methods, while traditionalists have argued the superiority of
face-to-face learning environments. Each side in this debate has pointed to
strengths in their own methodologies, while criticising the lack of comparable
features in the methodologies of their opponents. Blended learning, as the
name implies, allows practitioners to combine traditional education with a
variety of instructional technologies — solving the argument by joining forces,
and creating a better overall product as a result. With this study the
researcher aims to explain the concepts of blended learning and discuss the
factors that make each form of educational delivery successful. The thesis
addresses the necessary components of a computer literacy programme and
Outcomes-Based Education, as well as elaborate on good teaching principles.
These strands of research are then combined into the foundations for a
unique programme, to deliver a computer literacy course using blended
learning techniques to South African students. The programme was
developed, implemented and tested through three cycles of action research.

Keywords: Blended learning, computer literacy, computer-assisted learning,
e-learning, online learning, instructional technologies, web-based instruction.
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CHAPTER ONE

INTRODUCTORY ORIENTATION

1.1 INTRODUCTION

“Blended learning can be described as a leamning programme where more than
one delivery mode is being used with the objective of optimising the leaming
outcome” (Singh & Reed, 2001:1). It is quite possible that even educationists at
the cutting edge of their field may not recognise the term “blended leaming”. As
stated by Kiser (2001:Online), the term “blended leaming” came to the fore only
in the year 2000. It refers to the mixing and integration of different leaming
delivery approaches, including face-to-face classroom leaming, e-learning and
self-paced computer-mediated leaming to create a single leaming programme.
Unlike earlier concepts where e-leaming and face-to-face classroom leaming
were seen as mutually exclusive, blended leaming is seen as the AND model
rather than the OR model. It is about using the best of all worlds to create the
most effective integrated offering. It combines the power and effectiveness of the
classroom with the flexibility and any-time nature of e-leaming and allows
learning to be more tailored and more individual. Marsh (2001:Online) underlines
the fact that blended leaming, which combines e-leaming tools with traditional
classroom training to ensure maximum effectiveness, is one of the leading trends
in training today.

1.2 STATEMENT OF THE PROBLEM
. “Computers” is the buzzword of the time. Never before has technology spread so

. rapidly. Never has an invention enabled so many people to do so many things
that are strategically important to life in the information society. It has become so

© Central University of Technology, Free State



Central University of
Technology, Free State

strategically essential, that being able to use a computer, has become a basic
skill, even a literacy in its own right (Hofstetter, 1998:xii; Long and Long,
1999:xvii: Shelly, 1999:1.1). |

/'-’—'—

As the use of computers in society increases, so does the demand for training
people to attain the skills necessary to use the required technology. Furthermore,
many higher education institutions in South Africa have made it compulsory for all
students to complete a basic computer literacy course.This leads to the fact that
training institutions are inundated with large numbers of students who need to be
trained in computer literacy. Computer literacy entails practical training that
necessitates the forming of groups. The number of groups is determined by the
number of computers available in the computer laboratories, e.g. if 2000 students
are enrolled and there are 50 computers in the lab, there will be 40 practical
groups. This places a heavy burden on lecturing staff. By combining face-to-face
lecturing with the use of self-paced e-learing methods, it is envisaged that large
numbers of students can be accommodated more effectively.

Countries like the United States of America, Britain and Australia are currently
presenting computer literacy courses where e-leaming techniques are combined
with face-to-face classes (Spear, 1999:3). However, because of the fact that
South Africa is on the disadvantaged side of the digital divide, it is not possible to
copy such courses and present them in the same format in South Africa. Digital
divide is the term used to describe the technology gulf that separates the
computer-literate rich from the world's poor masses (Hofstetter, 1998:6). There is
a need to develop courses that, on the one hand comply with global standards,
and on the other hand suit the needs of the particular circumstances of South
African students and meet the requirements of the South African outcomes-
based education (OBE) approach.

© Central University of Technology, Free State
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Taking the above-mentioned factors into consideration, the questions to be

answered in this study are:
< What is the role of blended leaming in education?

@ What influence do the principles of good practise and OBE have on
developing a blended learning, computer literacy programme?

@ What factors should be taken into account in developing a blended learning
computer literacy programme for South African students?

@ Can a blended leaming computer literacy programme be effectively
implemented for South African students?

Answers to the above-mentioned questions form the basis of this study.

1.3 AIM OF THE RESEARCH

/The researcher’'s primary aim with this study is to establish the factors that should
be taken into consideration in developing a blended leaming computer literacy
programme for South African students and to develop such a programme to
ensure that effective teaching and leamning can take place.

In order to accomplish this aim, the following objectives should be realised by this
study:

# to establish the role of blended leaming in education by researching the
different methodologies that can be used in presenting blended leaming
programmes;

< to determine how the principles of good practice and OBE influence the
development of a blended leaming computer literacy programme, by
researching the core elements of good practice, OBE and computer literacy;
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< to investigate the most appropriate way to go about developing a blended
learning computer literacy programme in the South African context, and

@ to establish how a blended leaming computer literacy programme can be
implemented to enable more productive computer training; implement such a
programme and evaluate the outcomes of the programme.

1.4 PRELIMINARY LITERATURE REVIEW

Computer literacy is defined by O’Leary and O’Leary (1996:xiii) as being able to
employ a microcomputer to increase productivity and effectiveness. Productivity
software, that includes applications such as word processing, spreadsheet,
database, presentation graphics, personal information management, accounting,
project management and other related types of software, is designed to make
people more effective and efficient while performing daily activities (Shelly,
1999:2.7). A computer literacy programme would thus have to include teaching
people to use at least one or two of these important tools. Furthermore, people
from all walks of life are using the Intemet on a daily basis (Hofstetter, 1998:5).
The Hobbes’ Intemet Time Line gives startling information as to how the number
of Internet users has grown during the past few years. The number of Internet
hosts, which each has a number of Intemet users, grew from 313 000 in October
1990 to 171 638 297 in January 2003 (Hobbes, 2004:Online). Taking this into
consideration, it could therefore be deduced that people taking a computer
literacy course, should also leam to use the Intemet and the various kinds of
possible uses it offers.

With the policy of the South African govemment (Department of Education,
1997:2) to implement outcomes-based education (OBE) as the methodology of
teaching in South African schools in 1998, it has become necessary for higher
education institutions to redevelop courses to comply with the principles of the
OBE methodology. An outcome can be seen as the result of the leaming process

© Central University of Technology, Free State
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and refers to what the leamer knows and can do (Isaacman, 1996:4). A computer
literacy programme for South African students would thus have to lead students
to know how and be able to use a microcomputer to increase their productivity
and effectiveness. The proposed programme indicates a practical approach
rather than merely leaming about the technical aspects related to computers.

The envisaged programme resulting from this study will be based on the
fundamentals of the methodology of blended leaming. As indicated in the
introductory paragraph, blended leaming is a leaming solution, which includes
face-to-face, live e-leaming and self-paced leaming (Valiathan, 2001:1). Blended
leaming means different things to different people, and can variously be defined
as (Strategic Visions Intemational, 2002:0nline):

@ combining modes of web-based technology to accomplish an educational
goal,

@ combining various pedagogical approaches (e.g. constructivism, behaviorism,

cognitivism) to produce a learning outcome with or without technology, or

@ combining instructional technology with actual job tasks to create a synergy
between leaming and working.

The primary leaming delivery methods of a blended leaming solution are:

@ Face-to-face classroom training, i.e. instructor-led training in the classroom.
This setting is best for hands-on access to equipment, complex curricula, and
high interactivity needs.

@ Synchronous e-leaming, i.e. virtual classroom e-leaming that delivers live
instructor-led training. This setting leverages the best instructional elements of
the classroom while taking advantage of technology benefits. Students and
instructors can collaborate on content, participate in coaching or mentoring,
access software and hardware remotely, and save the time and costs of
travelling.

© Central University of Technology, Free State
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@ Asynchronous e-learning, i.e. self-paced e-leaming, either accessing study
material from the Intemet, or from a CD. This is a quick and cost-effective
method, and good for providing introductory, prerequisite leaming, and
refresher courses.

According to Reay (2001:1), blended leamning has become all-pervasive in the
training industry. Rather than creating an artificial divide between e-leaming and
the more traditional approaches, many institutions are attempting to find the best
mix of both to provide the most effective learning solution. However, successful
implementation requires:

@ an understanding of the strengths of the respective delivery media;

@ recognition of how leamers approach and use information directed through
each medium;

@ an awareness of available knowledge resources, and

@ how resources can best be leveraged through online and traditional teaching
methods.

1.6 RESEARCH DESIGN AND METHODOLOGY

1.5.1 The design

The qualitative method of research, and in particular the participatory action
research component thereof, is to be implemented in this study. Qualitative
research enables the researcher to examine people’s words and actions and
report in narrative and descriptive ways - more closely representing the situation
as experienced by the participants (Maykut & Morehouse, 1995:2). Hummelvoll
and da Silva (1998:465), as well as McMillan and Schumacher (1997:372-373),
state that qualitative researchers accumulate data by interacting with selected

© Central University of Technology, Free State
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individuals in their settings (field research) and by acquiring documents relevant
to the study.

McNiff (2002:15) asserts that participatory action research is used to improve
practice rather than to produce knowledge. The fundamental aim of action
research is to integrate instruction and instructor development, curriculum
development and evaluation, research and philosophical reflection into a unified
conception of a reflective education practice (Elliot, 1992:54). Charles (1995:220)
asserts that this kind of research is frequently used by instructors in graduate
studies programmes. As the focus of this study is to develop an efficient
computer literacy programme for undergraduate students, it is deemed
appropriate to implement action research in this research study.

In addition to qualitative research, the researcher will employ quantitative
research strategies in the study. Quantitative research deals with quantifying
relationships between variables (Hopkins, 2000:0Online). Quantitative studies can
either be descriptive or experimental. In a descriptive study, no attempt is made
to change behaviour or conditions - things are measured as they are. There are
countless texts that distinguish between quantitative and qualitative research and
demonstrate a loyalty to the one or the other (Pring, 2000:1). Pring (2000:2)
states that, although the two methodologies are often seen in opposition, an
either/or position is misleading and the two methodologies should rather be used
simultaneously to supplement each others weaknesses and strengths.
Quantitative research will form a small part of this study, but is deemed
necessary to build a profile of the students with regards to factors like, for
instance, the access students have to computers outside the university campus
and the experience of working on computers before enrolling for the envisaged
course.

© Central University of Technology, Free State
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1.5.2 Data collection and analysis

Silverman (2000:90) asserts that qualitative research can be performed by
observations, accumulating texts and documents, interviewing people or making
audio and video recordings of naturally occurring interactions. During this study
relevant texts and documents will be accumulated and semi-structured interviews
will be conducted. Through qualitative interviews researchers can understand
experiences and reconstruct events in which they did not previously participate
(Rubin & Rubin, 1995:1). The quantitative data will be collected by requesting
participants to complete questionnaires.

The participants to the research study will be selected by using the method of
purposeful sampling, which according to Mason (1996:93), “... means selecting
groups or categories to study on the basis of their relevance to your research
questions, your theoretical position ... and most importantly the explanation or
account which you are developing.”

McKeman (1996:15-28) provides a detailed list of different models of action
research that were suggested by educationalists. The list includes models of
Lewin (1947), Taba & Noel (1962), Lippet and Radke (1946), Elliot (1978), Ebbut
(1983) and a number of other specialists. The most important characteristic that
emerges from all of these models, is that action research is executed in a series
of spiralling decisions, taken on the basis of repeated cycles of analysis,
reconnaissance, problem conceptualising, planning, implementation and
evaluation. Schmuck (1997:50) and Sagor (1992:23) suggest that action
research should consist of a number of cycles, each consisting of three basic
phases, i.e. initiation, detection and judgement.

< In the initiation phase an action researcher should reflect on the future and
inquire about what actions might be taken first. This phase is referred to as
“research for action’.

© Central University of Technology, Free State
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« Detection calls for an action researcher to monitor and adjust his/her actions
from time to time. Detection requires reflection on the present. This phase is
called “research in action”.

< In the judgement phase, researchers collect data on the results of their own
actions over a period of time, and is called “research of action”. Judgement
entails a kind of reflection on the past; it is systematic inquiry into what has or
has not been achieved after testing the actions over a considerable period of

time.
The research in this study will be conducted in a number of cyclic phases.

Data will be collected by implementing the following research techniques:

& A thorough literature study of the aspects and concepts imbedded in
developing a blended learning programme will be undertaken.

< Quantitative data will be collected by requesting students to fill in
questionnaires. A profile of students’ accessibility to computers will be formed
by presenting the numerical data in the form of pie charts.

# The programme will then be developed and implemented at one site for a six
month period.

< While the programme is running for the first time, data will be collected by
means of questionnaires, semi-structured focus group interviews and
observations.

@ After the initial implementation, the programme will be revised according to
the results from analysing the data.

@ The revised programme will be ir‘ﬁplemented at a number of different sites
and a further” cycle of data collection will be undertaken, using the
questionnaires, semi-structured interviews and observations.

@ After analysing the data, the programme will be changed accordingly and the
result of this study, the final blended leaming programme, will be produced.

© Central University of Technology, Free State
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According to Maykut and Morehouse (1995:126), one of the defining
characteristics of qualitative research is the inductive approach to data analysis,
where data is collected that relate to a focus of inquiry instead of a hypothesis
being generated. The constant comparative method is one way to conduct an
inductive analysis of qualitative data and this is the method that will be used to
analyse the data collected in this study.

In addition to the above-mentioned methods used for collecting data, the
following methods, specifically used in action research, will also be employed
(McKeman, 1996:81-91):

@ The researcher will keep a journal to record events.

@ A profile of the envisaged programme will be set up. This profile will provide a
structure to evaluate the success of the implementation of the programme.
The profile will include evaluations of the contents of the programme, the
manual that will be developed, the media or technology that will be used and
the implementation strategies that will be followed.

@ The researcher will use a checklist, that is a set of questions one answers
oneself, to evaluate the process of implementation.

@ Document analysis will be done involving all documentation relevant to the
programme, e.g. the study guide, curriculum, tests, examination papers,
examination results and student assignments.

The trustworthiness of the research will be ensured by using multiple methods of
data collection, as well as building an audit trail (Maykut & Morehouse,
1995:146).

10
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1.6 DELIMITATION OF THE STUDY

The study will be performed in the field of Didactics. Both qualitative and
quantitative methods of research will be used to accumulate data to be able to
integrate teaching methodologies in developing a blended leaming computer
literacy programme for South African students. This programme will be
implemented at the Welkom campus of Vista University during the first semester
of 2003. The programme will be evaluated through action research and then
changed according to the results of the data analysis. The changed programme
will be implemented at the other campuses of Vista University, i.e. Bloemfontein,
Port Elizabeth, Mamelodi, Soweto and East Rand during the second semester of
2003. During this phase, July — November 2003, data will again be collected.
This data will be analysed in December 2003 and the programme will be
changed once more. The final programme will then be produced to be
implemented in 2004.

1.7 LIMITATIONS OF THE STUDY

Modem technology, e.g. videoconferencing facilities and up-to-date computers
with high-speed Intemet connectivity is not freely available amongst the
developing communities of South Africa. This factor could limit the design of the
envisaged programme.

Vista University, a multi-campus institution, is set to unbundle and merge with a
number of other Higher Education institutions at the beginning of 2004. This may
mean that the programme will not necessarily continue to run on all campuses
from the year 2004 onwards. The researcher, however, believes that this
research will result in such an excellent programme that merger partners could
be convinced to continue using the blended leaming programme.

1
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1.8 PROGRAMME OF THE STUDY

Chapter One: Introductory orientation

In Chapter One, the researcher gives a statement of the research problem, and
outlines the aims of the study. A brief literature overview provides definitions for
the key concepts computer literacy, outcomes-bases education and blended
leaming. The methods of the research are outlined, indicating the research
methodologies, the design and the data collection and analysis procedures to be
used.

Chapter Two: Blended learning

Chapter Two provides an in-depth literature study of concepts related to the
blended leaming methodology. It investigates different elements that can be used
in a blended leaming programme looking at both the advantages and
disadvantages of each of these elements. Furthermore, the chapter provides
sound instructional design principles that can be followed to develop an effective
blended leaming programme.

Chapter Three: Blending principles of good practice, computer literacy and
outcomes-based education

In Chapter Three the researcher reviews literature related to principles of
computer literacy, outcomes-based education and good teaching methods. The

aim of this review is to establish a sound pedagogical framework for developing
the envisaged programme.

12
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Chapter Four: Research methodology, data collection and analysis

Chapter Four gives a detailed account of the research methods implemented in
this study. It explains how the cycles of action research are applied, how data is
collected and analysed and gives the final conclusions and recommendations of
the research.

Chapter Five: An outcomes-based computer literacy programme for South
African students presented by the methodology of blended learning.

The final product that resulted from this study is presented in Chapter Five.

1.9 CONCLUDING REMARKS

For some years, proponents of distance and online leaming have touted the
efficacy of their methods, while traditionalists have argued the superiority of face-
to-face leaming environments. Each side in this debate has pointed to strengths
in their own methodologies, while criticising the lack of comparable features in
the methodologies of their opponents. Blended learning, as the name implies,
allows practitioners to combine traditional education with a variety of instructional
technologies — solving the argument by joining forces, and creating a better
overall product as a result. With this study the researcher aims to explain the
concepts of blended learning and discuss the factors that make each form of
educational delivery successful. The thesis will address the necessary
components of a computer literacy programme and OBE, as well as elaborate on
good teaching principles. The aim is to combine these strands of research into
the foundations for a unique programme, to deliver a computer literacy course
using blended leaming techniques to South Africa students. The programme will
be developed, implemented and tested through three cycles of action research.

13
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CHAPTER TWO

BLENDED LEARNING

2.1  DEFINITION OF BLENDED LEARNING

Literature reveals a number of different definitions for blended learning. The
most widely used definition of blended leaming, is that it is the integrated
combination of traditional, face-to-face methods of learning with web-based,

online approaches (Harrison, 2002:Online).

However, Driscoll (2002:0Online) found in her research that the term can
actually refer to any of the following scenarios:

< to combine or mix modes of web-based technology (e.g., live virtual
classroom, self-paced instruction, collaborative learning, streaming video,
audio, and text) to accomplish an educational goal;

< to combine various pedagogical approaches (e.g., constructivism,
behaviourism, cognitivism) to produce an optimal learning outcome with or
without instructional technology;

= to combine any form of instructional technology (e.g., videotape, CD-ROM,
web-based training, film) with face-to-face instructor-led training and

< to mix or combine instructional technology with actual job tasks in order to

create a harmonious effect of learning and working.

Labrow (2002:0nline) asserts that blended learning is simply the mixing of
more than one type of learning within a single learning programme, and
according to Smith (2001:0nline), it is a new surge combining the synergy of
consulting services and content via several deliveries including web-based,
self-paced and instructor-led classes. The focus is on improved performance

of both students and educators.
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According to Masie (2002:137), blended learning is the use of two or more
distinct methods of training. This may include combinations such as:

< blending classroom instruction with on-line instruction;
% blending on-line instruction with access to an instructor,
% blending simulations with structured courses and

< blending managerial coaching with e-learning activities.

The fact that blended learning means different things to different people may
appear to be a problem, but in reality these definitions illustrate the untapped
potential of this methodology.

The following section looks at reasons why blended leaming has become
such a popular trend in education. v

2.2 WHY SELECT BLENDED LEARNING?

According to Reay (2001:6), blended learning has become all pervasive in the
training industry. Rather than create an artificial divide between e-learing and
more traditional approaches, many organisations are attempting to find the
best mix of both to provide the most effective learning solution. It should be
noted that e-learning is often seen as the equivalent of on-line distance
learning. However, in this study the researcher prefers to use the broader
definition of e-learning, i.e. that it is anything delivered, enabled, or mediated
by electronic technology for the explicit purpose of leaming (Hicks, 2000:75).

Ward and LaBranche (2003:22) assert that blended learning is often referred
to as the best of both worlds where learning events take place by combining
aspects of face-to-face instruction and e-learning. It is seen as a powerful
strategy that expands and enhances the leaming experience.
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McCampbell (2001:71) identifies some of the strengths of e-learning:

&

The use of varied e-leaming methods results in highly engaging

programmes.

Huge cost savings come from students not needing to leave their work, or
homes and travel long distances.

Students progress at their own pace and do not hold back others or
become bored by a slower pace. Students can repeat parts of a
programme that are not clear to them.

Students can complete learning at times that work best for their schedules.
Many students learn more effectively on their own rather than in groups.

E-learning seems especially appropriate for transfer of information and
cognitive understanding.

Complex performance skills can be learned efficiently with technology-
enhanced learning such as flight simulators.

Highly efficient e-learning programmes can be developed by following the
principles of good instructional design.

According to McCampbell (2001:71), centuries of experience have shown the

power of students coming together for face-to-face lectures. The following are

some of the strengths of face-to-face learning:

&

The enthusiasm of the facilitator for the content is contagious and
encourages leaming.

Students prefer to learn in a social situation.
There is accountability in a classroom that is missing in e-learning.
Learning occurs casually and indirectly when individuals interact.

Instructor-led sessions remove students from their daily work
responsibilities, so participants can focus on learning. There is no such
protection when using e-learning methods.
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@ The questions and comments of students help raise and address
important issues, and make it comfortable for others to talk.

@ The pattern of learning in a group environment is established in almost

every educational institution and connects with past learning experiences.
<+ The facilitator speeds up the process of knowledge acquisition.

@ Classroom experiences provide opportunities for students to practise and
rehearse skills and to receive feedback from others.

Bersin (2003:0nline) states that e-learning became a craze in the late 1990's
- every training institution started an initiative, purchasing training software,
and putting courses and instructors on the web. However, now that the first
few millions have been spent, important questions need to be asked:

< What results are achieved from the e-learning programmes?
% How can results of all the training be correlated and measured?
= Which of the investments is giving the highest return?

=« Should investment in e-learning be increased or decreased?

The unfortunate truth is that many e-learning programmes do fail, often as a
result of under-estimating the complexity of the development, rollout, or
measurements needed. In many instances the emphasis is on the “e” of e-
learning instead of focusing on the learming part thereof. Reay (2001:6) re-
enforces this idea by stating that e-learning brings advantages and new
opportunities to the learning situation. However, its limitations, particularly in
presentation and delivery, affect the content and design of material and the
effectiveness of the learning process. For many learning needs there is
nothing that surpasses real-time presentation to an audience or face-to-face
tuition. This fact results in the growing trend to integrate e-learning into
conventional learning, creating blended learning programmes.

Harris (2002:Online) stresses that the need for blending is simple: students
are very different, and if training solutions should be developed that will work
for many students, then the differences must be acknowledged,
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accommodated and catered for, b;mgrzzt:r;:r?agmthe maximum range and variety
of learning opportunities. Some students like to work on their own, without any
direction at all. Others also like to learn on their own, but in a structured and
directed environment. Still others prefer socialized leaming which entails
working through concepts and formal principles by experimentation in a
primarily social context, and others like to reflect privately on material,

whether presented on the electronic or traditional page.

The world-class Thomson Job Impact Study (Harris, 2002:Online), the first of
its kind to measure the effectiveness of blended learning against single
training options, developed a study in collaboration with leading corporate
organizations and academic institutions including Lockheed-Martin; Utah
State University; University of Limerick, Ireland, Anoka-Ramsey Community
College, Minnesota, Executive Service Corps of Chicago; and
KnowledgePool.

The first phase of the study, released in 2002, aimed to determine if there
were significant differences in the accuracy and time it took students to
perform real-world tasks after using blended learning training approaches, e-
learning training programmes or no training at all. Results from this phase
revealed that a structured curriculum of blended learning generated a thirty
percent increase in accuracy of performance and a forty one percent increase
in speed of performance over single-delivery options. Lead researcher Stacey
Boyle (Harris, 2002:Online) says the biggest surprise was the fact that the
students who were exposed to the blended curriculum were able to save so
much time performing the tasks. “What it really means is that those who had
the blended learning were able to work more efficiently,” and that "They had
the resources available to them, and the instruction was structured better for
them to be successful at the real-world task at the end.”

Boyle and her team also identified five core features as contributing to the

success of the blended leaming model used in the study, namely:

# access to live mentors during the online portion of the training;
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& assessments designed to mime real-world tasks;
<+ early use of the software being taught;
< integration of learning objects with realistic scenarios and

@ use of scenario-based exercises to teach the software application.

The second phase of the study sought to identify the essential instructional
components of a successful blended learning solution. The researchers
studied five separate groups of students to compare e-learning with three
different types of blended learning solutions: instructor-led training, text-based
programmes and scenario-based exercises.

@ The instructor-led training group received blended learning driven by

scenario-based exercises within the context of an instructor-led course.

< The text blend group received scenario-based exercises that included
access to text objects.

# The scenario-based exercise group received scenario-based exercises
that included access to NETg Learning Objects (NLOs).

< The e-learning group received a standard e-learning course.

@ The control group was established to benchmark performance and did not
receive any training.

All of the groups completed a post-assessment and three real-world tasks.

As in phase one of the study, the new results also confirm that a defined
blended learning solution heightens overall on-the-job performance achieved
by e-learning alone and that either blended or single-delivery models are
more effective than no training at all. When compared with the e-learning
group, the blended learning groups were twenty seven to thirty two percent
more accurate in task performance and performed the tasks forty one to fifty
one percent faster.
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The following remarks by Ward and LaBranche (2003:23) summarise why

blended learning is fast becoming the most popular teaching methodology:
“Like something that is greater than the sum of its parts, blended learning
offers the potential to offer a better learning experience and greater value.
Blended learning is a student-centered strategy. Students have more options,
more time and more freedom to explore learning. It extends learning before or
after the physical learning experience, and enhances learning by taking the
student outside of the traditional classroom to take advantage of the power
and depth of the Internet and other e-learning opportunities.”

As indicated in the previous paragraph, blended learning solutions can
enhance learning programmes. However, the promise of effectiveness and
value that blended learning brings to the table depends upon thorough
evaluation of the many delivery options available and a well thought out
strategy for integration and implementation (Strategic Visions International,
2002:0nline).

2.3 WHATIS THE RIGHT BLEND?

In blended learning, it is not the mixing and matching of different learning
delivery modes by itself that is of significance, but the focus on the learning
outcome (Singh & Reed, 2001:1). They therefore propose a refined definition
for blended learning by stating that it focuses on optimising achievement of
learning objectives by applying the “right” learning technologies to match the
“right” personal learning style to transfer the “right” skills to the “right” person
at the “right” time.

The following principles are embedded in this definition:
@ focus is place on the learning objective rather than the method of delivery;

@ many different personal learning styles need to be supported to reach
broad audiences;
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# each student and instructor brings different knowledge into the learning

experience and

@ in many cases, the most effective learning strategy is “just-what-lI-need,
just-in-time”.

According to Valiathan (2002:1), there is no single formula that guarantees
effective learning, but there are some guidelines which categorise blended
learning into three models:

<= skill-driven learning, which combines self-paced learning with instructor or
facilitator support to develop specific knowledge and skills;

@ attitude-driven learning, which mixes various events and delivery media to
develop specific behaviours and

< competency-driven learning, which blends performance support tools with
knowledge management resources and mentoring to develop workplace
competencies.

Reay (2001:6) asserts that blended learning is not just about adding online
materials to a conventional training catalogue. Blended learning must be
relevant, and demand a holistic strategy leveraging the best characteristics of
all learning interventions, as well as considering the mix of mediums, e.g. how
a blend of synchronous, instructor-facilitated and asynchronous, self-directed,
self-paced approaches can best be combined to meet student needs. An
effective blended approach will find the strengths and supporting
competencies of traditional classroom training, presentations, stand-alone
interactive online training and asynchronous and synchronous Web-based
training. Successful implementation requires an understanding of the
strengths of the respective mediums, recognition of how students approach
and use information directed through each medium and an awareness of
available knowledge resources and how they can be best leveraged through
online and traditional teaching methods.
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In this study the researcher investigates the strengths and weaknesses of the
different mediums that can be used in a blended learning approach (cf. 2.4).
In a further quest to find the right blend, the researcher looks at sound
instructional design models (cf. 2.5), as well as principles of good teaching
practice (cf. 3.4).

24 ELEMENTS OF BLENDED LEARNING

The following sections look at the advantages and disadvantages of different
types of elements that could be selected to form part of a blended learning

programme.

2.4.1 Printed material

.

Print is the foundation of any form of educational delivery. While the
technological developments have added to the repertoire of tools available to

———— ‘-:—.‘n‘ﬂ.\l

instructors, print continues to be a significant component of all education
programmes (Wills, 2001:0nline).

Hartley (1995:279) asserts that a student should receive a package of study
material, which includes a wide variety of printed materials. These could be
study guides, books of readings, text on design and quality assurance of
assignments, curriculum planning and assessment guides.

A number of different printed materials can be used as part of educational
programmes. Some examples are:

F; Textbooks

f Wills (2001:0Online) claims that textbooks should be the basis and primary
source of content for the majority of educational programmes. Textbooks play
a critical role — specially when the student and instructor are not in daily
contact.
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e Study guides

The main purpose of a study guide is to guide students in their study through
the source of content (Holmberg, 1995:71). The study guide could contain
some of the content of the programme, but the bulk of content comes from a
textbook, a collection of readings or a combination of these two sources.
Study guides should include activities, related readings and additional
resources available to the student. In deciding to use a study guide an
instructor can take advantage of using one or more high-quality textbooks. On
the down-side, it is unlikely that an instructor will find a textbook which
precisely matches the curriculum. Furthermore textbooks can change
editions, go out of print or simply become too expensive for students to buy.

o Self-contained study manuals

Holmberg (1995:71) distinguishes between study guides and self-contained
study manuals. A self-contained study manual contains all the content or
subject matter, as well as the guidelines that would be included in a study
guide. To produce a self-contained study manual, the instructor therefore has
to write everything which would go in a textbook, as well as all the activities
which turn it into a tutorial in print. He suggests that the latter may be used in
cases where the programme content is fairly elementary and does not call for
a study of different sources.

An advantage of using self-contained study manuals is that programme
content can be tailored precisely to the programme. Furthermore, content,
examples and case studies can be chosen to be appropriate for the local
situation and everything the student needs is under the control of the
instructor. The major disadvantage of using self-contained study manuals is
the time and resources needed to produce a manual of high quality.

 —

o Workbooks
Workbooks are often used to provide programme content in an active manner.

| A typical format may contain an overview, the content to be covered,

A
.

23

© Central University of Technology, Free State



O

Central University of
Technology, Free State

exercises or case studies to elaborate the points being made and a quiz or
test (with an answer key) for self-assessment (Wills, 2001:0nline).

e Syllabus

Students should receive a comprehensive and well-planned programme
syllabus that provides programme outcomes, performance expectations,
descriptions of assignments, related readings, grading criteria and a schedule
to be followed by the student in order to cover the content within a given
timeframe (Spear, 1999:3). A syllabus must be as complete as possible in
order to guide the students through the programme, specially in the absence
of daily contact with the instructor. Sorrentino (1997:0Online) adds that a
syllabus should include programme goals, performance objectives, examples
of student work as well as information on how to contact the instructor.

The following are some advantages of using printed material:

< From a teaching point of view, print is by tradition a powerful medium.
Reading is second nature to most students. As a result, they are easily
able to focus on the content without becoming mesmerised or frustrated by
the process of utilising all kinds of technology (Wills, 2001:0nline).

+ Print materials can be used in any setting without the need for
sophisticated presentation equipment. Given adequate light, print
materials can be used any time and any place without the aid of
supplemental resources such as electricity, viewing screens and specially
designed electronic classrooms. This portability aspect is particularly
important for rural students with limited access to advanced technology
(Kember, 1991:40)

< Both Wills (2001:Online) and Kember (1991:40) agree that print materials
are typically student-controlled, meaning that a student can decide in
which order to access the material. A student can for instance decide to
rapidly move through redundant sections and focus on areas which
demand additional attention.
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= Printed material is undoubtedly the least expensive instructional tool to
develop (Keegan, 1996:174). Furthermore, there are many established
facilities to produce these materials.

@ |n comparison to technically sophisticated electronic software, print is both
easy and inexpensive to edit and revise. New electronic production leads
to printing on demand, meaning it is not necessary to have an estimated
number of copies duplicated — but material can be printed as students
register (Macdonald-Ross, 1995:305).

< |t can be argued that printed material can be developed time-effectively,
because the developer’'s primary focus remains on content concerns and
not on the technical requirements of the delivery system (Wills,
2001:0Online).

Literature reveals the following limitations of printed material:

# By its reliance of the written word, printed material can only offer a limited
view of reality. Despite the use of excellent sequential illustrations or
photos, for example, it is impossible to adequately recreate motion in print
(Holmberg, 1995:79).

< Printed material is passive and self-directed and it takes more self-
motivation from students to read a book than for instance watch a
television programme. Without feedback and interaction, instruction
suffers, regardless of the delivery system in use. Even if feedback
mechanisms are incorporated in the material, there is a time-delay before
interaction from the instructor takes place. This could lead to students
losing interest (Wills, 2001:Online).

<« If students do not have good reading skills, the effectiveness of printed
material could be crippled (Schlebusch, 2000:60).

2.4.2 Face-to-face instruction

Traditional face-to-face instruction can also be included as an element in a
blended learning programme (Singh and Reed, 2001:3). The aim of teaching
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is simply to make student learning possible. The instructor has a crucial and
demanding role to play in the process of student leamning, by creating a
context in which the students' desire and ability to learn can work most
effectively.

Lectures continue to be one of the most commonly used teaching methods in
education (D'Cruz, 2003:Online). Research done as far back as 1988,
suggests that traditional lectures, if well planned and presented, are as
effective as other methods - but not necessarily more effective - for conveying
information (University of Technology, Sydney, 2002:0nline). However, there
is little point in simply conveying information without stimulating students'
motivation to learn and giving them opportunities to develop understanding.
Methods which actively involve students are more effective than lectures for
encouraging them to take deep approaches, which are likely to result in
developing understanding, encouraging critical thought, challenging opinions
or changing conceptions. This, of course, does not mean that lectures should
be abolished, but rather that lectures should be conducted in such a way that

they maximise the chances of students developing understanding.

Lectures can be used to give broad contextual information, to highlight the
important or interesting aspects of a topic, to demonstrate problem solving
techniques, or to show the relative strengths of two sides of an academic
controversy. However, they should not be used to transmit information that
the students can acquire (perhaps more effectively) from reading a textbook
or accessing the Internet. Lectures which are based around a set text should
be used to clarify, expand, or explain the content of the text rather than merely
to repeat it. It should also not be assumed that transmission by the instructor
implies reception and learning by students. Felder (1992:0Online) asserts that
of all instructional methods, lecturing is the most common, the easiest, and
the least effective. Unless the instructor is a real spellbinder, most students
cannot stay focused throughout a lecture. One of Felder's studies indicates
that immediately after a face-to-face lecture students recalled 70% of the
information presented in the first ten minutes and only 20% of that from the
last ten minutes. However, actively involving students in learning instead of

26

© Central University of Technology, Free State



O

Central University of

Technology, Free State
simply lecturing to them leads to improved attendance, deeper gquestioning,
higher grades, and greater lasting interest in the subject. Students learn more
effectively when lectures include activities which engage their thoughts and

motivation.

The following factors should be taken into consideration when planning
lectures (University of Technology, Sydney, 2002:Online):

<+ Students are not empty vessels into which knowledge can be poured.
They try to make sense of new information in the context of their existing
knowledge. Students can have pre-existing misconceptions about the
subject which affect the way they interpret and try to understand new
concepts. It follows that in order to encourage student understanding, the
intructor needs to know about students' prior knowledge and conceptions
and help them to change misconceptions. This can be done by asking
students to explain concepts in their own words; to discuss and to debate
the conflicts and paradoxes present in the subject; to point out links
between the specific subject and others and to relate new knowledge to
everyday examples. Students take an active role in their learning when
they are constructing knowledge themselves.

& As novice students, students often experience subjects as a collection of
topics, without being able to gain an idea of the relationships between
them or how they link to related subjects. To help overcome this,
instructors should give students an overview of the whole subject at the
beginning, e.g. a written subject outline or diagram of the subject can be
helpful. Students can then link each new session back to this overview and
to previous sessions. Making the structure of each session clear to
students can help them to fit the topics together in their minds and begin to
make sense of them.

< Students can be easily overburdened. Presenting too much content too
quickly can rapidly overwhelm students' ability to understand it. This is
particularly so if the content is very new, detailed or conceptually difficult.
Students are likely to have a greater chance of understanding if given
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opportunities to mentally process and reflect on new material. This may
mean that the amount of material an instructor plans to cover in a lecture
should be reduced, providing other sources of information - such as
printed or Web-based lecture notes, in order for students to leam

important concepts more effectively.

« |nvolving the students in activities where they engage with the content can
promote understanding and critical thought, and hence raise the quality of
student learning from lectures. There is a wide range of activities that can
be used to get students to actively participate in the lecture. Instructors
should choose a variety of activities and always focus on those that will
best suit the aims of the specific learning process. Whatever activity is
chosen, it is important to explain to students how the activity aims to assist
their learning. After any activity students should be allowed to report back
to enable them to hear different perspectives from the instructor and their
peers.

The task of an instructor has many dimensions (University of Technology,
Sydney, 2002:0nline; Young, 2002:Online). It involves:

<« the provision of a broad context of knowledge within which students can

locate and understand the content of their more specific studies;

& the creation of a leaming environment in which students are encouraged
to think carefully and critically and express their thoughts, and in which
they wish to confront and resolve difficulties rather than gloss over them;

@ constantly monitoring and reflecting on the processes of teaching and
student understanding and seeking to improve them and

* helping students to achieve their own aims, leading them to understand
that learning requires commitment, hard work, responsibility for their own

learning, and a willingness to take risks.
These are not easy tasks, and there is no simple way to achieve them. Still

less are there any prescriptions that will hold good in all disciplines and for all

28

© Central University of Technology, Free State



O

Central University of
Technology, Free State
students. Lecturing must be carefully tailored to suit both that which is to be

learnt and those who are to learn it.

In the past decade, some instructional experts suggested that a lecture format
is not as effective as other forms of instruction due to the passive involvement
of the student (McKethan & Everhart, 2001:4). They assert that the traditional
lecture method is not suited for the ever-expanding educational objectives of
today's society, diversity of students' needs, and the increasing volumes of
information. Further, in consonance with these arguments research
undertaken by the learning and technology e-lab at The Maisie Center in the
United States, suggests that even students involved in e-learning, learn best
when they collaborate with others, i.e. when they have a "social context" for
learning (D’Cruz, 2003:0nline). Collaborating with others as part of the
learning experience improves critical thinking, communication skills, recall,
course completion and a positive attitude towards leaming. This implies that in
terms of blended learning there are more benefits to be gained from face to
face instruction than merely getting a lecture from the instructor. Some of
these benefits are (D'Cruz, 2003:0nline; Young, 2002:Online; Kapp, 2002:4):

@ Face to face students get to know each other, connect professionally and

socially and might discover how they can mutually benefit from networking.

@ Students develop attitudes partly from seeing them role modelled by
others - particularly people they respect. A good practice for classroom
learning is to combine a diverse range of people in groups and facilitate an
exchange of opinions to positively develop attitudes.

@ An important element for developing team spirit is feeling “included". An
instructor should use as many techniques as possible to foster a sense of
inclusion. It is particularly useful to set up projects that require
collaboration and communication amongst students. Social development is
a natural process encouraged by simple events that create a common
bond amongst people and synergy happens when a team achieves results
that are more than the sum of their individual skills and experience. Setting
up class presentations and group projects can present powerful learning
experiences.
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Students are motivated to improve their performance when performance is
assessed relative to their peers. In a classroom setting students want to
demonstrate to the instructor and their peers that they are learning or have
knowledge. People strive to be at least as good as, if not better than, their
peers. Instructors who have commented on positive elements of students’
work have found that people respond to this kind of recognition by raising
the standard of their work .

Where a student develops a relationship with an instructor and other
students, a sense of accountability ensues, e.g. students would feel
accountable for meeting deadlines to submit assignments. By setting up a
common focus and challenge for students, the instructor creates an
environment where students depend on each other. This typically results
in increased accountability.

The researcher notes that there are some concerns about face-to-face

lecturing not being the answer to modern-day teaching. However, in

conclusion, it can be stated that there is enough evidence in literature to

indicate that the social context still plays an important role in the leaming

experience.

2.4.3 Instructional television

The third possible element to be used for blended learning, is instructional

television. According to Bates (1995:61), there are many forms of instructional

television, for example:

&

educational broadcasting where programmes are broadcasted on public or
private television channels;

tele-programmes where lessons are pre-recorded and distributed to
students on video cassette and

live television broadcasts where the instructor and students are connected

via video-conferencing media and can interact in various ways (cf. 2.4.4).
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Wills (2001:0nline) asserts that instructional television (ITV) is an effective
delivery system that can be integrated into the curriculum either as a single

lesson, a selected unit or a full programme.

The following advantages of ITV are found in literature:

& As far back as the 1980s, Bates and Gallaher (1987:6) claim that the
following characteristics of television make it valuable for educational
purposes: “Television is the only medium that can combine words, still
and moving pictures, events occurring in real time, slow or accelerated
motion, animation and text. This gives it a power to present information
that other media lack”. Wills (2001:Online) agrees that ITV is an effective
way to take students to new environments, e.g. the moon, a foreign
country, or through the lens of a microscope.

@ According to Sherry (1996:4), researchers have consistently found that
instructional television can motivate and captivate students, and stimulate

interest in the learning process.

@ In his list of advantages of ITV, Wills (2001:0nline) continues by saying
that since many students have watched television, the medium is familiar
and accessible and students will not have any problems using the
technology.

= Video recordings are often better than real demonstrations because they
can be replayed, stopped or played in slow motion (Wills, 2001:Online).
They are versatile as they provide flexibility and student control. Well-
designed videotapes present students with the opportunity to interact with
the lesson material by repeating until they master it and by reflecting on
and analysing the information. Furthermore, video segments can closely
be integrated with other learning materials so that students can move

between lesson material supplied by different media, e.g. study guides.

The following are a few disadvantages or limitations of ITV:

@ Bates (1995:87) states that while professional broadcast production can
take advantage of the unique presentational characteristics of television, it
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distances the instructor from the production and often presents problems
related to the integration of television programmes with the rest of the
programme material. Broadcast quality ITV is also very expensive to

create.

# Spear (1999:2) observes that video production is time consuming and can
be technically demanding, often requiring relatively sophisticated
production facilities and equipment. Unless professionally produced, video

programmes often look amateurish.

# Spear (1999:2) also remarks that once completed, it can be difficult to
revise and update the content of ITV programmes and videotapes.

< Despite its ability to reach a large section of the student population, open-
broadcast television is a one-way communication medium which does not
provide for interaction between the student and the instructor (Wills,
2001:0nline). Videotapes could thus be used passively, without interaction
in which case their instructional effectiveness is limited.

2.4.4 Video-conferencing

Video-conferencing is yet another element that can be used as part of a
blended learning programme. Video-conferencing can be defined as the set-
up where an instructor in one area lectures to students at various other
locations. Communication is established via a combination of transmission
media and devices. Communication can either be one-way, i.e. the students
can see and hear the instructor, or two-way, in which case both the instructor
and students can see and hear each other. In the latter case it is referred to
as interactive video-conferencing (IV) (Wills, 2001:0nline).

Porter (1997:166-167) describes a typical IV scenario as taking place in a
classroom dedicated to this type of instruction. The classroom should be
equipped with special consoles, in-table microphones and television monitors.
Instructors present information and the television cameras show the viewing
audiences in remote locations what is being presented at the site where the

broadcast originates. The instructor works from a console where documents,
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transparencies, computer displays, photographs, slides and other graphics
can be displayed by controling a camera. Microphones located at the
console, as well as on the students’ desks allow students and instructors to
talk to each other within the classroom, as well as discuss coursework with
students in remote locations. Many rooms are equipped in such a way that the
camera can be switched to show the person who is speaking; in this way, the
instructor knows who is speaking and can communicate directly with that
student.

Students in a remote location can see what is happening in the site originating
the transmission. Furthermore, the instructors and students at the origination
site can also see and hear the participants in remote sites. Optimally, this
format allows audience questions from remote sites that receive an immediate
response from the instructor. Ideally there should be a local instructor on each
of the remote premises who can facilitate individualised learning, feedback,

and integration following the distant presentation.

"IV can be effective because of the following factors:

& |V provides increased contact between instructors and students because it
allows real-time interaction. IV enables distant students to see and hear
the instructor as well as other students (Porter, 1997:168).

@ According to Reed and Woodruff (1995:0nline), IV allows the integration
of different media in a presentation, e.g. blackboard writing, hand-written
documents, videos, computer slides and other graphics may be

incorporated and viewed at all sites.

@ |V enables connection with experts in other geographical locations (Reed
& Woodruff, 1995:0nline). Instead of the instructor presenting a lesson, an
expert in the region could be invited to present information to remote
students.

& Porter (1997:168) mentions an important advantage of using IV, namely
that the televised presentation could be videotaped for later reference or
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use. Students who missed the conference or who want to review a class

session may either borrow or buy the tapes.

The following limitations of IV should be mentioned:

@ Certainly the most limiting factor of IV is described by O’Rourke
(1999:103) as being the initial context of the equipment and leasing the
lines to transmit conferences.

< Porter (1997:167) indicates that due to the technology used, only a limited
number of sites can be linked in an interactive video-conference.
Furthermore it is advisable that the groups at the remote sites are kept
small (for instance less than 20 students) to enable good interaction.

< Wills (2001:0nline) points out that students may be shy to communicate in
front of a camera and therefore may remain uninvolved in the lesson.

< |f visuals, like hand-written or copied materials, are not properly prepared,
students may find it difficult to read.

# On the technical side, if the “pipe” that carries the transmission among
sites is not large enough, the students may observe ghost images when
rapid movement occurs (Reed & Woodruff, 1995:0nline). Similarly if the
system is not properly configured, class members may observe an audio
echo effect. The result is audio interference that detracts from the learning
environment.

< Porter (1997:167) raises a valid point by indicating that even if the latest
technology is used, the quality of the programme still depends on the
instructor’s effectiveness in presenting information to students. Being a
presenter in IV requires much more of the instructor than merely giving a
lecture. The instructor would have to be trained in using the advanced IV
technology. Furthermore, the instructor would preferably have to have a
presentational personality and be able to present information in a lively
way.
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2.4.5 Computer assisted learning (CAL)

CAL might be considered as a possible element of blended learning. Raby
(2001:17) defines CAL as a technique that uses the computer as a self-
contained teaching machine to present discrete lessons to achieve specific
educational objectives. Information is delivered via fixed lessons on a
compact disc (CD). CAL (also referred to as Computer Based Training, CBT)
provides perhaps the best opportunity for student self-guided leaming (Cann,
1997:0nline). In today's society where there is an increasing emphasis on
students to take ownership of learning processes, merits of the lecture
approach to instruction is debatable while the usefulness of computer-based
instruction appears to be warranted.

According to Lawson (1999:32), CAL is an effective training medium founded
on its interactivity with the student. The computer becomes the instructor,

using a mix of full-motion video, animation, graphics, text and audio.

The following are some of the advantages of CAL.

@ CAL enhances the accessibility of leaming in instances where either
distance or time may separate workers from needed knowledge. CAL can
give students at various locations, having various working circumstances,
equal opportunity to learn. CAL thus vastly improves training flexibility
(Cann, 1997:0nline; Trepper, 1999:3).

@ CAL programmes come in a variety of types, including tutorials or
knowledge-based programmes, games, and simulations (Andrisani, Gaal,
Gillette & Steward, 2001:312).

* Well-planned CAL programmes can in some instances be more cost-
effective than live training. Although developing or purchasing CAL course
materials and hardware requires a significant investment, live training can
be much more costly. Examples of costs involved for live training include
the development of the course and course materials, paying for the
learning site and instructor, and travelling. Weidner (1999:52) asserts that
CAL is expensive to develop, but it costs less per class to present.
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CAL can include multimedia techniques like graphics, sound, animation
and full video clips. This results in learning content being presented in a
much more realistic way, making it more interesting to the student

(Trepper, 1999:3).

CAL course material can be updated frequently and at a low cost.
Corrections, additions, and changes to course materials are readily
accomplished and new CD-ROMs are less expensive to print and

distribute than printed material.

CAL allows trainees to deal with learning in bite-size chunks, rather than
sitting for hours in a classroom. The flexibility to segment content may lead
to students obtaining better results.

Classroom training often proceeds at the pace of the slowest student.
CAL, however, is selfpaced and self-planned, with the students
themselves choosing their own paths through the mass of information
encompassed by the package. Within a self-paced instructional
programme, a student may review specific topics on which he/she needs
clarification. Or, if familiar with the topic, he/she may quickly complete the
course and progress at a faster rate. Essentially, all students who
complete the programme will be able to master the topic and function at
similar levels. This is in stark contrast to classroom instruction (CI), in
which a group of students is trained based on a predetermined time, and
students are individually expected to master the topic during that time.

CAL leverages the capabilities of top-notch instructors. It allows a good
instructor to serve many students and permits the talents of experts to be
made widely available.

Successful use of CAL packages will not only increase students'
knowledge, but will require them to develop other important skills,
including self-assessment and planning of studies, information technology
skills, creativity and self-motivation.

Research done by Maul and Spotts as far back as 1993 (1993:24)
indicates that using CAL can reduce the amount of time needed to
complete training.
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@ According to a study done by Perry (1994:2), it was found that knowledge
retention was higher with students that used CAL packages.

= Trepper (1999:4) asserts that, when using CAL, students get immediate
feedback to questions and exercises. This enhances the learning process.

# |nteractive CAL courseware represents a move towards active learning. In
a classroom setting, some students tend to be shy and non-participative.
The personalised interaction inherent in CAL, however, results in students
being more participative and thus gaining more from the training (Trepper,
1999:4).

However many advantages there are to using CAL, instructional designers
need to be careful not to fall into the trap identified by Hoyle (2003:3) as the
“deadly sin of e-learning”. This happens when the printed pages of the text
book simply gets transferred to electronic format and what is supposed to be
CAL, becomes merely e-reading. The goal of a CAL training programme is to
impart knowledge or teach a particular skill. The most important components
of CAL include meaningful programme content, a creative design, and the
incorporation of interactivity appropriate to the programme's task. It is
imperative to take cognisance of some of the most important guidelines for
developing well-designed CAL programmes:

< The interactive nature of CAL has been credited with a 50% gain in
learning and a 20-40% gain in retention over traditional instruction
(Andrisani et al., 2001:320). The key factors in promoting interaction in any
CAL programme include the method of interactivity employed and the type
of feedback used. The type of knowledge being imparted or the particular
skill being taught should dictate the appropriate level of interactivity — this
can range from minimal user intervention to high user control. Developers
must give users a sense of control while providing training in a structured
environment that promotes optimal leamning and retention. The key to
successful CAL involves developing an interesting programme, asking
relevant and well-conceived questions, calculating the many paths users
will take in exploring the programme, and anticipating varied user
responses - all in the context of a visually rich environment.
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@ Special consideration should be given to the screen layout. Good
principles of design, such as the proper use of colour and white space, the
absence of scrolling, the limited use of attention-capturing devices, and the
variation in font type sizes and styles for effect, all impact how students
view a CAL programme. Additionally, consistency in the placement of text,
graphics, audiovisual elements, and navigational devices are crucial in
gaining user confidence, which results in credibility for a CAL programme
(Andrisani et al., 2001:321).

% One of the most important characteristics of CAL is its ability to provide
students with immediate feedback to their responses. Feedback is an
important part of the interaction between the student and the computer
because it lets the student know how well he/she is doing (Maul & Spotts,
1993:24). Feedback not only informs students about their progress and
competency levels, but also increases their level of confidence and
decreases their level of anxiety. The reinforcement provided for cormrect
responses motivates students to continue with the programme, and their
ability to immediately discover the correct answer to an incorrect response,
is an effective method of not only learning information, but also retaining it
(Maul & Spotts, 1993:25). Within the realm of visual feedback, there are
guidelines for providing feedback for correct and incorrect responses. The
feedback offered should be brief, such as using the word Good or Correct
for the right answer. Feedback for incorrect responses should begin with
the word No or Incorrect, followed by a sentence containing the correct
response, and perhaps a reason why this particular answer is considered
to be correct. It is important, for the sake of consistency, that feedback be
displayed in the same location on every screen. The font type size, style,
and colour used to display feedback should also be consistent (Andrisani
et al., 2001:322).

< Effective CAL programmes will provide students with a variety of hands-on
exercises and tutorials (Weidner, 1999:52).

# |n addition to immediate feedback, Weidner (1999:53) asserts that the
CAL programme should also be able to present a student with a report,
indicating his/her progress.
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% CAL programmes should be graphically rich, combining audio, animation,
video, line art and icons all accompanied by the appropriate use of colour

(Weidner, 1999:52).

@ Weidner (1999:53) furthermore suggests that CAL programmes should
have a brief tutorial that will show students how to access and use
different segments of the course material. A reference manual should be
available, either as a hard copy, or in electronic format on the CD.

Despite the extensive list of advantages of CAL, researchers have identified
some disadvantages of using CAL programmes:

& According to McKethan and Everhart (2001:4), studies on the
effectiveness of CAL have shown inconsistent results. The effectiveness of
CAL appears to be dependent upon its purpose, the context of its use and
the design of the software.

= Although research supports the use of CAL as a supplementary tool to
instructor-provided information, its effectiveness as an independent
instructional tool is not conclusive. Three investigations show no
favourable results when studying CAL as a sole instructional method as
compared to traditional instructional methods (LaBonty, 1989, Morrell,
1992, Ruef & Layne, 1990 as cited in McKethan & Everhart, 2001:4).
Gardner (as cited in McKethan & Everhart, 2001:4) studied the effects of
hands-on activities in science versus using a combination of hands-on
activities, CAL, as well as text-based activities. He concludes that the

combination of methods produced higher achievement.

@ Another concern is product quality. Some developers may understand the
programming aspects of formulating a CAL course, yet have no real
expertise in learning pedagogy (Lawson, 1999:33). As a result, learning
goals and objectives are not clearly defined, which leads to confusion on
the part of the student.

# Using CAL, implies that a student will, to a large extent, do self-study. This
requires certain skills and a high level of self-discipline, and not all
students cope with these demands.
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% Weidner (1999:53) asserts that CAL does not work well for discussion-
oriented subjects requiring vigorous interactions within the class itself.

# CAL requires students to have access to special equipment - often the
latest in computer technology - to be able to accommodate the graphics,
sound, animation and video clips.

Perry (1994:3) asserts that the decision whether to use classroom or CAL
methods for a learning programme, depends on both the audience and the
course content. Some of the specific factors that must be taken into
consideration are:

@ the target audience, including their educational level and computer
literacy;

# course content, including whether it will be presented in linear or free-form;

@ how the programme will be used (e.g., will students take the material

home to study or will it only be used in a class situation?);
& the computers that will be available;

% the availability of talented instructional designers and experts to render
technical support, and

# budget and time lines.

Dvorak (1999:73) is one of many researchers that holds the opinion that CAL
can never be a complete replacement for instructor-led classes. Trepper
(1999:4) reiterates that although CAL is often used as self-paced learning, it
can best be used in a facilitated approach. The facilitated approach combines
the benefits of CAL with the advantages of having an instructor in the
classroom to help students as needed. In the facilitated CAL approach,
students learn through discovery while also setting the pace of their learning.
To facilitate learning, instructors coach students while the students develop
new skills. This approach creates an environment in which knowledge is
shared through the collaboration of individuals while under the guidance of

instructors.
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The instructor's role in this approacl'i{ is to facilitate maximum sharing of
information and knowledge among students rather than control the delivery
and pace of the course. The instructor therefore provides direct feedback to
students while creating an environment to generate peer discussion. The
instructor acts as a problem solver when mistakes are made or technology

glitches occur.

Facilitated CAL can also take the form of combining CAL with video-
conferencing technology. Feldman (2002:37) asserts that KnowledgeNet, one
of the fastest-growing e-learning companies, uses Internet groupware in
conjunction with traditional conference-call technology, and found that this

produced highly effective learning resuits.

In conclusion it can be noted that the many advantages of CAL make it a
versatile method of delivering training. However, an instructor should take into
consideration the wide range of factors mentioned in this section to ensure
that an appropriate CAL programme be selected for the specific needs of the
students.

2.4.6 Computer communication technology

This section continues to investigate possible elements that can form part of a
blended learning programme.

One of the main advantages of recent developments in computer and
communication technology is that the computer can be used as a tool to
facilitate instructor-to-student as well as student-to-student communication.
Online communication is typically described as being either synchronous or
asynchronous (Wills 2001:Online).

& Synchronous technologies facilitate real-time interaction. This means that
students from a variety of locations communicate online during the same
period of time. This type of conferencing session may be a simple "chat"
session in which participants communicate via a series of text-based
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messages, or involve participants meeting online at a specified time to
watch presentations or share software applications. Commonly used
synchronous technologies are audio-conferencing by phone and

computer-conferencing (cf. 2.4.6).

# Asynchronous discussions are unbounded by both time and place. That
means that students can be on or off campus and participate online at a
time that is convenient to them. In education settings, an asynchronous
discussion on a topic might take place over a number of weeks. For
example, an instructor might set up a discussion group as part of a course
Web site. Students are assigned to one or more discussion groups.
Typically a discussion question or topic is posed to guide the discussion.
Students post text-based messages related to the topic over a number of
days. Through a series of typed messages, students can debate issues,
answer questions, interview guests, and even participate in role plays.

Computer communication technology opens up a number of e-learning
possibilities. Some aspects are mentioned here:

e Electronic mail

Electronic mail (e-mail) can be used to send messages or submit
assignments. If there are less than 20 students in the class, e-mail discussion
groups could be set up. Scarce (1997:0nline) indicates that the Internet is an
enormously popular medium of communication that has developed its own
norms of interaction, and expected and accepted behaviours of participants.
Students participating in e-mail discussion groups learn to present themselves
socially through a particular conversational style and learn to use Intemet
etiquette. Furthermore, they learn to think critically by interacting with text and
with one another, thereby developing a multiple-way dialogue.

o List serves
List serves stands for “list server” and works like an electronic mailing list,
sending e-mail messages to students whose names are on the list (Hofstetter,

1998:6). Whenever someone sends e-mail to the list serve, every member of
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the list will receive a copy. A list T:g:\g;;;:a ;ehus a simple way for groups of
students to communicate with one another through e-mail and allows its
members to view all of the messages posted to the list and to post their own
messages and replies. List serves can be used to facilitate discussions where

more than 20 students are enrolled in a class (Scarce, 1997:0nline).

e Bulletin board

A bulletin board service (BBS) functions like an electronic bulletin board, i.e.
an instructor can post notices or other information on the bulletin board and
students can access the information by logging into the bulletin board
(Hofstetter, 1998:3). There are many existing bulletin boards, but it is
preferable that an instructor uses special software to create a separate
bulletin board for a particular programme (Porter, 1997:116). Depending on
the software that is used, a BBS can be used in many different ways, e.g. the
instructor can post information to students, students can respond by posting
messages to the BBS where other students can retrieve it, students can have
on-line, synchronous dialogue and partake in other on-line activities. The BBS
is thus mainly used to facilitate instructor-to-student and student-to-student

communication.

o Computer-conferencing

Computer-conferencing is two-way synchronous communication and involves
individuals who are connected via computers equipped with a camera, sound
system and computer conferencing software (Porter, 1997:170). The
individuals can be seen and heard by all participants logged into the
conference. Instructors and students can discuss information, ask and
respond to questions and share documents and other materials in real time. A
major advantage is that participants do not have to meet at a pre-arranged
site to be able to communicate. However, although computer conferencing
allows participants to work together in real time, it does not create the same
classroom feeling as video-conferencing because students still primarily work
alone at a personal computer. Furthermore, there are a number of technical
stumbling blocks to overcome: every student's computer must be equipped
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with the required technology; often the response time is slow and there may
be a lag in communication between the moment a person finishes speaking

and the moment communication arrives on screen.

o World Wide Web

The World Wide Web (WWW or Web) is a networked hypertext system that
allows documents to be shared over the Internet (Hofstetter, 1998:10). As the
Web's wealth of information and accessibility grows, this medium has taken
on a more prominent role in society. An advantage of this technology is the
ease and instantaneous access to a magnitude of resources, opening new
doors to the educational process. Students no longer have to be satisfied with
out-dated videos and books for their information, the WWW showcases the
most current materials, which are easily and often updated all over the world
(Rosen, 1997:Online). Information stored on a web-site can include
hypermedia (such as video clips, animation, sound effects, music,
photographs and other graphics), hypertext (documents), and other unlinked
text or graphics (Porter, 1997:21). The prefix hyper simply means that the
information has been designed to link a piece of information with another
related piece of information.

One way to incorporate the Web in a programme, is to use it as an electronic
reserve shelf. The concept of an electronic reserve shelf is an innovative
instructional tool that allows instructors to bring more real-life and frequently-
updated material into the classroom (Kuechler, 1997:0nline). This helps to get
students involved in actual research beyond the confines of traditional library
research. In its basic form an electronic reserve shelf mirrors the traditional
reserve shelf for a particular programme in the campus library. The instructor
can put any of the following on this shelf. homework, assignments, guidelines
for writing a paper, newspaper clippings, class handouts, additional readings,
sample work by students and much more. The advantages are firstly that
several students can access the same piece of information simultaneously
and secondly that additions and modifications are easy to make so instructors
are more likely to broaden the range of materials. The electronic reserve shelf
can be expanded to include web-site links to related documents.
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2.4.7 Web-based instruction (WBI)

Another important element that can be included in a blended learning
programme is WBI. A web-based programme uses a web-site as a virtual
classroom (Spear, 1999:2). A web-site forms the basis of the programme and
in contrast with simply using the Web as an electronic reserve shelf, the
programme web-site features all activities surrounding the particular
programme, e.g. syllabus, work scheme, assignments, students’ marks and
all other information students need to have. Although the basic coursework
may be completed by using information and resources linked through the
web-page, it could be assumed that students taking web-based programmes
also have access to e-mail, mailing lists, bulletin boards and other Internet
services. Therefore, these Internet-related activities are often an expected
part of a web-based programme.

All advantages of CAL (cf. 2.4.5) are inherent in a properly designed and
delivered web-based programme. The following additional advantages can
also be identified (Weidner, 1999:53; Vogeler, 1997:0nline):

@ |nstructors have the opportunity to re-enforce learning by providing lecture
notes, visuals for review, and additional materials quickly and
inexpensively.

< Programme material can easily and constantly be updated by uploading it

to the website. Content can be updated anytime.

# Software used specifically to administer web-based programmes, allows
instruction management, i.e. monitoring and control of students' access to
content, monitoring students' class time and recording scores and other
student data.

<« [f required, live data can be used in student exercises. This capability is
especially valuable when it involves large amounts of information from
enterprise databases.

< WBI can approximate some of the unique elements of group activities in
face-to-face classroom training. Depending on the speed of the Intemet
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connection, capabilities range from web-type keyboard discussion groups
to live audio and video communication.

= Flexibilty of WBI allows for various types of modular construction.
lllustrative materials, animations, simulations, or even whole segments of
content can be inventoried, and the student can decide in which order to

complete the modules.

As in the case of advantages of using WBI the disadvantages are very similar
to those of CAL. The one added disadvantage of WBI, is the bandwidth
restrictions. This determines the speed with which material is accessed on the
Internet, and could lead to frustration if the interaction with the material is

slow.

Research on the effectiveness of WBI has shown mixed results:

< Dominguez and Ridley (1999:72) compared the effect of web courses with
that of traditional training on student learning. They found no significant
differences in grades between the online and offline students of the same
course.

@ Selwyn, Marriot and Marriot (2000:170) found that students’ attitudes
towards the Web courses, though generally positive, were influenced by
their initial introduction to the Web. Extended introductions tended to lead
to more positive feelings associated with the Web.

< Web courses have shown that greater human interaction has been
associated with greater problem-solving capabilities (Jareka, Bonk &
Lehtinen, 1999:370). Furthermore, greater interaction with the instructor
and fellow students has been associated with improved student attitudes
to WBI (Ryan, Carlton and Ali, 1999:274). The lack of direct physical
connection between the student and the instructor may be a significant
barrier to a student's developing a positive attitude to computers.

The research results mentioned in the previous paragraph indicate that WBI

may well deliver more effective results in a blended learning environment.
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2.5 INSTRUCTIONAL DESIGN FOR BLENDED LEARNING

After looking at the different elements available for presenting blended
learning programmes, the researcher will now explore instructional design
guidelines.

According to Treat (1999:0nline), instructional design (ID) provides a process
and framework for systematically planning, developing and adapting
instruction based on identifiable student needs and the content requirements.
Hodgkinson (1994.60) states that designing a new programme is a complex
exercise and needs careful planning. The process of doing so in order to meet
flexible needs is best achieved collaboratively, preferably after discussion with
experienced instructors. Literature reveals a range of different ID models that
exist for developing learming programmes. However, the researcher
concludes that most models consist of a combination of the phases as
portrayed in Fig 2.1. This specific ID model for developing a blended learning
programme is proposed by the staff of the University of Alberta
(2002a:0nline).

Analysis and

Design Development Production Implementation

Evaluate and Review

Fig. 2.1 Phases of instructional design (University of Alberta 2002a:0nline)

An important fact is that developing a programme is an iterative process in
which the developers must move flexibly back and forth between the phases.
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Although ID can be done by a team, where each of the different phases is
handled by experts, programmes are often developed by the instructors. In
this study the researcher refers to the developer of the programme as the
instructor.

The following section aims to elaborate on the phases of ID as portrayed in
Fig 2.1.

2.5.1 Analysis and design phase

One of the most important aspects of the analysis and design stage is to
analyse the target population of students. Sound instruction requires
considering the characteristics of students, and some aspects to consider are
(University of Alberta, 2002b:Online):

* What are the prospective students’ learning needs?
< What prior experiences are they likely to have?
@ What factors might affect their success in the programme?

+ What type of materials and technical support will students need to be
successful?

Careful consideration should be given in selecting an instructional strategy.

Questions to be answered include:

@ What teaching strategies have been found effective for the specific
content?

< Which strategies will be most effective with the specific target population?
< How will students be engaged to keep them motivated?

< Which instructional strategies take best advantage of the opportunities
offered by new media?

® What administrative support will be required?
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Singh and Reed (2001:4) indicate that a financial analysis should be done,
looking at the cost of content development as well as the delivery costs. This
could play a significant role in deciding on the delivery options.

The following worksheet, given as table 2.1, can be completed to assist the
instructor in finalising the analysis and design phase (Reigeluth, 1999:0nline):

Instructional Design Worksheet

Name of project lead:

Date:

Discipline focus:

Department/Institution:

Course title(s):

Date course(s) will be offered:

Names and responsibilities of project team members:

Is this project part of a larger programme of study? If so, indicate the name of the programme
and the relationship of this project to it.

Describe existing resources related to this course.

Identify the instructional strategies that will be used for the different levels of learning in the
following matrix:

Kinds of learning | Presenta- || Tutorial | Drill | Independent | Discussion |Game| Lab
tion study

Invariant
tasks

Concept
classification
Procedure
using
Understanding

Generic skills
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Where will your students be located? (Note: you may check one or more categories.)

Location of students

Students will meet regularly on campus

Students will meet occasionally

Students will participate from a distance

Students will be located in several time-zones

Describe the characteristics of the prospective students including the following information:
programme(s) of study, age range, educational backgrounds, work experience, access to
technology, and comfort with technology-mediated learning.

Identify appropriate delivery methods and media. (Note: you can select more than one

option.)

Delivery methods Yes No Maybe

Web

Videoconference

CD-ROM

Print Materials

Videotape

Audiotape

Face-to-face mstruction

Media to be developed Yes No Maybe

Audio

Video

Graphics

Animation

Text-based content

What campus facilities will be required to support the students?

Campus facilities

Library

Computer help desk

Computer lab

Classroom

Tabie 2.1 Instructional design worksheet (Reigeluth, 1999:0nline)

50

© Central University of Technology, Free State



O

Central University of
Technology, Free State

Once the analysis and design phase has been completed, the instructor can
proceed to the development phase.

2.5.2 Development phase

In the induction pack for writers by the Open Training and Education Network
(OTEN, 1994:11), instructional designers are informed to start the
development phase by constructing an instructional plan. This plan should
include detailed information about the layout of the programme, learning
objectives, assessment methods, and the media and instructional
technologies that will be used. The instructor should create a curriculum plan

for the programme (University of Alberta, 2002a:0Online). This plan must

include all the elements as listed by OTEN, as well as student f‘aqtjvitie‘._s..A

brief overview of each of these now follows:

e Learning outcomes

Melton (1997:29) defines learning outcomes as statements rof desired.

outcomes of learning expressed in terms that make it clear how rﬁéésurement
can be achieved. These outcomes provide a logical basis for measuring and
reporting on student achievement because attention is focused on what is to
be learnt rather than on the process of learning. Treat (1999:0Online) suggests
that learning outcomes should be set out clearly at the start of the writing
process and should be used for reinforcement and motivation during progress
through the programme. Outcomes in the context of the South African OBE

approach is discussed in sub-section 3.3.3.

o Framework and content outline

Melton (1997:51) states that a framework for the programme must indicate
how the programme will be broken down into units of instruction and
thereafter into related study sessions. It should also outline a study schedule
indicating the time allocated to each of the study units. The content which will
be covered in relation to each leaming outcome should be identified and
outlined. Wills (2001:0nline) proposes that in selecting the content, factors
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like the students’ ages, cultural backgrounds, past experiences, interests and
educational levels should be considered. The student analysis alongside with

the learning outcomes should then form the basis for selecting the content.

e Media and instructional technologies

The media and instructional technologies which will be used to deliver the
content should be selected. As stated previously (cf 2.4), media and
instructional technologies for a blended learning programme could include
printed material, face-to-face lectures, ITV, as well as a wide range of
teleconferencing or computer-related communication techniques. Selecting
the right blend of technologies has been discussed (cf. 2.3). The challenge
here is to integrate delivery components, based on identifiable student needs,
content requirements and technological constraints.

o Assessment methods

Deciding on assessment procedures and the timing thereof forms an integral
part of the development phase (Treat, 1999:0nline). The selection of
assessment methods will be influenced by the content that will be assessed,
and whether continuous assessment and/or an end-of-the-programme
examination will be used. When using continuous assessment, the timing of
the assessment plays an important role in the overall effectiveness thereof.
One should bear in mind that early in the programme the students may not
have learnt anything significant enough for testing, but on the other hand an
early assignment provides an opportunity for early interaction and feedback.
Furthermore it is desirable that assignments be related to major sections of
content and that they are spread evenly throughout the programme schedule
to generate regular feedback to and from students. According to a document
produced by the Maricopa Centre for Learning and Instruction (2000:0nline)

assessment is effective when it:
& s student centered;
& s congruent with instructional objectives;

& |s relevant;
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# s comprehensive;

& s clear in purpose, directions, and expectations;
@ is objective and fair;

# simulates end behaviour/product /performance;
@ incites active responses, and

# shows student progress and development over time.

Thorpe (1993:67) asserts that apart from formal assessment, student self-
evaluation should form an important part of blended learning assessment
strategies. Two approaches can be used, i.e. activities based on the content
material and self-review questions. The purpose of both is to help students to

reflect back on a period of leamning.

e Activities
According to Reigeluth (1999:0nline) the following kinds of learning can be
identified:

* [nvariant tasks require memorizing factual information or routine
procedures. They do not require any understanding, nor do they require
learning how to deal with variation.

@ A procedural task involves performing a procedure, which is a sequence of
activities to achieve a goal. Synonyms include method, technique, skill,
and rule. A procedure can be either a physical procedure, which entails
the execution of physical movements, a mental procedure, which entails
the execution of mental operations or a combination of physical and
mental activities.

@ Concept classification is a mental skill which requires a student to classify
instances as being examples or non-examples of a concept. It is
considered to be the building blocks for most of the cognitive capabilities a
person possesses. Procedures, for instance, describe how to change
things or to achieve a goal. Those "things" are concepts which are simpler
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components of the procedure and must be mastered before the procedure
can be learned.

Understanding is meaningful learning. It is usually contrasted with rote
learning (memorisation), although it is also distinct from specific and
generic skill application.

A generic skill is a skill which can be applied across a variety of subject
domains, and usually takes longer to acquire than domain-dependent
(subject-area) skills. The major kinds of generic skills include thinking skills
(such as problem solving techniques), learning strategies (such as
creating mnemonics to help you remember things), and metacognitive
skills (such as monitoring and revising your problem solving techniques or

mnemonic-creating techniques).

The type of learning that is required will determine the type of activities that

are selected. Involving students in activities deepens their understanding and

enables them to readily transfer what they have learned to new situations

(University of Alberta, 2002a:0nline).The following are some guidelines that

can be followed in planning activities:

&

Provide assignments that simulate in some way the real world application
of the course content.

Engage students in meaningful activities throughout the instruction and not
just at the end of a module or unit.

Require students to generate meaning for themselves by asking them to
analyse, compare, evaluate, and synthesise the concepts, principles, and
procedures.

Provide opportunities for interaction and collaboration amongst students.

This section gave a brief overview of aspects to consider in developing a

blended learning programme. It is the view of the researcher that sound

pedagogical principles should be applied in considering each of these

aspects. It was therefore decided to further investigate such principles (cf.
3.4).
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2.5.3 Production phase

This is the phase in which the instructor actually creates (or selects) the
educational resources, i.e. the media elements (e.g. video tapes, CDs, web
sites) and other instructional materials (e.g. study guides, activities,

assessment and on-line resources).

Some of the design principles appropriate to educational technology are
discussed in this section.

e Instructional multimedia

Instructional multimedia can include, amongst others, CDs and videos. Dowie
and Campbell (2002:0Online) provide the following principles for the design
and production of instructional multimedia applications (cf. table 2.2).

Principle Examples of applying the principle
The programme is @ novelty, surprise, or humour is used to enhance motivation
compelling for .
st @ students are shown how what they learn will help them solve

problems or perform tasks in the real world

@ anecdotes and case studies breathe life into the content

The programme is @ information contained in the programme is current and
academically credible accurate

@ pertinent theories, principles, and procedures are represented

Students know what |# learning objectives are stated as part of each major unit of
to expect instruction

The navigation system [® on-line help is available at all times

is efficient and well i
planned & menus, buttons, and other controls are used consistently

throughout the programme

@ directions and overt signals let students know what they are
supposed to do

% users are informed of their location in the programme
through the use of titles, frame numbers, and other indicators

@ students can select study and practice sequences that are best
for them
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The visual layout & content is broken into units that are small enough to be
promotes learning readily learned

<« long, linear sequences of screens are avoided

" the text is organized into short, easy-to-read paragraphs

Media elements are  |< a variety of media is used to effectively illustrate facts,
used wisely concepts, principles, and procedures

& the various media employed complement rather than compete
with each other

<& graphics, fonts, and other visual elements are legible,
functional, and attractive

The application & learning objectives are matched with appropriate learning
supports active activities
learning

@ the unique capabilities of the computer provide meaningful
interactivity and feedback

< students are provided with opportunities to check their level
of understanding

@ explanatory feedback is provided for both correct and
incorrect responses

& students are able to develop an in-depth understanding
applying their skills and knowledge in complex, real-life
context.

Table 2.2 Principles for the design and production of instructional multimedia (Dowie &
Camphbeli, 2002:0nline)

e Online resources

Instructors are now in the fortunate position of having an increasingly
abundant range of high quality resources freely available on the Internet.
According to Dowie and Campbell (2002:Online), the following aspects should
be considered in evaluating a particular online resource:

@ Does the resource provide alternative explanations or examples that will
be valuable for your students?

% Does the resource include demonstrations or simulations that extend what
you are able to do in your classroom?

56

© Central University of Technology, Free State




O

Central University of
Technology, Free State

Are learning activities that involve case studies, problem scenarios, or
topics for discussion included in the resource?

Is the content authentic, current, and relevant?

Are there multiple paths through the content, so that students have
flexibility in modes of learning, difficulty levels, and opportunities for review
or enhancement? Will students know what they are expected to do, where
they are, and where they have been? Is there a search feature?

Is the resource engaging and interactive, i.e. will the students be actively
involved?

Do the students have the time to make effective use of the resource? Too
often instructors pile additional activities on top of pre-existing lesson

plans. The resource should add value, not just "add on".

Does the resource meet high standards of access and equity? If the
resource or activity is required, all students should be able to access itin a
reasonable time frame without going to extraordinary effort.

Web sites

A web site contains the following basic elements: a home page, graphic or

text menus, information screens, and hyperlinks to other sites. The following

basic design fundamentals should be considered (University of Alberta,
2002a:0nline):

&

Divide written information into logical units. Discrete, succinct “chunks” of
information are easier to read on a computer screen than long chapters.
Limit each unit that contains printed information to no more than the
equivalent of three pages of typed text.

Break up large blocks of text. Minimize large grey masses of print. Most
web pages contain lines of text which are too long to be easily read. A
reader's comfortable eye span is 40 to 60 characters per line on a
computer screen. One of the easiest ways to control the format of text
passages is to place the text within tables on your web pages.
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Organize the content on the page so that it is logical and predictable.
Place elements such as headings consistently from one page to the next.

To ensure a uniform, professional look to the courses within a programme,
it is essential to establish a set of parameters for the visual elements in
both the online and print materials. These guidelines should include
information about the font, size, and colour of the normal type, headings,
subheading(s) and how emphasis will be added. In general, use 10 to 12
pt. Times or Arial font for the normal text within the site.

Build clear navigation aids. Incorporate easily understood icons, headings,
and menus. As well, the page layout and overall visual style should be
consistent throughout the site. Aim for a functional elegance while
providing cues so that users know where they are within the site at all

times.

Graphics add interest and breathe life into text presentations, but be aware
of download speeds especially for those users with slower modem
connections. People find it frustrating when it takes longer than 10 or 15
seconds to view an image. In general, it is recommended that online

graphics are no larger that 20K.

Use colours with restraint. Keep colours and layout conservative,
conventional, and simple. Be aware not to create a page which is
overdone in which everything is garish and nothing in particular is
emphasized. When selecting a background colour, subtle pastel shades
are a good choice. Ensure that the font type contrasts sharply with the

background, and avoid using background images as they obscure text.

Printed material

Because print is largely a one-way communication medium, the challenge is

to design instruction to maximize the amount of interaction in print materials

that will be used in a blended learning programme (Wills, 2001:0Online).

Misanchuk (1994:111) addresses a number of practical ways to write good

study material. Some basic principles are proposed that will ensure good
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page design, e.g. that the writer :v:;:zgm;v&rai:ing too much text on one page,
use unjustified right-hand margins as it is easier to read, avoid too many
different font types and only use graphics when it really serves a purpose.
Hodgkinson (1994:63) agrees that one of the central concepts regarding
printed material is readability. This has little to do with the content of text in
terms of its complexity and everything to do with print, word length and
grammatical structure. An easily readable font and font size should be

selected and sentences should be kept short.

Misanchuk (1994:113) suggests using active voice instead of passive voice
sentences, making writing personal by using words like “you” and “me’,
keeping content clear, concise and coherent by using short sentences and
cutting out redundant information. It is also preferable that material is divided
into sections. The OTEN guide (1994:16) underlines some of the previous
statements by suggesting that the writing style should be plain, conversational
English. This could be established by using simple, active voice sentences,
familiar words, personal pronouns (e.g. |, you, we), contractions (e.g. I'm,

let's), a friendly tone and humour, where relevant.

Kember (1991:11) states that one of the ideal characteristics of study material
should be that it is self-instructional. The OTEN guide (1994:16) describes
self-instructional material as study material that is specially written with
particular programme objectives in mind. Furthermore, it is structured in such
a way that students can do most, if not all, their learning from the materials
alone. “The materials must carry out all the functions an instructor would carry
out in a conventional situation — guiding, motivating, explaining and so on.”
The student must be guided through the programme material in such a way
that he/she should be able to attain the learning outcomes with minimal
contact by the instructor. One way of reaching this goal is to use the active
learning approach where content is combined with activities. Activities help
students to practise newly acquired skills, check their own understanding of
material, apply and transfer their leaming into realistic situations, think for
themselves, become self-directed students, enter into dialogue with their
tutors and focus on key areas of learning.
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2.5.4 Implementation phase

Once the instructor has completed the production phase, the programme can
be implemented.

A number of administrative issues have to be resolved in order to effectively
implement a new programme. At this stage, most of the instructional design
work has been completed and the implementation issues often relate more to
project management than to educational theories. As the focus of this study is
didactics, the researcher will not expand too much on this specific phase.
However, the following decision matrix given by the University of Alberta
(2002a:0nline) gives a comprehensive overview of the administrative and
management issues to be considered in ensuring the long-term success of
technologically enhanced courses. The matrix outlines the policy areas and
key issues which must be addressed when implementing a blended learning
programme. It is provided to help the instructor keep track of the many
administrative tasks involved in managing the implementation of a blended
learning environment. The instructor can indicate the status of each policy
area by ticking the resolved, in progress or not an issue column on the right-
hand side. A matrix sheet can be completed at the end of every week of
implementation, and in this way the instructor can ensure that no issues are
left behind or stay unresolved.
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The matrix is based on the strategic management decision zones as
described by King (2000:Online).

Key Issues
Resolved pr o::- e L :?It
issue
Academic
Course integrity % 4 O
Transferability r i &
Student/course evaluation T o r
Admission standards e ' -
Curriculum/course approval & C c
Accreditation & e r
Recruiting/marketing r & &
Governance and fiscal administration
Tuition fee £ £ [
Technology fee e & &
FTE's e (i «
Administration Cost e r C
Staffing (o r T
Facuilty
Compensation and workload £ {7 '
Development incentives £ i &
Faculty training i r i
Congruence with union contracts £ C O
Faculty support & e C
Faculty evaluation « i C
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Legal

Intellectual property

Compliance with the Freedom of Information and
Protection of Privacy Act (FOIPP)

Faculty, student, and institutional liability

Student support services

Advisement & counselling

Library access

Materials delivery

Student training

Test proctoring

Computer accounts

Registration

Financial aid

Labs

Technical

Systems reliability

Connectivity/access

Hardware/software

Setup concerns

Infrastructure

Technical support (staffing)

Scheduling

Costs

Labs
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Cultural
Adoption of innovations - P -~
Organizational values -~ -~ .

Table 2.3 Matrix outiining the policy areas and key issues which must be addressed
when implementing a blended iearning programme (University of Alberta,
2002a:0nline)

2.5.5 Evaluation and review phase

Once the programme has been implemented, the next phase is to evaluate it.
According to Reeves (2002:0nline), the term evaluation refers to the process
of researching the quality of the outcomes achieved by a programme, course,
or other educational activity. The objective of this research is to assess the
strengths and weaknesses of the learning activity and determine if and how it
might be improved.

The diagram in fig. 2.1, indicates that évaluation is not a separate phase in
instructional design, but that it is an ongoing process that should take place
throughout the life of an instructional project, from its initial conception to
project completion.

Lockwood (1995:197) indicates that evaluation can either be formative or
summative.

@ Formative evaluation is an on-going process to be considered at all stages
of the instructional design process. It enables the instructor to improve the
programme as it proceeds. This kind of evaluation will identify major gaps
in the instructional plan or the need for minor adjustments and facilitates
programme and content adaptation. Calder (1995:22) explains that
evaluation is formative when it is used with the intention of developing or
improving the functioning of an activity or the effectiveness of a
component. Thorpe (1993:9) ascertains that formative evaluation is
concerned with the evaluation of progress towards achieving programme
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outcomes, during implementati:)ecnn.wigt{.;;:Js';a;lfy answers the questions: “How
are we/they doing?”, “What should we be doing next?” It aims not to
measure the effectiveness of a programme, but to identify any changes it
requires which will improve it and make it more likely to eventually achieve

its outcomes.

% Summative evaluation assesses the overall effectiveness of the finished
programme. Because summative evaluation is usually done at the end of a
programme, it will not help current students but can be used as a
springboard in developing a revision plan or form the baseline of
information for designing a new programme. The purpose of a summative
evaluation is to assess whether the project met its initial goals. If initial
goals were not met, the summative evaluation can be used in a formative
manner, to advance the next iteration of the project (University of Alberta,
2002a:0nline).

In this study both formative and summative evaluation will be used to evaluate

the programme through action research (cf. 4.2.2).

In the view of Wills (2001:Online) the following factors relating to a
programme should be evaluated:

< the use of technology, i.e. familiarity, concerns, problems, positive aspects
and attitude towards the technology;

< the quantity and quality of interaction with other students and with the
instructor,

# programme content, i.e. the relevancy, adequate body of knowledge and
layout;
@ the assessment methods, i.e. the frequency and relevancy of tests and

assignments;

+ the support services, i.e. the support that students get from the
organisation as a whole as well as the instructor as an individual;
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student achievement, looking at the rate of participation of students and
the marks obtained for assignments and

the instructor, to determine his/her contribution to the effectiveness of the
programme through being organiser, leader, facilitator and mentor.

Keegan (1996:186) observes that evaluation should focus on the quantity,

quality, status and relative cost of the learning achieved:

&

In evaluating the quantity of learning one could consider the number of
students enrolled, the number of students that passed the final
examination, the number of drop-outs and all other aspects of the
programme that could be quantified.

In evaluating the quality of the learning, one could look at the quality of the
learning materials, the extent to which the blended learning approach is a
suitable vehicle for educating students in the specific subject and the
extent to which education is provided as opposed to instruction.

Evaluating the status of the learning could be derived from the extent to
which other educational institutions recognise the studies for credit transfer
purposes, the acceptance of the qualification awarded as qualifying
students to go on to higher level studies and the recognition of the awards

by managers in competitive interviews for employment.

In evaluating the relative cost of the learning achieved one should
determine whether the programme is cost-effictive to be presented in
blended leaming mode as opposed to being presented as a contact tuition
programme.

In this study the researcher is concerned with developing a programme based

on sound educational principles. It has therefore been decided to extensively

evaluate the programme against the principles of good practice as set out in

Chapter Three.
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2.6 CONCLUSION

It is the opinion of the researcher that the content of the current status of
blended leaming can be summarised by the view of Ward and LaBranche
(2003:23). Their observation is that over the past few years, there has been
much discussion about the emergence of online learning. Some speculated
that e-learning would lead to the reduction, if not the demise, of face-to-face
lectures. However, the way things are actually developing, is that what was
once seen as an "either-or" proposition is quickly becoming an "also-and"
situation. Blended learning, the convergence of e-learning and traditionally-
delivered learning, is one of the fastest growing trends in education, and is
definitely here to stay. It provides a deeper, broader and more flexible
platform for knowledge transfer, as it extends the learning experience outside
the classroom and helps to create leaming communities. Ultimately, blended
learning provides a way to overcome one of the limitations to face-to-face
style learning: that learning has to take place largely in the room, at the time
when the presenter is available. Blended learning is a student-centered
strategy. Students have more options, more time and more freedom to
explore learning. It extends learning before or after the physical leaming
experience, and enhances learning by taking the student outside of the
traditional classroom to take advantage of the power and depth of modern
technology.

Modern technology provides a variety of elements that can be used to form
part of a blended learning programme. Examples range from more traditional
elements like printed material and face-to-face lectures, to modern technology
like web-based instruction, video conferencing and a variety of computer-
facilitated teaching methods (cf. 2.4). The success of a blended learning
programme is, to a large extent, determined by selecting the right blend. As
Bersin (2003:0nline) states: “The key to blended learning seems to be
selecting the right combination of media that will drive the highest learning
impact for the lowest possible cost.” There is no simple way in finding the right
blend, however, literature revealed sound instructional design principles as
well as guidelines for developing good instructional media (cf. 2.5). The
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researcher concludes that by following the phases of instructional design and

adhering to the development guidelines it will be possible to develop an
effective blended learning programme.
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CHAPTER THREE

BLENDING PRINCIPLES OF GOOD PRACTICE, COMPUTER
LITERACY AND OUTCOMES-BASED EDUCATION

3.1 INTRODUCTION

As indicated in the title of this thesis, the aim of the research is to develop an
outcomes-based computer literacy programme that will be presented in
blended learning mode to South African students. Literature on blended
learning was reviewed in Chapter Two. In this chapter the researcher
continues by reviewing literature related to principles of computer literacy,
outcomes-based education and good teaching methods. The aim is to
establish a framework for developing the envisaged programme.

3.2 COMPUTER LITERACY

This sub-section aims to describe the concept of computer literacy (CL) and
determine the content to be included in a CL programme.

3.2.1 Definition of computer literacy

In 1976 Nevison coined the term CL and unwittingly sparked a long, complex
debate when he wrote: “Because of the widespread use of elementary
computing skills, there should be an appropriate term for this skill. It should
suggest an acquaintance with the rudiments of computer programming, much
as the term literacy connotes a familiarity with the fundamentals of reading
and writing, and it should have a precise definition that all can agree on. It is
reasonable to suggest that a person who has written a computer programme
should be called literate in computing. This is an extremely elementary
definition. Literacy is not fluency" (Nevison, 1976:401).
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In studying related literature, the researcher found that the precise definition

that Nevison called for has yet to emerge from the voluminous debate on the
topic. The range of the debate runs from Nevison's original idea - CL as
programming ability - to the idea that quickly followed on its heels - the notion
that programming ability is passé and what matters is the ability to choose and
run applications.

The Webster's Il New College Dictionary (1999) defines CL as "the ability to
use a computer and its software to accomplish practical tasks". The General
Education Committee of UMass Dartmouth (1996:0nline) gives the following
definition: “CL includes an understanding of computer hardware, computer
software and applications, computer interfaces and social and ethical issues
such as computer security, viruses and privacy’.

Eisenberg and Johnson (1999:0nline) states that a meaningful, unified CL
curriculum must be more than a "laundry list" of isolated skills, such as
knowing the parts of the computer; writing drafts and final products with a
word processor and searching for information using a CD-ROM database.
While these specific skills are certainly important for students to learn, the
"laundry list" approach does not provide an adequate model for students to
transfer and apply skills from one situation to another. These curricula
address the "how" of computer use, but rarely the "when" or "why." Students
should be able to recognise what they need to accomplish, determine whether
a computer will help them to do so, and then be able to use the computer as
part of the process of accomplishing their task.

Although a number of other definitions of CL are to be found in literature
resources, the one outstanding fact that emerges from most publications is
that there is no specific standard for CL - as computer technology changes, so
do the requirements for being computer literate. Kim and Keith (1994:0nline)
assert that there is no globally accepted definition of CL, and the scope and
orientation of the training required to achieve literacy has not been resolved.
Ross (2001:0nline) explains CL by stating that “because computers and their
applications are so diverse and changing so rapidly, no one is completely
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computer literate - CL usually refers to basic skills of use to students in any

field, as opposed to those needed only by computer professionals’.

Although there is apparently no consensus on the exact definition of CL, the
statement of Harvey that “... every person needs skills to cope with the
computer-centred society” (1990:0nline) is even more applicable today than it
was in 1990.

In the following sub-section the researcher investigates the aspects that
should form the basis of a CL programme.

3.2.2 Proposed syllabus for a computer literacy programme

In August 2000 the Computer Society of South Africa sent letters to all
Universities in South Africa with the following introductory paragraph: “The
Computer Society of South Africa has long been aware of the problem with
uneven levels of end user-training in South Africa. It has therefore introduced
the International Computer Driving License (ICDL). More than 750 000 people
in Europe have an ICDL or are registered to obtain one. The ICDL is also the
required entry level for many programmes in the new UNESCQO curriculum for
IT education at tertiary level.” (Computer Society of South Africa, 2000:1).

By introducing the ICDL a standard was set for CL training. The syllabus of
the ICDL consists of seven modules. An overview of each of the modules’
content is given below:

< Module 1: Basic concepts of information technology (IT), requires the
student to know about the basic physical make-up of a personal computer
and understand some of the basic concepts of IT such as data storage and
memory, the context for computer-based software applications in society,
and the uses of information networks within computing. This is the only

one of the seven modules that is tested by writing a theory examination
paper.
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< Module 2: Using the operating system and managing files, requires the

student to demonstrate knowledge and competence in using the basic
functions of a personal computer and its operating system. The student
should be able to operate effectively within the desktop environment,
manage and organise files and directories/folders and know how to copy,
move and delete files.

< Module 3: Word processing, requires the student to demonstrate the ability
to use a word processing application on a personal computer. (S)he
should understand and be able to accomplish basic operations associated
with creating, formatting and finishing a word processing document ready
for distribution. The student should demonstrate competence in using
some of the more advanced features associated with word processing
applications such as creating standard tables, using pictures and images
within a document, importing objects and using mail merge tools.

@ Module 4: Spreadsheet, requires the student to understand the basic
concepts of spreadsheets and to demonstrate the ability to use a
spreadsheet application on a personal computer. (S)he should understand
and be able to accomplish basic operations associated with developing,
formatting and using a spreadsheet. The student should be able to
accomplish standard mathematical and logical operations using basic
formulas and functions and demonstrate competence in using some of the
more advanced features of a spreadsheet application such as importing
objects and creating graphs and charts.

< Module 5. Database, requires the student to understand the basic
concepts of databases and demonstrate the ability to use a database on a
personal computer. The student should not only be able to design and
plan a simple database, but also retrieve information from an existing
database by using query, select and sort tools. Furthermore, the student
should also be able to create and modify reports.

< Module 6: Presentations, requires the student to demonstrate competence
in using presentation tools on a personal computer. The student should be
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able to accomplish basic tasks such as creating, formatting and preparing

presentations for distribution and display.

# Module 7. Information and communication, requires the student to
accomplish basic Web search tasks using a Web browser application and
available search engine tools and secondly to demonstrate the ability to
use electronic mail software to send and receive messages.

Another example of a CL standard is the IC3 certification programme.
Certiport Incoporate (2002:Online) introduced this programme in February
2002 in the United States of America. It was designed for individuals who
were qualified as instructors or trainers of basic computing and Internet
literacy skills and was developed in response to a certification gap identified
through extensive nationwide academic programmes administered by
Certiport. The certification programme is comprised of three modules, i.e.
Computing fundamentals, Key applications and Living online.

The syllabi of the different modules in the IC3 certification programme include
the following:

@ Module 1: Computing fundamentals, requires students to be able to
identify different types of computers, explain how computers work (process
information) and how individual computers fit into larger systems. Students
must be able to describe the function of computer hardware components
and common problems associated with individual components, identify
issues relating to computer performance and how it is affected by different
components of the computer, and identify the factors that go into a
decision on how to select or purchase a computer or select a computer for
work, school, or home. Students should be able to identify how software
works and how software and hardware work together to perform
computing tasks, identify different types of software, and the tasks for
which each type of software is suited. Students should also be able to
identify what an operating system is and how it works, be able to
manipulate and control the Windows desktop, files and disks and be able
to change system settings and install software.
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* Module 2: Key applications, requiregsf students to be able to start and exit a
Windows application, utilise sources of online help, identify common on-
screen elements of Windows applications, change application settings,
and manage files within an application. Students should be able to perform
common editing (cut, copy, paste, spell check, etc.), formatting (fonts,
margins, tabs, etc.) and common printing functions. Using a word
processor, students should be able to format text and documents including
the ability to use automatic formatting tools and add tables and graphics to
documents. Requirements for spreadsheet functions are to be able to
modify worksheet data and structure, sort data, manipulate data using
formulas and functions and be able to add pictures and charts to a

worksheet.

* Module 3. Living online, requires students to identify network
fundamentals, the benefits and risks of network computing and the
relationship between computer networks, other communications networks
(like the telephone network) and the Internet. Students should be able to
identify how electronic mail works and know how to use e-mail applications
applying netiquette. Students should .be able to identify how computers are
used in different areas of work, school, and home and identify how to use
the Internet safely and legally.

In assessing the ICDL and IC3 programmes, it could be deducted that a CL
programme should include the following:

& A theory section which covers the basic principles of computer hardware
and software.

< A practical section covering the basic principles of using a word processing
application.

@ A practical section covering the basic principles of using a spreadsheet
application.

& A practical section covering the basic principles of using an operating
system.
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& A practical section covering the basic principles of using the Internet and

e-mail applications.

Although the ICDL also includes database and presentation packages,
students could obtain certification after completing any four of the seven
modules.

Having established the elements of a CL programme, the researcher
continues in the next section by looking into the principles of OBE.

3.3 OUTCOMES-BASED EDUCATION

The programme that will be developed through this research should be
implemented in higher education institutions in South Africa. As South Africa
has adopted an outcomes-based education system (Department of Education,
South Africa, 1998:2) it is imperative that the programme be developed on
outcomes-based principles as applied in the South African context. This

section aims to investigate these principles.

3.3.1 Definition of outcomes-based education

Killen (2001:2) gives a simple definition of outcomes-based education (OBE)
by stating that OBE is an approach to planning, delivering and evaluating
instruction that requires instructors and students to focus their attention and
efforts on the desired end results of education, particularly when those end
results are expressed in terms of student learning.

Malan (1997:10) elaborates on Killen's definition by stating that “education —
the process of teaching and learning — is outcomes-based when it accepts as
its premise that the definition of outcomes should form the basis of all
educational activity, including the description of qualifications, the
development of curricula, the assessment of students, the development of
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educational structures and institutions and even the planning of finances,
buildings and other resources’.

Spady’s view (1994:1) is that OBE means clearly focusing and organising
everything in an educational system around what is essential for all students
to be able to do successfully at the end of their learning experiences. This
means starting with a clear picture of what is important for students to be able
to do, then organising the curriculum, instruction and assessment to make
sure this learning ultimately happens.

3.3.2 Key elements of OBE

An analysis of the underlying principles of OBE reveals the following:

@ All decisions are driven by the vision of what the student should be able to
do and not merely know (Killen, 1998:2).

= QBE relies on the technique of mastery learning, based on the assumption
that all students can learn and succeed and that failure is not an option
(Van der Horst & McDonald, 1997:11). The general aim of mastery
learning is to ensure that students are granted opportunities to be
successful at most tasks, by providing an appropriate learning
environment, materials and back-up guidance.

@+ Spady and Marshall (1991:61) further state that OBE is built upon the
principle that success breeds success and that schools control the
conditions that determine whether or not students succeed.

= In an OBE system it is expected of students to collaborate in learning
rather than to compete with one another (Centre for Community
Development, 2002:115).

3.3.3 Outcomes in OBE

According to Killen (2001:2), outcomes can be defined as what you can do

and what you understand, the contextually demonstrated end-products of the
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learning process. Outcomes areTe;r:;M::sS:Tts of the learning process, i.e.
knowledge, skills, attitudes and values, within a particular context so that
knowledge is applied, skills develop into competencies and attitude and
values harmonise with those of the workplace. An outcome is only an
outcome if it can be demonstrated and measured. This implies that students

must be actively involved in the learning process.

Spady (1994:49) asserts that outcomes are the learning results that are
desired from students that lead to culminating demonstrations. The word
“culminating” is used because the results and their demonstrations occur at
the end of a significant learning experience. Outcomes are thus not simply the
things students believe, feel, remember, know or understand, but rather what
they can actually do with what they know and understand. Isaacman (1996:8)
agrees by stating “an outcome is anything which you can show that you know
and can do’.

To determine whether a student has achieved the desired outcomes, he/she
must be assessed. Assessment strategies in OBE are discussed in the next

section.
3.3.4 Assessment in OBE

The purpose of assessment is to provide information on student achievement
and progress (Australian National Training Authority, 2003b:9). This section
aims to establish how assessment should be applied in OBE.

3.3.4.1 Overview of important terminology

To be able to describe and fully understand OBE assessment, it is necessary
to ensure that the reader has a clear view of the meaning of the following
assessment-related terminology:

e Criterion-based assessment
When students are assessed against a set of external criteria, the assessment
is known as criterion-based (Malan, 1997:29). The norm which has to be
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attained is not a predetermined mark, but the demonstration of a particular
ability or competence. According to Van der Westhuizen, Van Wyk, Collett,
Jacobs and Debeila (2002:140), criterion-based assessment has the following

principles:

@ assessment criteria are clearly defined at the beginning of an activity;
& competencies are acquired through interaction with the ;

@ |evels of proficiency are expressed on a continuum and

& a student’s achievements can be judged without comparing it with that of
another student.

o Performance-based assessment

Killen (1998:23) describes performance-based assessment as a type of
assessment where students are required to demonstrate that they have
achieved specific outcomes by performing a task or producing a product.
Performance-based assessment can be seen as a form of criterion-based
assessment and according to Malan (1997:30) takes place when a student’s
performance is directly and systematically observed. With performance-based
assessment students are engaged in activities that require them to
demonstrate specific skills or develop specified products. The demonstrations
can take place in a controlled environment such as a laboratory or classroom
or in a realife environment where the complexities faced by students are
much higher. It can also be applied to evaluate completed products, e.g.
models or assignments.

e Formative assessment

Formative assessment is defined by Van der Horst and McDonald (1997:168)
as assessment that aims to help students to improve their performance,
maximise their learning and reflect on and improve their own learning. Archer
and Rossouw (1999:109) explain that formative assessment builds up a
system of feedback which forms and shapes the appropriate learning
experience to the optimal benefit of students.
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e Summative assessment

According to Archer and Rossouw (1999:111), summative assessment is
intermittent and usually applied as a final judgement at the end of a learning
unit. Van der Horst and McDonald (1997:168) define it as a summary of the
student’s performance. All forms of assessment are added together and this
sum is then used to provide an overview of student progress and/or barriers to
learning and assist in meaningful interpretation of strengths and needs.

3.3.4.2 Defining OBE assessment

The Department of Education (1998:2) in South Africa defines OBE
assessment as the process of identifying, gathering and interpreting
information about a student’s learning. The central purpose of assessment is
to provide information on student achievement and progress and set the
direction for ongoing teaching and learning. The Free State Department of
Education (1997.5) elaborates on this point by stating that the process
involves the following four steps:

@ generating and collecting evidence of achievements during the course of
activities;
@ measuring this evidence against the set criteria;

@ recording the findings on an appropriate form and

@ using this information to assist the student’s development on the path
towards success.

Killen (1998:20) views assessment of student leaming as an essential
element of OBE because students should be able to demonstrate their
achievement of predetermined outcomes. It is therefore imperative to provide
students with opportunities to demonstrate their achievements and it is
necessary to have valid, reliable and fair ways of judging these
demonstrations. It is further stated that, although instructors are accustomed
to assessing students, OBE assessment requires special techniques. It must
be kept in mind that the idea that “some students can learn well and others
cannot” is not part of the philosophy of OBE. Therefore, assessment should
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be used to show students what they have learned and what they still need to
learn. Assessment should always contribute to the goal of improving students’
learning therefore assessment tasks must provide opportunities for students
to demonstrate what they have learned and to help them identify what it is that
they still need to leamn.

3.3.4.3 OBE assessment strategies
In this section the researcher looks at different methods and techniques of
implementing OBE assessment.

e Different methods of OBE assessment
At a workshop on OBE assessment by the Free State Department of
Education (2000:9) the following were listed as possible methods of OBE

assessment:

& Self assessment describes the type of assessment where students have to
make judgements about whether or not they have achieved specific
outcomes and if they have not, they need to make decisions to continue
their learning (Killen, 1998:24). Even young children are able to make
judgements about their own leaming provided they understand the criteria
by which their learning should be evaluated. He adds that there is a limit to
how much responsibility students can be given for their own assessment
and instructors still need to make regular checks on their students’
progress.

* Peer assessment is an extension of self assessment and involves students
at approximately the same stage of learning making judgements and
providing feedback on each other’s performance (Killen, 1998:24). There
are many practical difficulties with peer assessment and it is suggested
that both self assessment and peer assessment should be thought of as
supplementary methods of assessment and not be the prime method of
assessment.

< Group assessment is an extension of peer assessment and is the situation
where a student is judged by a group of other students. The Curriculum
2005 document (Department of Education, 1997:10) states that group
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work plays an important role in OBE and encourages instructors to take

advantage of this teaching strategy.

Observation-based assessment is seen as an invaluable assessment and
instructional tool. (Van der Horst & McDonald, 1997:190). Through
observation, an instructor can assess the student’s schoolwork, as well as
spot clues to possible causes of the student’s behaviour or lack of
understanding.

Instructors can use interviews or oral questioning to try and assert whether
a student has accomplished certain competencies. The interview may be
structured in the form of specific questions or an unstructured dialogue
with an individual or a group of students.

Although tests and examinations are seen as part of a more traditional
education system, they still have an important role to play as OBE
assessment methods. As Van der Horst and McDonald (1997:167) remark:
“Learning may be more than merely knowing the right answers, but the
right answers are important as well. While schooling is about learning to
think and solve problems, it is also about knowledge”. Woolfolk (1995:56)
adds to this: “students must have something to think about — facts, ideas,
concepts, principles, theories, explanations, arguments, images, opinions.
Well-designed traditional tests can evaluate student’s knowledge
effectively’. At a workshop attended by Free State educators (Free State
Department of Education, 2000:8) they were advised to use
tests/examinations to reach meaningful assessment, but were cautioned
that final assessment should not be concentrated in only one final

examination.

Techniques of assessment

The following are some examples of techniques that can be used in OBE

assessment:

< Practical assignments, e.g. scientific experiments, building models,

drawing a map of the community or creating some document on a
computer.

80

© Central University of Technology, Free State



Central University of
Technology, Free State

@ Projects which can either be done alone or as part of a group where a

number of students work on a task together. A project might require
planning, research, discussion and presentation.

@ Written assignments, e.g. essays. A written assignment involves
descriptions, analysis, explanations and summaries.

@ Role-play where it is required of students to temporarily take on the role of
a specific figure, e.g. in the role of a receptionist working with clients.

< Demonstrations, where students have to practically show that they have
accomplished an outcome, e.g. riding a bicycle.

3.3.5 OBE in the South African context

As mentioned, South Africa adopted an outcomes-based education system
when Curriculum 2005 was introduced into schools in 1998 (Department of
Education, South Africa, 1998:2). The new Curricuum 2005 and its
implementation were reviewed by a Ministerial Committee in 2000. The
Review Committee recommended that strengthening the curriculum required
streamlining its design features and simplifying its language through the
production of an amended National Curriculum Statement (Department of
Education, South Africa, 2002:5). It further recommended that this Revised
National Curriculum Statement should reduce the curriculum design features
from eight to three:

@ critical and developmental outcomes
@ |earning outcomes, and

@ assessment standards.
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Critical and developmental outcomes

Critical outcomes are general outcomes and apply to all learning areas. The

South African Qualifications Authority (SAQA) selected seven critical

outcomes which should serve as guidelines for all other outcomes defined for

South African students. The critical outcomes envisage students who will be
able to (Department of Education, South Africa, 2002:11):

&

Identify and solve problems and make decisions using critical and creative
thinking.

Work effectively with others as members of a team, group, organisation
and community.

Organise and manage themselves and their activities responsibly and
effectively.

Collect, analyse, organise and critically evaluate information.

Communicate effectively using visual, symbolic and/or language skills in
various modes.

Use Science and Technology effectively and critically showing
responsibility towards the environment and the health of others.

Demonstrate an understanding of the world as a set of related systems by

recognising that problem-solving contexts do not exist in isolation.

The developmental outcomes envisage learners who are also able to:

(5 o

v

&

&

&

Reflect on and explore a variety of strategies to learn more effectively.

Participate as responsible citizens in the life of local, national, and global
communities.

Be culturally and aesthetically sensitive across a range of social contexts.
Explore education and career opportunities.

Develop entrepreneurial opportunities.
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e Learning outcomes

In the South African context a learning outcome is derived from the critical and
developmental outcomes (Department of Education, South Africa, 2003:14). It
is a description of what (knowledge, skills and values) learners should know,
demonstrate and be able to do after completing a Learning Area (subject). As
this study is concerned with CL, the leaming outcomes for the subject
Computer Applications Technology (CAT), which deals with computer literacy,
are listed here (Department of Education, South Africa, 2003:14-18):

# Learning outcome 1. The learner is able to demonstrate operational
knowledge of information and communication technologies and the
environments in which they operate.

@ |Learning outcome 2: The learner is able to apply and integrate end-user
computer applications skills and knowledge to solve problems related to
the processing, presentation and communication of information.

< Learning outcome 3: The learner is able to apply information management
processes and skills using end-user computer applications.

e Assessment standards

Assessment standards describe the level at which leamers should
demonstrate their achievement of the learning outcome(s) and the ways of
demonstrating their achievement (Department of Education, South Africa,
2003:15). They embody the knowledge, skills and values required to achieve
learning outcomes. The learning outcomes describe what learners should
know and be able to do, whilst the assessment standards describe the
minimum level, depth and breadth of what is to be learnt. In practical terms
this means that leamning outcomes can and will, in most cases, remain the
same from grade to grade while assessment standards change from grade to
grade. Table 3.1 displays the relation between the learning outcomes and
assessment standards for the subject Computer Applications Technology in
grade 10 (Department of Education, South Africa, 2003:40).
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Learning Learning Qutcome 1 Learning Qutcome 2 Learning Qutcome 3
ST Operational knowledge Integrated end-user Information
: of Information and computer applications | management
Communication skills and knowledge in
Technologies problem-solving The leamner is able to
apply information
The learner is able to The learner is able to management processes
demonstrate operational apply and integrate end- | and skills using end-user
knowledge of information | user computer computer applications.
and communication applications skills and
technologies and the knowledge to solve
environments in which problems related to the
they operate. processing, presentation
and communication of
information.

Assessment We know this when the We know this when the We know this when the

Standards for learner: learner: learner:

Grade 10: & describes and @ achieves a basic @ uses available
explains the basic level of competence technologies to
concepts of computer in the use of input locate data from
hardware, software devices different sources and
and information @ enters, edits and resources and
technology including processes text, collects it using
networked numerical data and relevant methods
environments graphics using basic | ¥ extracts and

& identifies and uses techniques in a word processes relevant
available input and processing program information and
output devices @ enters, edits and records it in useful
appropriately processes text and electronic formats

@ develops an numerical data using | = presents and
organisational basic functions and communicates
structure to manage formulae in a information in text
different types of spreadsheet program and/or numerical
files by applying correct formats

® identifies legal, techniques
cthical and security @ solves problems by
issues related to using a word
information processing and/or a
technology spreadsheet program

@ describes and @ interprets simple
evaluates the local layout and editing
impact of information instructions to
technology on the produce accurate
environment, output of text,
community and numerical data and
personal health graphics

& states and discusses @ demonstrates an
how developments in understanding of a
information and variety of
communication communication
technologies affect modes and tools
and facilitate human
interaction

Table 3.1 Learning outcomes and assessment standards for the subject Computer
Applications Technology in grade 10 (Department of Education, South Africa,
2003:40).
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The principles of OBE assessment (cf3.3.4) should be applied to assess
students and provide indications of their achievements.

Section 3.3 describes a number of OBE-related principles that will have to be
taken into consideration when designing the envisaged programme (cf. 4.4.2).
The following section aims to broaden this framework by looking at principles
of good teaching practice.

3.4 PRINCIPLES OF GOOD TEACHING PRACTICE

Several advantages of using a blended learning approach have been
discussed in Chapter Two (cf. 2.2). However, it is clear that simply blending
face-to-face instruction with any technology does not necessarily result in an
effective instructional programme. Ehrmann (1995:23) asserts that what
matters most is not the technology per se, but how it is used, and not so much
what happens in the moments when the student is using the technology, but
more how those uses promote larger improvements in the fabric of the

student's education.

The “Seven principles of good practice for undergraduate education” were
developed by Chickering and Gamson (1987:0nline). As distilled findings from
decades of research, the principles provide a solid basis for good pedagogy in
traditional education. Since published, educators embraced the principles and
they have continued to be refined and used in a variety of ways (Chickering &
Ehrmann, 1996:3).

The seven principles are:

# Principle 1: Encourage contact between students and instructor
< Principle 2: Develop reciprocity and co-operation among students
< Principle 3: Encourage active learning

< Principle 4. Provide prompt feedback
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@ Principle 5: Emphasize time on task
& Principle 6: Communicate high expectations

# Principle 7: Respect diverse talents and ways of learning

In an interactive-style workshop delivered at the Telelearning '97 Conference
Spear and Bruce (1997:1-5) led participants in an examination of distance
learning pedagogy and explored ways to outline and implement good teaching
principles as standards for delivering quality distance learning courses. As a
result of the discussion that followed their presentation the authors added an
eighth principle: “Making effective use of technology”.

In studying the principles of good practice, the researcher came to the
conclusion that these same principles can be applied in a blended learning
environment to ensure good teaching practice. However, it is the view of the
researcher that, in using computer-mediated instruction, principles 3 and 4
are so closely related that they should be seen as one. Thus for the purpose
of this study principle 3 and 4 will be combined to: Encourage active learning
and provide prompt feedback.

It is the aim of the following sub-sections to describe principles of good
practice, and strategies to implement these principles in a blended learning
environment.

3.4.1 Encourage contact between students and instructor

Frequent student-instructor contact in and out of classes is the most important
factor in student motivation, intellectual commitment and personal
development. Concerned instructors can help students get through rough
times so they will keep working toward their goals. Students describe good
instructors as approachable, interested, easy to talk to, inviting of student
views, concemned about student progress, and open to helping students with
problems (Chickering & Gamson, 1991:15).
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Spear and Bruce (1997:1-5) led participants in an examination of distance
learning pedagogy and explored ways to outline and implement good teaching
principles as standards for delivering quality distance learning courses. As a
result of the discussion that followed their presentation the authors added an
eighth principle: “Making effective use of technology”.

In studying the principles of good practice, the researcher came to the
conclusion that these same principles can be applied in a blended learning
environment to ensure good teaching practice. However, it is the view of the
researcher that, in using computer-mediated instruction, principles 3 and 4
are so closely related that they should be seen as one. Thus for the purpose
of this study principle 3 and 4 will be combined to: Encourage active learning
and provide prompt feedback.

It is the aim of the following sub-sections to describe principles of good
practice, and strategies to implement these principles in a blended learning
environment.

3.4.1 Encourage contact between students and instructor

Frequent student-instructor contact in and out of classes is the most important
factor in student motivation, intellectual commitment and personal
development. Concerned instructors can help students get through rough
times so they will keep working toward their goals. Students describe good
instructors as approachable, interested, easy to talk to, inviting of student
views, concemed about student progress, and open to helping students with
problems (Chickering & Gamson, 1991:15).
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Communication technologies that increase access to instructors can

strengthen instructor interactions with all students, but especially with shy
students who are reluctant to ask questions or challenge the instructor directly
(Chickering & Ehrmann, 1996:3). It is often easier to discuss values and
personal concerns in writing than orally, since inadvertent or ambiguous
nonverbal signals are not so dominant. E-mail, computer conferencing, and
the World Wide Web increase opportunities for students and instructor to
converse and exchange work much more speedily than before, and more
thoughtfully and “safely” than when confronting each other in a classroom or
instructor’s office. Total communication increases and, for many students, the
result seems more intimate, protected, and convenient than the more
intimidating demands of face-to-face communication. Communication is eased
when student or instructor (or both) is not an English first language speaker;
each party can take a bit more time to interpret what has been said and
compose a response. With the new media, participation and contribution from
diverse students become more equitable and widespread.

Instructors can use the following guidelines to implement the principle of
student-instructor contact in a blended leaming environment (Spear, 2003:4;
Schlebusch & Oosthuizen, 2003:5):

@ QOffer various forms of contact, e.g. e-mail, phone calls, fax, and face-to-
face appointments.

@ |nform students of the expected time in which the instructor will respond to
e-mail or voicemail messages (e.g. within 24 hrs).

& Qutline the rules students should follow when communicating via e-mail,
voicemail, or other modes of communication.

@ Establish face-to-face as well as virtual office hours, i.e. times when the
instructor will be available for online chats, phone calls, or immediate e-
mail response.

& Acknowledge initial receipt of students' e-mail with an automatic e-mail
reply.
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& Inform students that infrastructure problems (e.g. a problem with the

server) are beyond the control of the instructor and have an impact on
response time.

< Regularly send general messages to the whole class.

< If possible, contact students before the start of the course. Let them know
where to find the class (either the face-to-face class or the online class),
and when the formal classes will start. Advise students to get course
materials before the start of classes, and let them know what to expect
during the first week of class.

< Hold an orientation session at the beginning of the course.
& Get to know students as individuals.

# Refer to students by name.

* Follow-up on students who are not participating.

@ Establish replies and responses as important values of online discussions,
through tone, modelling, and marks allocated for assignments.

# Encourage student questions, input, and feedback. Clearly state that all
points of view are welcome and respected.

= Become involved in online class discussions.

As blended learning implies the convergence of face-to-face learning with e-
learning, it is a given that the students will have direct contact with the
instructor. The instructor should, however, carefully consider how the face-to-
face contact will be blended into the programme (Ward & LaBranche,
2003:23). It is possible that face-to-face lectures form the major part of
instruction and that learning is enhanced by e-resources, like web-access,
CAL or e-communication. Another scenario is to have a “digital sandwich”
where a face-to-face class is first preceded and afterwards followed-up by an
e-learning experience. This provides the students with the chance to continue
dialogue with each other and the instructor, ask follow-up questions, and
continue to learn.
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A definite way of enhancing student-instructor contact, is to hold an orientation

session right at the beginning of the course (Australian National Training
Authority, 2003a:9). This session usually involves talk about what is required,
followed by some work directly on computer. During the orientation session
the instructor should provide students with guidelines to organise and manage
their time, introduce them to the online or CAL platform, and sort out security
issues such as passwords needed to log into the system and practise. The
orientation session may also be an important social occasion where the
instructor and the students get to know each other, and the ideal time for
putting people into groups and assigning group tasks. As blended learning is
a fairly new methodology, the orientation session can be used to introduce
students to this concept, indicating to them exactly how they can benefit by
combining traditional and e-learning aspects.

3.4.2 Develop reciprocity and co-operation among students

is the process of getting two or more students to work together to learn
(linois Online Network, 2003c:Online). Students work in small teams
composed of participants with, preferably, differing ability levels and using a
variety of learning activities to master material. Each member of a team is
responsible for learning what is taught and for helping teammates learn.
Research has indicated that co-operative learming can be more effective than
interpersonal competitive and individualistic efforts in promoting cognitive

development, self-esteem, and positive student-student relationships.

Online learming models are natural environments for getting students to work
together, however, learning activities have to be specifically and carefully
designed to work effectively (lllinois Online Network, 2003c:Online). According
to Chickering and Ehrmann (1996:4), one of the earliest surprises about
computers is the extent to which computer-based tools encourage
spontaneous student collaboration. A clear advantage, for instance, of e-mail,
is that it opens up communication among classmates even when they are not
physically together.
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In order for effective learning to occur, the instructor should create a sense of

community in the virtual classroom (lllinois Online Network, 2003a:0nline).
The discussion element of an online course is seen to play a critical role in
creating and sustaining this sense of community. The synergy of the
discussion is probably the most important learning tool of online courses.
Learning teams should bond and thus make each student in the group want to
do his or her share.

Successful instructors use strategies to help create an environment in which
participants feel eager to contribute and comfortable with the demands and
pace of the discussion - both in face-to-face and online classes (lllinois Online
Network, 2003d:Online). To enhance co-operative learning the instructor can
(Spear, 2003:4; Schlebusch & Oosthuizen, 2003:5):

@ request students to complete a personality questionnaire for the formation
of compatible and effective learning work groups;

@ either assign students to groups or request students to form their own
groups;

@ assign student forum moderators and summarisers;

@ encourage links between students, e.g. exchange of phone numbers and
e-mail addresses;

@ design activities that promote co-operation;

@ structure the content of the programme in such a way that it encourages
co-operation;
& use techniques for fostering student co-operation, e.g. peer reviews, chats,

bulletin boards, and discussion forums, and

@ request students to e-mail a list of group goals, and assigned
responsibilities mid-way through a group assignment;
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To promote co-operation, group members should:

<« provide each other with mutual support and advice on a variety of topics,
including test preparation and administrative matters;

& critique each other's written work, e.g. term papers, and

« work together on group projects, e.g. develop a team presentation or
report on a specific topic, collaborate to produce a group answer to an
open-ended discussion question, develop an analysis of a case study or
write a joint research paper.

Discussion forums can be used to get students to participate in online
programmes. In this case the focus shifts from the instructor and the course
materials as the source of knowledge, to students as an important source of
knowledge (Australian National Training Authority, 2003a:22). For example, if
a student e-mails the instructor with a query that is relevant to the group, the
query can be posted to the forum, and all students can then reply. The
instructor has to monitor the discussions and intervene, if necessary, or close
the discussion by providing the correct answer.

A student should be able to obtain a grade for participation and a minimum
number of weekly contributions to discussions (lllinois Online Network,
2003a:0nline). This will motivate shy students to participate in online
discussions. At first, students may submit short, superficial responses but in
time their responses and contributions will show more depth and insight.

3.4.3 Encourage active learning and provide prompt feedback

To maximise learning, students must interact with the material they are
learning, write about it, relate it to past experiences and incorporate what they
are learning into their world view. They must be able to make what they learn
an indispensable part of them to take valuable skills and knowledge into the
workplace and career pursuits. Research indicates that teaching methods that
encourage student activity and involvement are likely to be superior to more
passive methods when higher-level cognitive or affective learning is the goal
(Chickering & Gamson, 1991:4). Felder (1992:0nline) asserts that actively
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involving students in leaming, instead of simply lecturing to them, leads to
improved attendance, deeper questioning, higher grades, and greater lasting
interest in the subject.

Active learning strategies may be implemented in the face-to-face classroom
as well as the online classroom (University of Alberta, 2002a:0nline).
Interaction takes different forms: between a student and course materials;
between student and leaming activities; between student and instructor;
among students; and, in a computer-mediated environment, between the
student and the technology. Gilbert and Moore (1998:30) note that interactivity
in computer-mediated instruction is defined as a reciprocal exchange between
the technology and the student. Interactivity includes the element of
"feedback".

Getting prompt feedback from the instructor is as important as getting
feedback from the computer. Students need appropriate and timely feedback
on performance to get the maximum benefit from their education. They need
frequent opportunities to perform and receive suggestions for improvement,
and they need to learn how to assess and evaluate their own learning and

competency progress.

Feedback consolidates a student's understanding, enables him or her to plan
how to study, and allows the instructor to elaborate on the instruction
(University of Alberta, 2002a:0nline). Zirkin and Sumler (1995:101) found that
interaction seemed to have an impact on student achievement, as well as
satisfaction. “The weight of evidence from the research reviewed, was that
increased student involvement by immediate interaction, resulted in increased
learning as reflected by test performance, grades, and student satisfaction.”

Although some text found in literature reveal deep doubts that e-learning
methods can ever have the degree of interaction as is the case in a non-
distance environment, studies such as one by Miller and Webster (cited in
Roblyer & Ekhaml, 2000:Online) have found no significant difference in
assessments of interaction between students in a face-to-face and online
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programme. Hirumi and Bermudez (1996:6) are among those who find that,

with proper instructional design, e-learning can actually be more interactive
than traditional learning, providing more personal and timely feedback to meet

students’ needs than is possible in large, face-to-face classes.

Students need much more support and feedback in the online environment
than in a traditional course (lllinois Online Network, 2003b:Online). This is
because the potential threat that students feel alienated is quite high in the
virtual classroom. Getting students actively involved and using effective
feedback strategies will enable the instructor to identify and meet individual
student needs as well as encourage students to participate and continue to
participate at a high quality level.

As mentioned (cf. 3.4.2), there are activities that can be used to provide
opportunities, and encourage students to interact and collaborate with one
another.

The following activities can be considered to increase the active involvement

of students and promote higher-order learning:

% Provide assignments that simulate in some way the real world application
of the course content.

# Engage students in meaningful activities throughout the instruction not just
at the end of a module or unit.

@ Require students to generate meaning for themselves by asking them to
analyse, compare, evaluate, and synthesise the concepts, principles, and
procedures.

The following guidelines to create a dynamic, active and intellectually
stimulating environment for students in blended learning, reflect some of the
principles mentioned in this section (Spear, 2003.6; Schlebusch &
QOosthuizen, 2003:6):

« Ask students to state what they expect to leamn in the class.
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% Ask students to provide and critique web sites that enhance leaming.

< Pose online discussion questions that foster critical thinking and problem
solving.

# Use open-ended questions to encourage extended and wide-ranging

online dialogue.

& Instruct students to review the content by taking computer-based quizzes
that are automatically graded.

@ Ask students to teach or help their classmates.
# Encourage students to, not only give facts, but express their opinions.

< Follow-up reading assignments with online discussions, simulations, or

applications to case studies/scenarios.
@ Ask students to critique other students' work.

# Ask students to reflect on their learning, e.g. “In your own words, describe
what you have learned”.

# Provide unexpected, small assignments for which students can get bonus
credits.

Strategies for providing feedback in the blended learning environment
classroom include (Spear, 2003:5; University of Alberta, 2002a:0nline):

@ Respond with frequent e-mail: with answers to questions, comments about
lesson/unit content, giving directions and information.

@ Return tests, papers, and assignments within one week, i.e. make results
available on a regularly basis. It is important that students have ongoing
information about their progress. Feedback on grades must be private
communication.

< Provide substantive critique, comment, and/or evaluation for work
submitted by individual students or groups, referring to additional sources
for supplementary information where appropriate.

< Hold virtual office hours for students to discuss their graded work. During
these hours the instructor must be available for immediate feedback.
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# Acknowledge all student questions. If it is not possible to answer a

question immediately, inform the student of the expected delay in getting

the right answer.

@ Link feedback to associated reference materials for enrichment or remedial
support.

@ Take note of students who don't participate during the first session, and
contact them individually after class. They may have technological
difficulties, and it is critical to get them resolved as soon as possible. If
students are focusing on the medium of delivery, they cannot focus on the
course content.

< Thank students publicly for comments submitted to the virtual classroom
showing insight or depth. This will serve to model the types of responses
and critical thinking skills expected from other participants as well as give
positive reinforcement to the student who contributed the message.

= |rrespective of the specific learning activity, the instructor should recognise
quality work and intervene as the work is being developed to steer
students in the right direction. When the instructor participates in an online
conference providing extensive critique, feedback, and encouragement,
students cannot help but become more involved.

Roblyer and Ekhaml (2000:Online) designed the rubric given in Table 3.3 that
can be used for evaluating interactive qualities of distance learning
programmes. As many of the techniques used in distance learning are
applicable to blended learning it is the view of the researcher that this rubric
can successfully be used to evaluate a blended learning programme.
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The rubric has four separate elements that contribute to a programme’s level

of interaction and interactivity, namely:

1.  Social rapport-building activities created by the instructor;

2. Instructional designs for learning created by the instructor;

3. Levels of interactivity of technology resources, and

4. Impact of interactive qualities as reflected in student response.

A programme is evaluated by circling a description for each of these four

elements that applies best to the programme. After reviewing all elements and

circling the appropriate level, the points should be totalled to determine the

programme'’s level of interactive qualities (e.g., low, moderate or high).

Low interactive qualities || 1-7 points
Moderate interactive qualities 8 -14 points
High interactive qualities 15-20 points
Scale Element #1 Element #2 Element #3 Element #4
Social Instructional Levels of Impact of
(see Rapport- Designs for Interactivity of Interactive
points building Learning Technology Qualities as
below) Activities Created by the Resources Reflected in
Created by the Instructor Student
Instructor Response
Fow The instructor Instructional Fax, web, or other By the end of the
Sbovmciive does not actiﬁlies do not technology resource course, all students
qualities encourage Students | require two-way allows one-way in the class are
to get to know one || interaction between (instructor to student) || interacting with
(1 point) another on a instructor and delivery of instructor and other
personal basis. No || students; they call for || information (text students only when
activities require one-way delivery of and/or graphics). required.
social interaction, information (e. g.,
or are limited to instructor lectures,
brief introductions || text delivery).
at the beginning of
the course.
Minimum In addition to brief || Instructional E-mail, listserv, By the end of the
Sulernitive introductions, the activities require bulletin board or course, between ;!0-
qualities instructor provides || students to other technology 25% of students in
for one other communicate with the | resource allows two- the class are
(2 points exchange of instructor on an way, asynchronous initiating
personal individual basis only exchanges of interaction with the
each) information (e g. information (text instructor and other
among students, asking/responding to and/or graphics). students on a
€.g., written bio of || instructor questions). voluntary basis
personal (i.e., other than
background and when required).
experiences.
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|
Nodersite In ac!diﬁon to In addition to In addition to By the end of the
faternctive providing for requiring_ studems to technologies used for || course, between 25-
qualities exchanges of communicate with the | two-way 50% of students in
personal instructor, asynchronous the class are
(3 points information instructional activities | exchanges of text initiating
among students, require students to information, chat interaction with the
each) the instructor work with one room or other instructor and other
provides at least another (e. g., in pairs || technology allows students on a
one other in-class or small groups) and synchronous voluntary basis
activity designed share results within exchanges of written (i.e., other than
to increase social their pairs/groups. information. when required).
rapport among
students.
Absgve In at!dition to In addition to the In addition to By the end of the
average providing for requiring studen_ts to technologies used for || course, between 50-
: eraetive exchanges of communicate with the || two-way, 75% of students in
qualities personal instructor, asynchronous the class are
information instructional activities || exchanges of text initiating
(4 points among students, require students to information, interaction with the
the instructor work with one additional instructor and other
each) provides several another (e. g., in pairs || technologies (e. g., students on a
other in-class or small groups) and teleconferencing) voluntary basis
activities designed | share results with one || allow one-way visual || (i.e., other than
to increase social another and the rest and two-way voice when required).
rapport among of the class. communications
students. between instructor
and students.
High level In addition to In addition to the In addition to By the end of the
of providing for requiring students to technologies to allow || course, over 75%
fnteraciive exchanges of communicate with the two-way exchanges of students in the
qualities personal instructor, of text information, class are initiating
information instructional activities || visual technologies interaction with the
(5 points among students, require students to such as two-way instructor and other
the instructor work with one video or students on a
each) provides a variety || another (e. g., in pairs || videoconferencing voluntary basis
of in-class and or small groups) and technologies allow (i.e., other than
outside-class outside experts and synchronous voice & || when required).
activities designed || share results with one || visual
to increase social another and the rest communications
rapport among of the class. between instructor
students. and students and
among students.
Total for pts. pts. pts. pts.
each:
Total pts.
overall:

Table 3.2 Rubric to be used for evaluating interactive qualities of distance learning

programmes (Roblyer and Ekhamli, 2000:Online)
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3.4.4 Emphasize time on task

Chickering and Ehrmann (1996:6) assert that “Time plus energy equals
learning”. Leaming to use one’s time well is critical for students and
professionals alike. Allocating realistic amounts of time means effective
learning for students and effective teaching for instructors. To survive in a
demanding academic world, students have to be pragmatic about how they
spend their time (Wlodkowski, 1993:0nline).

New technologies can dramatically improve time on task for students by
making studying more efficient. Teaching strategies that help students learn at
home or work can save hours otherwise spent commuting to face-to-face
classes. Time efficiency is dramatically increased as a result of modern-day e-
communication. Furthermore, students and instructors alike make better use
of time when they can get access to important resources for learning online,
instead of spending hours in a library (Chickering & Gamson, 1987:0nline).

The following guidelines can be followed to emphasise time on task (Spear,
2003:4; Schlebusch & Qosthuizen, 2003:5):

% Provide an orientation session or a programme overview which indicates
total time students should expect to expend each week. Inform students
about the importance of time on task, and time management skills.

@ Provide learning objectives for each module, lesson, unit or chapter.
@ |ndicate suggested time-on-task for each task.

@ Post notes from assignments and ask each student to respond within a
certain time frame.

@ Require online discussions, e.g. use open-ended question to encourage
extended and wide-ranging dialogue.

@ Build in a reward system of points for all student work — even for simply
participating.
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& Make assignments enjoyable for students to encourage increased time-on-

task.

= Make students aware of time that would have been spent sitting in a face-
to-face class and travelling to class in comparison to time expended on
computer-mediated classes.

3.4.5 Communicate high expectations

Expecting students to perform well becomes a self-fulfilling prophecy when
instructors and institutions hold high expectations of themselves and embark
in extra efforts. Setting reachable goals contributes to successful learning for
the poorly prepared, as well as for the bright and well motivated. Instructors
and students alike must constantly focus on the importance of a high quality
education through continual high expectations (Chickering & Gamson,
1987:0nline).

The most important factor in communicating high expectations is to ensure
that the students are fully informed about what is expected of them. Students
are often unsure of performance expectations in Web-based courses and in
particular with discussion groups. Unclear and ill-defined evaluation standards
lead to student stress and avoidance (lllinois Online Network, 2003a:0nline).
Students should be provided with a policy on expected participation and a
description of grading criteria. The instructor should clearly state expectations
regarding (University of Alberta, 2002a:0Online):

@ quality, quantity, depth, breadth, and frequency of discussion participation
and interaction;

& relative emphasis on facts, concepts, critical thinking, analysis, writing,

format, and quantitative reasoning;
& deadlines;
@ etiquette;
< internet usage,

< frequency of check-ins and
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@ how to effectively participate.

In addition to the above-mentioned, the instructor should do the following
(Spear, 2003:4; Schlebusch & Oosthuizen, 2003:5):

@ set high standards for him/herself;
< model high standards and quality through example;

# jnclude course goals, performance objectives, and examples of good
student work either online or in the study guide;

@ post outstanding, average, and poor student work online, and

@ convey enthusiasm and passion for the subject.

3.4.6 Respect diverse talents and ways of learning

Students need the opportunity to showcase their talents and learn in ways that
work for them. They also need to be nudged into learning new ways that might
not come so easily, and expand their learning style inventory to include
experimenting with different methods.

As mentioned (cf. 2.4) a blended learning environment may incorporate a
variety of instructional technologies such as electronic presentations, a course
Web site, CD-ROMs, videotapes, and printed materials. The term
environment is used as a conceptual shell for learning experiences that are no
longer constrained by the boundaries of location and time (University of
Alberta, 2002a:0nline). The freedom to combine more than one method of
teaching leads to multiple options, e.g. the following examples given by Singh
(2003:52): blending offline and online learning, blending self-paced and live,
collaborative learning, blending structured and unstructured learning, and
blending custom content with off-the-shelf content.

By its very nature, blended learning thus provides the perfect opportunity to
offer students different ways of learning. However, the focus must remain on
integration, where everything complements everything else to form a neat
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whole, rather than on simply providing multiple options (Australian National
Training Authority, 2003a:11).

Instructors can take student characteristics into consideration by doing the
following (Spear, 2003:9; Schlebusch & Oosthuizen, 2003:7):

&

&

Ask students to complete a learning style assessment questionnaire.

At the beginning of the programme, try not to rely on own assumptions
about what students know, but give them a small task, e.g. sending an e-
mail, to try and establish the level of their computer skills.

Allow students who are not confident with computers plenty of time to work
face-to-face until they have picked up on the basic skills.

Design materials in a flexible way to accommodate different student
groups. Well-designed modules allow the instructor to tailor assessment
tasks and timing to the group.

Build in tasks and options that cater for different learning styles, e.g.
include both chats and formal written tasks.

Design more than one method of assessment and demonstration of
student achievement.

Understand and allow for different pacing (keeping in mind the time-on-
task principle).

Recognise, respect, and reward creativity.

Allow students to choose from different possible modes of project

presentation which were established up-front in a learning agreement
between instructor and student.

Make students aware of other resources (e.g. web resources) and
alternative media (e.g. videos) to master course content.

Design course materials to encourage analysis, synthesis, application, and
evaluation.

Recognise that some students will derive more benefits from the face-to-
face sessions and others more from the e-leaming component.
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< Be sensitive to possible cultural differences.

< Understand and appreciate possible problems that students may
encounter with the e-learning component, e.g. technical problems.

3.4.7 Making effective use of technology

Modern technology provides the possibility to present particular objects or
events in a variety of ways. Media integration may, however, not be taken
lightly but must be preceded by systematic planning. The instructor must
make sure that optimal learning gain is obtained (Steyn, 1993:1).

There is a strong temptation to introduce fancy technology just because it is
available (Wills, 2001:Online). Instructors are urged to resist the attitude of “/
must use this kind of technology”, but to rather start by saying “My students
have to learn this — how can | best present it to them?” Although the promise
of new and emerging technologies continues to be realised, sound
instructional design practices need to be employed in order to maintain the
proper focus on the educational process.

According to a report set up through the Innovations in Distance Education
(IDE) Project (The Pennsylvania State University, 1997:Online), a thorough
analysis of the role of the instructional media and supporting tools in achieving
the learning outcomes, an understanding of the impact of the use of
technology, and careful consideration of the characteristics of the student
should drive the media selection and application process. The report indicates
that the following should be taken into consideration in selecting media for
distance learning programmes. It is the view of the researcher that the factors

are equally applicable to blended leaning programmes:

# The selection and use of instructional media should be based upon their
ability to support the predetermined learning outcomes of the learning
programme. One should be aware of the fact that technologies may
produce learning impediments as well as benefits. When infusing
technology into the learning environment, the potential arises to
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incorporate superficially innovative strategies that may actually complicate
or hinder learning. Such counterproductive activities, however attractive,
can rob students of time and hinder their ability to focus on what is to be
learned. Williams, Paprock and Covington (1999:108) remark that it is
important not to get so wrapped up in the technology that the technology
drives the methods. Instructors should focus on the fact that the outcomes
determine the teaching methods and techniques.

The selection of instructional media should be influenced by their
accessibility by students. This fact is agreed upon by Holmberg (1995:84)
who states that a learning programme should incorporate a technology
base that is appropriate for the widest range of students within that
programme’s target audience. The circumstances of social infrastructure,
technical development and cost must be considered. Costs could be
controlled by using the lowest-level technologies capable of supporting the
student in achieving the learning objectives. Since online students may not
have immediate and ready access to technical support services,
technologies should be selected that are stable and predictable and that
are positioned comfortably behind the “leading-edge technologies” that
represent higher risk of failure.

The design of learning programmes should reflect the diversity of potential
students. The unique contexts in which students live and work may
influence the way they think about, and use instructional media. The
instructor should take into consideration what influence the students’ age,
maturity and social, economic, and cultural backgrounds will have on their
ability to use and benefit from the selected media. It is imperative that
students should have a functional level of familiarity with the media that
are being considered - if not, the necessary training required to gain a
functional competence with the selected media should be built into the
programme.

If the programme relies on some component of electronic technology for
delivery, e.g. video-conferencing, contingency strategies should be
planned to provide a quick recovery from technology-related interruptions.
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Students should be informed what to do, should the supporting

technologies fail.

Although the IDE report states that programme design should employ a
systematic design model to guide the selection of instructional media,
Holmberg (1995:84) claims that over the years a number of media selection
models have been introduced but that no such taxonomy has been shown to
be generally useful or applicable. Even in modern times, the statement of
Schramm (1977:263) is still applicable: “There is no cookbook recipe for
media selection that can be applied automatically in every educational
system”.

However, the researcher asserts that the ACTION model of decision-making
criteria by Bates (1995:35-40) outlines a good practical strategy for selecting
instructional technologies. ACTION is an acronym derived from the words:
Accessibility, Cost, Teaching, Interactivity, Organisation and Novelty. These
decision-making steps involve asking questions about each of these aspects,
e.g.

@ Accessibility: will students be able to easily access and use the media?

@ Cost: how cost effective is the technology?

@ Teaching: is the technology a viable way for achieving the learning
objectives?

@ Interactivity: does the technology support interactive activities for

students?

@ Qrganisation: is the institution organised to support the use of the
technology?

@ Novelty: will the technology interest students or be overwhelming to use?

The following table can be used as a guideline to link the type of leaming with
the best media (University of Alberta, 2002a:0nline). In the left-most column
the type of learning is indicated, the second column lists examples and in the
column on the right, the appropriate media is suggested.

104

© Central University of Technology, Free State



Central University of
Technology, Free State

Type of Learning Examples Media
Memorization learning definitions text pages
dates & events slide presentations
interactive drill & practice
Conceptual classifying and organizing listserv/text page
understanding information/objects slide presentation
online discussion groups
Casual understanding make predictions listserv/text page
develop solutions slide presentation
Skill application apply skills to diverse situations tutorial
practice exercises
Higher-order skill flexibly combine and apply a variety | student group projects
application of skills in complex, novel situations | online discussion groups
document sharing
Interpersonal skills ability to relate effectively to others video examples
problems with feedback
online role-playing activities
online discussion groups
Affective (attitudes & facilitate the development attitudes video examples
values) and values problems with feedback
online discussion groups

Table 3.3 Guidelines to link the type of learning with the best media (University of
Alberta, 2002a:0nline)

It is the view of the researcher that using the guidelines indicated in the
above-mentioned table and combining it with the ACTION model of decision-
making (Bates 1995:35-40), an instructor will be able to, successfully, select
the most effective technology for a specific programme.

3.5 CONCLUSION

The aim of Chapter Three was to blend the principles of computer literacy,
outcome based education and good teaching practice.

Through this literature study the researcher concludes that, although there is
no specific definition for computer literacy, the content of a CL programme
should preferably include teaching students about basic theoretical concepts
of computer hardware and software, as well as word processing, spreadsheet,
database, presentations, Internet and e-mail skills (cf. 3.2.7, 3.2.2).

In researching the principles of OBE and good teaching practice, the
researcher came to the conclusion that many of these principles complement
one another and they can, with ease, be applied in a blended learning
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environment. In this regard it was noted that the principle to encourage active
learning (cf. 3.4.3) blends in with the very important principle that OBE is
driven by the vision of what students should be able to do and not merely
what they know (cf. 3.3.2). Indeed if an outcome is anything that a student can
show that (s)he knows and can do, it is imperative for students to be actively
involved in the learning process (cf. 3.3.3). The principle of promoting co-
operative learning (cf. 3.4.2) is in line with one of the critical outcomes of the
South African OBE system, i.e. that “students should be able to work
effectively with others as a member of a team, group, organisation or
community” (cf.3.3.3). Likewise the critical outcome stating that students
should be able to use science and technology effectively (cf. 3.3.3), underlines

the principle of making effective use of technology (cf.3.4.7).

The researcher noted with interest how many of the principles of OBE
assessment relate to the principles of good practise. The fact that OBE
assessment criteria are clearly defined at the beginning of an activity (cf.
3.34.1) is in accordance with the principle of communicating high
expectations (cf. 3.4.5). Furthermore OBE suggests that competencies are
acquired through interaction with the mediator (cf. 3.3.4. 1) which compliments
the principle of prompt feedback (cf. 3.4.3). Performance-based assessment,
which expects students to engage in activities that require them to
demonstrate specific skills (cf. 3.3.4.1), is in accordance with the principle of
encouraging active learning (cf.3.4.3), and the notion of formative assessment
that builds up a system of feedback to form the appropriate learning
experience to the benefit of the student (cf. 3.3.4.1) blends in with the principle
of prompt feedback. The variety of methods and strategies that can be used to
perform OBE assessment (cf. 3.3.4.3) indicates that an OBE programme will
be able to accommodate the principle of taking diverse talents and ways of
learning (cf. 3.4.6) into consideration.

The researcher concludes by stating that the literature content of this chapter
provides a sound framework for developing an outcomes-based computer
literacy programme based on principles of good teaching practice.
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vnAaricrx rOUR

RESEARCH METHODOLOGY, DATA COLLECTION AND AN
ALYSIS

INTRODUCTION

As mentioned in Chapter One, the primary aim of this study was to establish

the factors that should be taken into consideration in developing an outcomes-

based computer literacy programme to be presented in blended learning

mode, and to develop such a programme through which effective teaching

and learning can take place.

This research further aimed to:

« establish the role of blended learning in education by researching the

different methodologies that can be used in presenting blended learning
programmes;

determine how the principles of good practice and OBE influence the
development of a blended learning computer literacy programme, by
researching the core elements of good practice, OBE and computer
literacy;

investigate the most appropriate way to go about developing a blended
learning computer literacy programme in the South African context, and

establish how a blended learning computer literacy programme can be
implemented to enable more productive computer training, implement
such a programme and evaluate the outcomes of the programme.

A review of literature in Chapter Two revealed that blended learning is set to

play an increasingly important role in future education systems and that there

are various techniques of implementing blended learning programmes. It
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further indicated instructiviiai ucoyn yuwuelines that could be followed in

designing a blended learning programme.

In Chapter Three a literature overview of the principles of CL, OBE and good
teaching practice, provided a framework for developing an effective CL
learning programme.

Chapter Four involves the implementation of action research as a component
of qualitative research, to obtain data to develop and implement an effective
OBE CL programme in blended learning mode for South African students.

4.2 RESEARCHMETHODS IMPLEMENTED IN DATA COLLECTION
4.2.1 Selecting the research methodology

Hummelvoll and da Silva (1998:465) state that qualitative researchers
accumulate data by interacting with selected individuals in their settings and
by acquiring documents relevant to the study.

Gerdes and Conn (2001:184) indicate that, unlike quantitative research, which
investigates a priori hypotheses developed from the researcher’s own biases,
qualitative research examines what people are doing and how they interpret
what is occurring. Qualitative research places emphasis on comprehension by
paying attention to the words used by people, and the intention of such
research is to discover patterns emerging from thoughtful analysis of the
research topic. Contextual findings and not extensive generalisations are the
discoveries made through qualitative research (Maykut & Morehouse,
1995:17-21).
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Devers, Kelly, Frankel anu i i evuu.254) list the following important

characteristics of qualitative research:

@ The logic of qualitative research is inductive, rather than deductive, and
consists of describing people and groups' particular situations, meanings
and experiences.

= Qualitative research designs are emergent and flexible, and the research
itself is quite dynamic, i.e. the researcher, research subjects, their
relationship, and the research setting are all subject to development and
change.

= The qualitative research process is non-linear and non-sequential. Data
collection and analysis often proceed simultaneously.

Although qualitative research will be the primary methodology implemented,
the researcher will also, to a limited extent, employ a quantitative research
strategy. Quantitative research deals with quantifying relationships between
variables (Hopkins, 2000:Online). Quantitative studies can either be
descriptive or experimental. In a descriptive study, no attempt is made to
change behaviour or conditions - things are measured as they are. The two
methodologies are often seen in opposition; however, an either/or position is
viewed to be misleading and the two methodologies should rather be used
simultaneously to compensate for each other's weaknesses and supplement
the strengths. In this study the researcher will use an aspect of the
quantitative method to build a profile of prospective students (cf. 4.3.3).

Patton (2002:231) defines programme evaluation research as “the systematic
collection of information about the activities, characteristics, and outcomes of
a programme to make judgements about the programme and improve the
programme’s effectiveness”. He asserts that qualitative methods are often
used in evaluations as they tell the programme’s story by capturing and
communicating the participants’ stories.
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A specific type of qualitative ieseaiun - avuon research - is used to improve
practice rather than to produce knowledge (Charles, 1995:220). This kind of
research is frequently done by instructors in graduate studies programmes.
The aim of this study is to develop, implement and evaluate a CL programme.
Taking into consideration the factors mentioned in this section, the researcher
came to the conclusion that action research, as a component of the qualitative
research methodology, will be most suitable to use.

The following section describes the way action research was applied in this
study.

4.2.2 Action research

According to Hitchcock and Hughes (1995:6), action research can be
described as inquiry conducted on a particular issue of current concern,
usually undertaken by those directly involved, with the aim of implementing a
change in a specific situation.

Dick (1999:0Online) notes that there are several varieties of action research;
however, for the most part, they have in common that they are oriented
towards achieving two sets of outcomes at the same time: action and
research. The purpose is to research action, and to action (i.e. act on)
research.

Schmuck (1997:29) asserts that action research is:

@ practical, as insights from data lead to practical improvements in the
classroom;

@ participative, as action researchers are co-workers who collect data with
and for people focused on a real problem;

= empowering, as all participants can affect and contribute equally to the
inquiry;
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= tentative, as inquiries uo nut resun n action researchers coming up with
right or wrong answers but rather with tentative solutions based on the
multiple and diverse views of participants, and

@ critical, as participants not only search together for practical improvements
in their educational situation, but they also act as self-critical change
agents.

McKernan (1996:15-28) provides a detailed list of different models of action
research that were suggested by educationalists. The list includes models of
Lewin (1947), Taba & Noel (1962), Lippet and Radke (1946), Elliot (1978),
Ebbut (1983) and a number of other specialists. The most important
characteristic that emerges from all of these models is that action research is
executed in a series of spiralling decisions, taken on the basis of repeated
cycles of analysis, reconnaissance, problem conceptualising, planning,
implementation and evaluation.

The researcher decided to follow the phases as given by Schmuck (1997:50).
These phases are initiation, detection and judgement (cf. 1.5.2). Schmuck
(1997:31) further distinguishes between two models of action research, i.e.
proactive and responsive. These models differ primarily in when the data is
collected and analysed during the cycle of events. In proactive action
research, action precedes data collection and analysis. The instructor acts
and then studies the effects of the actions. In responsive action research,
however, data is collected and analysed before action is taken, i.e. the
instructor diagnoses the situation before acting.

As the aim of this study is to develop a new programme and data has to be
gathered before the programme can be developed, the researcher decided to
follow the steps of responsive action research (Schmuck, 1997:50). It was
decided to combine some of the steps, as the programme will be evaluated
during implementation and not at the end of the process (cf. Fig 4.1). The
researcher correlated the steps of action research with the phases of
instructional design (cf. 2.5).
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The steps followed in this Sy were.

@ Step 1: Collect and analyse data to diagnose the situation, i.e. collect data
and use this data to design the new programme (cf. 2.5.1 and 2.5.2).

@ Step 2: Distribute the data to others, i.e. develop the new programme (cf.
2.5.3).

@ Step 3: Try a new practice, i.e. implement, and monitor the implementation
of the programme (cf. 2.5.4).

@ Collect and analyse data to diagnose the situation, i.e. evaluate the
programme (cf. 2.5.5). At this stage the sequence has circled back to step
1; however, in this second data collection, the general methods previously
used will be supplemented with specific questions about the particular
issues worked on, i.e. on specific aspects that were incorporated into the
programme. The essence here is to determine how students are reacting
to the new programme.

The process is summarised on the following page in the diagram given in
Fig. 4.1. Note that:

= steps 1 - 2 are classified as the initiation phase;
= step 3 is classified as the detection phase and

= step 4 is classified as the judgement phase.
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Step 4: Collect
data

Judgement
phass Initiation
phase
Detection
phase

Fig. 4.1 Steps in action research (Schmuck, 1997:50)

The way data was collected and analysed correlates with the steps indicated
in Fig. 4.1. The following table summarises the process as applied in this
study:
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CYCLE |STEP |Para- |ACTIONS TAKEN

graph

Cycle1 |BEpH |4.4.1 Collect data by doing a thorough literature
review and obtaining quantitative information
about the background of prospective students.
Analyse the data and design the programme.

'B8P2 [442 | Distribute data: develop the programme.
'BIBPE [4.4.3 | Try a new practice: implement the programme
at one site of instruction (round 1).

Cycle2 [BBPH |4.4.4 | Collectand analyse data from the students
and instructor involved in round 1 of
implementation.

'BIBPE (445 | Distribute data: if necessary, change the
programme to improve it.

‘B8P |4.46 | Try a new practice: implement the changed
programme at more than one site of instruction
(round 2).

Cycle3 [BIBPHM |4.4.7 | Collectand analyse data from the students
and instructors involved in round 2 of
implementation.

'Bi8P2 [4.48 | Distribute data: if necessary, change the
programme to improve it.

'BBPE [ 449 | Try anew practice: implement the changed
programme (round 3).

Cycle4 [BIBPM |4.4.10 | Collect and analyse data from the students
and instructors involved in round 3 of
implementation.

'BI8P2 | Chapter | Distribute data: present the final programme.
Five

Table 4.1

Cycles of action research as applied in this study
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4.3 ASPECTS OF DATA vuLLEL 1IUN

In this section the researcher describes the validity, population and sampling,
and methods used in data collection for this research.

4.3.1 Validity

The most essential attribute of a research instrument is the existence of
validity (Frankel & Devers, 2000:253).

Gerdes and Conn (2001:186) indicate that validity refers to the
trustworthiness of data. LeCompte (2000:146) states that data are valid to the
extent that they depict or deal directly with the topic under consideration, and
McMillan and Schumacher (1997:404) assert that validity in qualitative
research addresses the questions: “Do researchers actually observe what
they think they observe; do researchers aclually hear the meaning that they
think they hear? “ This factor is underlined by Morse (1994:49) when he
proposes that a qualitative researcher should continuously ask him/herself the
question: “Do |, the researcher, really understand and describe what | am
studying in the same way that the people who live it, do? Did | really get it
right?” The validity of qualitative designs is thus the degree to which the
interpretations and concepts have mutual meanings between the participants
and the researcher.

The following strategies, as proposed by McMillan and Schumacher
(1997:405-406) and Gerdes and Conn (2001:186), were applied in this study
to enhance validity:

< Prolonged and persistent field work was done by conducting in-depth
interviews with participants in their natural setting to enable them to reflect
the reality of their experiences.

< Data was recorded mechanically. A tape recorder was used to record the
interviews, thus enabling accurate and complete reporting.
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# Verbatim accounts of conversauons, transcripts and direct quotes from
documents are highly valued as data. The researcher presents in this
study direct quotations from the data to illustrate participants’ views.

@ During the interviews, the researcher allowed the participants opportunities
to clarify their comments, checking for understanding, as if asking, "Did /
get this right when you said...?" or "What | think | heard you say was .... "
This strategy is referred to as member checking.

# The strategy of participant review was applied by asking participants to
review the researcher's synthesis of interviews for accuracy of
representation.

The researcher has no doubt that the strategies followed in this study ensured
the validity of the research.

4.3.2 Population and sampling

Qualitative research design can be thought of as a rough sketch to be filled in
by the researcher as the study proceeds (Frankel & Devers, 2000:255). After
a preliminary question has been formulated and resources identified and
secured, the design can be likened to an abstract drawing. It has taken shape
without particular individuals, groups, organisations, or sites (i.e. the social
and physical settings where "subjects"” or "cases" are located) in mind. Further
specification of the research design requires the researcher to understand
and consider the unique characteristics of specific research subjects and the
seftings in which they are located. In essence, the researcher must make the
design more concrete by developing a sampling frame (i.e. criteria for
selecting sites and/or subjects) capable of answering the research
question(s), identifying specific sites and/or subjects, and securing their
participation in the study.

Given the goals and logic of qualitative research, purposeful sampling is often
employed (Frankel & Devers, 2000:264). Purposeful sampling strategies are
designed to enhance understandings of selected individuals or groups'
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experience(s) or for developing theories and concepts. Researchers seek to
accomplish this goal by selecting "information rich" cases, that is individuals,
groups, organisations, or behaviours that provide the greatest insight into the
research question.

McMillan and Schumacher (1997:397) assert that purposeful sampling
strategies differ from probability (or random) sampling strategies in that it is
specifically done to increase the utility of information obtained from small
samples. A number of sampling strategies can be applied, e.g. site selection,
comprehensive sampling, maximum variation sampling, network sampling and
sampling by case.

In this study the researcher used the purposeful sampling strategies of site
selection and theory-based sampling. According to Mason (1996:93), “theory-
based sampling means selecting groups or categories to study on the basis of
their relevance to your research questions, your theoretical position, and most
importantly the explanation or account which you are developing.”

In correlation with the first step of responsive action research (cf. 4.4.4) -
which indicates data collection before action - the researcher intended to
interview instructors who have already been using the methodology of
blended learning in a particular programme. However, as this is such a new
phenomenon in the field of didactics, it became clear that most information on
blended learning were to be found from sources on the Internet, and that
there were no experts in South Africa in this specific field. The initial data
collection for developing the programme was thus done by an extensive
literature review (cf. Chapter Two and Chapter Three).

As the researcher was an instructor at Vista University for the duration of this
study, the programme was implemented at various campuses of Vista
University. The students and instructors involved in the implementation of the
programme were the key role players in the cycles of action research. It
should be mentioned that it was initially intended to implement the programme
on six different campuses, however, due to technical problems (e.g. problems
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with sound cards) experienced, the programme was only implemented at
three sites: the Welkom, Port Elizabeth and East Rand campuses of Vista
University. The duration of the programme is six months. A total of 496
students enrolled over a period of eighteen months, i.e. the three rounds of
implementation and testing (cf. Table 4.2). Three instructors at the different
campuses were involved in implementing and evaluating the programme. The
following table summarises the number of students per campus:

Period of implementation Campus Number of | Number of

students instructors

FIRST ROUND OF IMPLEMENTATION

Jan 2003 - June 2003 Welkom 69 1

SECOND ROUND OF IMPLEMENTATION

July 2003 — Nov 2003 Welkom 73 1
July 2003 — Nov 2003 Port Elizabeth | 187 1
July 2003 — Nov 2003 East Rand 66 1

THIRD ROUND OF IMPLEMENTATION

Jan 2004 - June 2004 Welkom 101 1

Table 4.2 Summary of population and sampling

For the first round of implementation and data collection, the programme was
piloted only at one campus, i.e. the Welkom campus. This is the campus
where the researcher is based, and it provided an opportunity to closely
observe the process of implementation, and collecting data on a day-to-day
basis as the programme progressed. It was seen as a pilot implementation
(cf. 4.4.3).

For the second round, the programme was introduced at two other campuses
of Vista University, i.e. Port Elizabeth and East Rand. This provided the
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opportunity to test the proyianune wiui swdent from two other provinces of
South Africa, i.e. the Eastern Cape and Gauteng.

For the third and final round of implementation, it was envisaged that the
programme should be presented at the campuses of Vista University.
However, as a result of the restructuring of higher education in South Africa
(South Africa, 1997:Section 24), each of the campuses of Vista University
merged with a different higher education institution in 2004. As a result of
these mergers the continuation of the research had to be confined to the
campus where the researcher was based, i.e. the Welkom campus. The final,
revised programme was thus implemented in July 2004 at the Welkom
campus, which was merged with the Technikon Free State, to form the
Central University of Technology, Free State (CUT,FS).

4.3.3 Methods employed in data collection

e Literature review

An interpretative literature review is a summary and synthesis of relevant
literature on a research problem (McMillan & Schumacher, 1997:119).
According to Devers ef al. (2000:255) no matter what the discipline, research
cannot be undertaken without a thorough review of the literature. They assert
that the outcomes of a literature review are the following:

= Sharing the results of other studies that are closely related to the research.

& Relating the study to a larger, ongoing dialogue amongst professionals in
the field of research.

< Providing a framework for establishing the importance of the study, as well
as a benchmark for comparing the results of the study with other findings.

In this study the researcher performed a thorough literature review to create a
contextual framework for developing the envisaged programme. The findings
are summarised in paragraph 4.4.4.1.
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e Interviews

“If you want to know how people understand their world and their life, why not
talk to them?” (Kvale, 1996:1). The qualitative research interview attempts to
understand the world from the subjects’ point of view, and to unfold the
meaning of peoples’ experiences.

McMillan and Schumacher (1997:447) assert that qualitative interviews may
take several forms:

@ In the informal conversational interview, the questions emerge from the
immediate context and are asked in the natural course of events; there is
no predetermination of question topics.

« |n the interview guide approach, topics are selected in advance but the
researcher decides the sequence and wording of questions during the

interviews.

@ |n the standardised open-ended interview, participants are asked the same
questions in the same order, thus reducing interviewer effects and bias.

According to Patton (2002:341), programme evaluation interviews aim to
capture the perspectives of programme participants. Questions to be
answered include: “What does the programme look and feel like to the people
involved?”; “What are their experiences of the programme?”; “What are their
expectations?” It is the responsibility of the researcher to provide a framework
within which interviewees can respond comfortably, accurately and honestly.

In this study the researcher conducted personal interviews with the instructors
involved in implementing the programme. To keep the interview
conversational and collect as much information as possible, the interview
guide approach was followed (cf. Table 4.5)

The researcher also conducted interviews with students participating in the
programme. However, as so many students enrolled, it was impossible to
interview everyone individually, and therefore students were interviewed in
groups. Focus group interviews are effective, as the interaction among the
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interviewees often leads to spontaneous statements about the topic under
discussion (Kvale 1996:101). In the view of McMillan and Schumacher
(1997:453), a focus group interview is a strategy for obtaining a better
understanding of a programme by interviewing a purposefully sampled group
of people. The fact that group members are stimulated by the perceptions and
ideas of one another, increases the quality and richness of data through a
more efficient strategy than one-on-one interviewing. Standardised open-
ended interviews were conducted in this case (cf. Table 4.6). This ensured
that participants were asked the same questions, but still permitted interaction
among the interviewees.

The interviews are discussed in detail in paragraph 4.4.4.

e Questionnaire

Questionnaires are the most widely used technique for obtaining information
from participants, and are mostly associated with the quantitative method of
research (McMillan & Schumacher, 1997:252). Although this study primarily
used the qualitative method of research, a questionnaire was used to help
build a profile of prospective students (cf. Table 4.3). Students were
requested to complete a questionnaire to determine how many have computer
access at home and had prior experience of working on a computer. As the
researcher did not intend to perform any statistical analysis on the quantitative
data, but to portrait a fact, the questions were simple closed factual questions,
i.e. the assumption was made that respondents would give a yes or no
answer (Scott & Usher, 1999:68).

The findings of the questionnaires, presented in pie charts (cf. 4.4.1.2)
constituted an important part of the analyses, as they played a concluding role
in selecting the media to be used in the programme (cf. Table 4.4).
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In addition to the more traditional methods of data collection (i.e. the literature
review, interviews and questionnaires), the following methods, specifically
related to action research, were also employed (McKernan, 1996:81-91).

@ The researcher kept a journal and made cryptic notes of events. These
notes were used to report the proceedings in detail (cf4.4.3, 4.4.6, 4.4.9).

< A profile of the envisaged programme was set up by completing an
instructional design worksheet (cf. Table 4.4). This profile provided a
structure for the programme and enabled the researcher to identify key
elements that should be evaluated during implementation. It included
evaluating the contents of the programme, the manual that was
developed, the media or technology that was used and the implementation
strategies that were followed.

# The researcher used a checklist as proposed by the University of Alberta
(2002a:0nline) to evaluate the process of implementation (cf. Table2.3).

@ Document analysis was done involving all documentation relevant to the
programme, e.g. the study guide, curriculum, tests, examination papers,
examination results and student assignments.

44 DATA COLLECTION AND ANALYSIS
As previously explained this study was done following the steps of responsive
action research (cf. fig. 4.1). This section aims to describe in detail how data

was collected and analysed during each of the cycles.

44.1 Cycle 1, Step 1: Collect and analyse data to diagnose the situation
(cf. table 4.1)

4.4.1.1 Literature review
During the first cycle of data collection, the researcher performed an extensive
literature review of the principles of blended learning, computer literacy,
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outcomes-based education anu gouva eaching practice. The aim was to

contextualise a framework for developing an effective outcomes-based CL
programme. Furthermore, the literature review included a review of
instructional design principles related to blended learning (cf. 2.5). The aim
was to find the best way to follow in developing the envisaged programme.

This section gives an overview of the most important aspects that emerged
from the literature review.

= Blended learning is a powerful strategy that expands and enhances the
learning experience by combining the strengths of both e-learning and
face-to-face instruction. It has become all pervasive in the training
industry, and it is said to be applied increasingly in the search for
delivering effective education (cf. 2.2).

= There is a vast number of different elements that can be used in blended
learning, e.g. printed material, face-to-face instruction, instructional
television, video-conferencing, CAL, computer communication technology,
and WBI. Each one of these elements has advantages and disadvantages
and should be considered in the context of the learning outcomes of the
programme and the profile of the students (cf. 2.4).

< The most important aspect of developing a blended learning programme,
is to apply the “right” learning technologies to match the “right” personal
learning style to transfer the “right” skills to the “right” person at the “right”
time. There is a number of strategies that can be followed to select the
“right” blend (cf. 2.3).

@ There exist well-developed instructional design models that can assist in
developing an effective blended learning programme. The phases include
analysis and design, development, implementation and evaluation (cf.
2.5). The researcher correlated each of the phases in the instructional
design model with different steps in the action research cycle (cf. table
4.1).

@ Literature reveals design principles that can be applied to ensure the

effectiveness of a blended learning programme. The researcher followed
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these guidelines in the airrerent pnases of the instructional design process
(cf. 4.4.2, 44.3,4.4.4, 4.4.5).

& Although there is no universal definition for computer literacy, two
standards set in different countries indicate that a computer literacy
programme should preferably consist of basic computer-related theory,
word processing, spreadsheet, databases, operating system, as well as
Internet and e-mail literacy. This fact laid the foundation for selecting the
content of the envisaged programme (cf. 3.5).

« Many of the principles of good teaching practice correlate with those of
outcomes-based education, and can, with ease be applied in a blended
learning environment (cf. 3.5).

After the literature review, the researcher decided to develop the envisaged
programme by following the phases of the instructional design model, and
taking into consideration the principles of OBE and good teaching practice.

The first phase in instructional design suggested that one of the most
important aspects of the analysis and design stage is to analyse the target
population of learners. Sound instruction requires considering the
characteristics of students. The aspects that the researcher found necessary
to look into in this regard were the availability of computers at home, and the
extent to which students had experience of using computers before enrolling
for the programme. Students were requested to complete a questionnaire (cf.
Table 4.3).

4.4.1.2 Questionnaire

The questionnaire is the only part of this qualitative research where
quantitative data is used. To be able to determine the type of e-learning
component that should be included in the blended learning programme, the
researcher had to establish whether students had access to computers at
home and to what extent have they been using computers before enrolling for
the programme. An important criteria for selecting the e-learning component
of the programme, is that the media should be accessible to students (cf.
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3.4.7), e.g. there would be no use in selecting web-based instruction, if most

students do not have computers and Internet connectivity at home. As the

researcher, from experience, knows that the students of Vista University

typically come from a disadvantaged background, it was predicted that

prospective students would have very little prior experience of working on a

computer and might probably not have a computer at home. However, this

fact had to be substantiated by statistics, and therefore students in the first

group were requested to complete the questionnaire in table 4.3

Questionnaire

Indicate your selection with an X.

1a

At which Vista
campus are you a
student?

Mamelodi

Soweto

East Rand

Sebokeng

Welkom

Bloem=
fontein

Port
Elizabeth

VUDEC

1b

How many times have
you worked on a
computer before you
enrolled for this End
user Computing
course?

0 times

Less
than 10

Weekly

Daily

1c

Do you have a
computer at home?

Yes

No

1d

Have you ever taken
a formal computer
literacy course
before?

Yes

No

1e

Specify what course if
you answered “Yes”
in 1d.

Table 4.3 Questionnaire
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i.e. that by far the majority of students did not have computers at home and
had never worked on a computer before enrolling for the programme. The
results are summarised in the following pie charts:

" Central University of
Technology, Free State

The results of the questionnaire confirmed what the researcher had predicted,

Round 1 Computers at home

O No computer at
home

B Computer at home

Fig. 4.2 Percentage of students with computers at home

The chart in fig 4.2 indicates that only 3% of the students had a computer at

home.

16%

Round 1 Prior experience

9%, 3%

B Never worked on a
computer before

H Worked less than
10 times

O Work weekly

0O Work daily

Fig. 4.3 Percentages indicating prior experience working with computers
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The chart in fig 4.3 indicates wmart r 27 or ine students had never worked on a
computer before enrolling for the programme; 16% had used a computer less
than 10 times; 9% used a computer on a weekly basis and only 3% made use
of a computer on a daily basis.

The statistics portrayed by these charts gave a clear indication that the
researcher could not consider WBI as part of the envisaged blended learing
programme, but that the e-learning part of the programme should preferably
take place in the computer laboratories on campus.

4.4.1.3 Design the programme

The researcher proceeded by designing the programme, following the
guidelines as set out in Chapter Two. The following instructional aspects as
proposed by OTEN and Reigeluth (cf. 2.5.2) were addressed in designing the
programme:

e Learning outcomes
One of the themes derived in sub-section 3.2.2 is that a CL programme
should consist of a theory as well as a practical component. Furthermore,
the specific outcomes for the subject Computer Applications Technology
are listed in sub-section 3.3.5. Taking the aforementioned into
consideration, the researcher derived the following learning outcomes (LO)
for the envisaged programme:

@ LO1: Students should be able to describe and explain the use of basic
computer terminology.

@ LO2: Students should be able to use the basic principles of MSWord to
create, edit, save and print text documents.

@ LO3: Students should be able to use the basic functions of the
Windows operating system to access programme packages and
manage files.
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@ LO4: Students shouu ue auic w avucss a specific web-site and search

for information on the Internet using Microsoft Internet Explorer as well
as send and receive e-mail messages using Pegasus Mail.

« LOS5: Students should be able to use the basic principles of Excel to
create a spreadsheet which contains values, text, formulas, functions
and graphs.

As the content is broken down into units of learning, more specific lesson
outcomes are listed at the beginning of each unit in the study guide (cf
Chapter Five).

Content outline

From the questionnaires (cf. Table 4.3), it became clear that most Vista
students have no, or very little, experience working on computers before
they enroll for the CL programme. In light of this fact the content of this
programme is selected in a way to accommodate such inexperienced
students. (Note that, at the time the study manual was developed, the
computers laboratories of Vista University utilised the out-dated Windows

95 operating system.)

Content outline for LO1 (Basic theory principles):

Classification of computers
Components of an information system
Computer hardware

Application and system software
Productivity software

Graphics software for professionals
Software for home, personal and educational use
Software for communications
Software and legal issues

Input devices

Output devices

9 9 9 § 9 9 9 9 9 § § §

Magnetic disks
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@ QOptical disks
@ Magnetic tapes
& Latest developments in storage units

Content outline for LO2 (MSWord):

Start MSWord

Identify the different parts of the MSWord screen
Create a new document & enter text

Edit text by using the backspace, delete and insert keys
Move the cursor to different positions on the screen
Save a new document

Create a new blank document

Switch between different open documents

Close a document

Exit MSWord

Open a saved document

§ 9§ § § 9§ 9 § § § § § §

Edit a document using various selection techniques to cut, copy and
paste

Undo/Redo

Editing text

Format text by changing font styles and sizes
Format text by justifying it

Print a document

Change page view

Change line spacing

Insert page numbers to documents

Change page margins

Insert headers, footers and footnotes

Use the spell checker

Use the thesaurus

Use the find and replace feature

Use advanced printing options

Create & edit tables

9 9 4§ 9§ 9 9 § § 9 § § § § § 9§
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Insert graphics in a uvcument

-
= Create a data source file

= Create a main document file
# Perform mail merge

Content outline for LO3 (Windows 95):

@ Start Windows95

& |dentify the different parts of the Windows385 screen
& Shut down Windows85

& Activate program applications in Windows95

= Use the facilities of Windows Explorer

< QOpen and use Windows95 accessories

Content outline for LO4 (Internet and e-mail):

@ Explain the relationship between the World Wide Web and the Internet
# Describe the uses of the Internet.

« Effectively search for information on the Internet using internet explorer
@ Send and read electronic mail using Pegasus Mail

Content outline for LOS (Excel):

Explain what a spreadsheet is

Start Excel

Identify the parts of the Excel screen
Explain and use cell addresses
Navigate around a spreadsheet
Enter numbers, text and formulas
Save a workbook

Close a workbook

Start a new workbook

Exit Excel

Open an existing file

8 § § § 9 § § § § § 4
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Work with more than one workpook at a time
Insert/delete rows and columns

Hide and unhide columns

Change column widths

Change row heights

Use different formatting techniques

Print a workbook

Use formulas in Excel

Use functions in Excel

Move and copy data in a workbook

Sort data in a workbook into either ascending or descending order

9 § 9§ 9 9§ 9 9 9 § 9 § §

Create different types of charts in Excel

o Media

An important theme that emerged in sub-section 2.4.1 is that printed material
is the basis for any educational delivery. As Vista University students received
self-contained study manuals for most of their programmes, it was decided to
develop a complete manual for this programme. The researcher believes that
any computer user should be able to teach him/herself new techniques by
following instructions from a manual, and therefore decided to develop the
manual according to the guidelines for self-instructional study material (cf.
2.5.2). To supplement instruction, the researcher decided to include CAL,
where learning is delivered via self-instructional CDs. The reason for selecting
CAL as part of the blended learning programme is that students can come to
the laboratories on campus and, in their own time, work through the CAL CDs.
The researcher could not consider any of the online media options listed in
sub-section 2.2. as questionnaires indicated that the majority of students did
not have computers and/or Internet connectivity at home.

o Teaching strategies
The programme will be presented over the course of one academic semester,

i.e. 6 months. There will be two registration periods per year, i.e. January and
July. Students will receive the manual and CAL CDs at the beginning of the
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semester. During the first fave-w-1ave viass, called an orientation session (cf.

3.4.1), students will be informed about the methodology of blended learning
and the advantages that it holds for them. Furthermore, they will receive a
complete work schedule indicating the activities, assignments and the
timeframes within which different activities should be completed. This concurs
with the principle of time on task (cf. 3.4.4).

Students will meet in face-to-face classes (one hour each) twice weekly, and
will be expected to supplement the face-to-face classes with spending at least
one hour per week working on the CDs. As very few students have prior
experience of working on a computer, the researcher decided that the CAL
part of the programme should not be introduced from the first week, but that
students should be guided in face-to-face classes for at least two weeks,
before they are requested to use the CDs. Furthermore, they will be
requested to work in groups when using the CAL CDs. The reason for this is
to encourage interaction between students and provide opportunities to help
each other (cf. 3.4.2). Apart from attending face-to-face lectures and using the
CDs to review work already done, students should spend at least two hours
per week in the laboratory working on practical assignments.

e Activities and assessment strategies

According to the principles for good teaching practice, students learn better
when they are actively involved in the learning process, and when they work
in groups (cf. 3.4.2 & 3.4.3).

As the content of this programme is of a practical nature, the activities and
assessment are closely linked. The main focus will be to assess whether
students can perform activities, as this is the essence of OBE assessment (cf.
3.3.4).

132

© Central University of Technology, Free State



O

o Central University of
Technology, Free State

A number of assessment suaweyries win we used according to guidelines set
out in sub-sections 2.5.2 and 3.3.4:

% The manual will contain practical activities that students have to complete
using the computer and the application packages. Students can use these
activities as self-assessment to determine whether they have progressed
well enough to proceed to the next section.

# Requiring students to use the CAL CDs plays an important role in getting
them actively involved. Students will work through self-guided lessons, and
take computer-based tests. These tests are scored by the computer, and
the marks are immediately available. This concurs with the principle of
prompt feedback (cf. 3.4.3), and helps students to improve their

performance.

<+ Students will be requested to hand in a practical assignment on MSWord
midway through the semester, and an Excel assignment close to the end
of the semester. These assignments will be used as continuous
assessment and will contribute 66.67% towards the term mark. The
assignments can be classified as formative assessment (cf. 3.3.4.1).
Students will do a final practical examination as well as write a final theory
examination at the end of the semester. The theory exam will mainly
consist of multiple choice and other short-type questions. The final
examination at the end of the programme is a form of summative
assessment (cf. 3.3.4.1).

As suggested by Reigeluth (cf. 2.5.2), the researcher completed the
worksheet listed as Table 4.4 to conclude the design phase. The completed
worksheet served as a profile of the programme.
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Instructional Design Worksheet
Course title(s): EUC5001

Identify the instructional strategies that will be used for the different levels of learning
in the following matrix.

Kinds of learning||Presentation | Tutorial Drill Independent | Discussion||Game | Lab
study

Invariant

tasks X X
Concept X
classification
Procedure
using
Understanding X
Generic skills X X X

Where will your students be located? (Note: you may check one or more categories.)

Location of students
Students will meet regularly on campus X
Students will meet occasionally

Students will participate from a distance
Students will be located in several time-zones

Describe the characteristics of the prospective students including the following
information: programme(s) of study, age range, educational backgrounds, work
experience, access to technology, and comfort with technology-mediated learning.

Characteristics of students

Prospective students will probably not have access to a computer at home, and
ery few students will have prior experience of working with computers (cf. 4.4.1.2).

Identify appropriate delivery methods and media.

Delivery methods Yes No Maybe
Web X
Videoconference X

CD-ROM X

Print Materials X

Videotape X

Audiotape X
Face-to-face instruction X
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Media to be developed | Yes No | Maybe
Audio
Video
Graphics
Animation
Text-based content X

K| x| >

What campus facilities will be required to support the students?

Campus facilities

Library X
Computer help desk
Computer lab X
Classroom | X

Table 4.4 Instructional design worksheet as applied in this study to build a profile

Once the programme was designed, the instructor proceeded to the
development phase.

44.2 Cycle 1, Step 2: Distribute the information, i.e. develop the
programme (cf. table 4.1)

This is the phase in which the instructor actually creates (or selects) the
media elements (e.g. video tapes, CDs, web sites) and other instructional
materials (e.g. study guides, activities, assessment and on-line resources) for
the programme. The researcher followed the guidelines as set out in sub-
section 2.5.3.

The media identified for this programme is a self-contained, self-instructional
study manual as well as CAL CDs.

In compiling the manual, the researcher paid specific attention to the following
guidelines (cf. 2.5.3):

@ Basic principles were applied to ensure good page design, e.g. the
researcher avoided writing too much text on one page, used unjustified

135

© Central University of Technology, Free State



O

Eent.ral ‘Un'mgr‘sil:ysfafw
. = . echnology, Free 3 5
right-hand margins as i« « caocw w 1ead, avoided too many different font

types and used graphics to serve a specific purpose.
@ An easily readable font and font size (Arial 12pts) were used.

@ Special attention was given to the use of uncomplicated grammar as, for
most Vista University students, English is not their first language.
Sentences were kept short and either written in conversational English or
structured in a step-by-step manner to guide students through practical

sessions.

# The material was divided into different sections — each further divided into
lessons.

As previously mentioned, the researcher chose to develop a self-contained,
self-instructional study manual, structured in such a way that students could
do most of their learning from the materials alone. The active learning
approach was used by combining content with activities.

The following guidelines were followed in designing the activities:

& The activities were developed to match the lesson outcomes. They were
carefully selected to help students achieve the outcomes and appear in
order of increasing difficulty.

& Activities were selected to be realistic and manageable for students to
complete.

< Activities were not grouped at the end of a section, but were interspersed
with content.

It should be noted that the researcher did not write the content of the theory
section of this programme, but paid a copyright fee to use text from an
existing textbook: Exploring Computers:Theory (Oosthuizen, de Bruyn &
Zeelie, 1999:1-40).

In selecting the CAL CDs, the researcher evaluated a range of different CDs
according to the guidelines set out in sub-section 2.5.3. The VTC training CDs
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guidelines:

@ The navigation system is efficient and well-planned, i.e. on-line help is
available at all times; menus, buttons, and other controls are used
consistently throughout the programme; directions and overt signals let
learners know what they are supposed to do, and users are informed of
their location in the programme through the use of titles, frame numbers,
and other indicators.

@ The visual layout promotes learning, i.e. the content is broken into units
that are small enough to be readily learned; long, linear sequences of
screens are avoided; the text is organized into short, easy-to read
paragraphs, and students can select study and practice sequences that
are best for them.

@ Media elements are used wisely, i.e. graphics, fonts, and other visual
elements are legible, functional and attractive.

@ The application supports active learning: the unique capabilities of the
computer provide meaningful interactivity and feedback; learners are
provided with opportunities to check their level of understanding, and
explanatory feedback is provided for both correct and incorrect responses.

After developing the manual and selecting the CAL CDs, the researcher
continued with implementing the programme for the first time.

44.3 Cycle 1, Step 3: Try a new practice, i.e. implement and monitor the
\ implementation of the programme (cf. table 4.1)

—
‘i"

!

This step in the research marks the beginning of the implementation and
evaluation phases of the instructional design process (cf. Fig. 2.1). It could be
classified as formative evaluation (cf. 2.5.5).

One of the methods used to collect data during this phase of the research
process was by keeping a journal - also called a diary. McKernan (1996:84)
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way by keeping a journal. According to McNiff (1992:79), a journal acts as a
record of events as well as a record of the researcher’s thinking about the
events. In this study the researcher chose to keep a log-type journal. As
described by McKernan (1996:85), a log, as opposed to a personal diary, is a
list of short notes recording events as they happen and not necessarily on a
day-to-day basis. This section elaborates on the cryptic notes that were made
about the events in this specific E!flﬁ‘_/

The researcher started the implementation process by giving informal training
to the instructor at the Welkom campus where the programme was introduced
for the first time. The instructor was informed about the main aspects of
blended learning, as well as the principles of OBE and good teaching practice
that should be applied to enhance learning. He was requested to work
through some of the CAL lessons to acquaint himself with the operational
functioning and content of the CDs.

Two weeks before the start of the semester, the instructor was requested to
install the initialising programme to all computers in the laboratory and ensure
that the CDs will be working. At this stage it came to light that the computers
in the laboratory scheduled for the use of this programme, did not have sound
cards. This posed a serious problem, as the CDs used audio instructions to
guide students through the lessons. The researcher had to re-arrange the
timetable to enable students to move to a different laboratory where
computers had sound cards.

Another technical problem that was encountered is that the lessons had to be
viewed in Netscape Navigator. Netscape Navigator was not pre-loaded on all
computers in the laboratory, which meant that the instructor first had to install
it.

The researcher came to the conclusion that preparing the computer laboratory

took much more time than originally anticipated. This factor had to be taken
into account when planning implementation at the other sites. It is suggested
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before the first class is scheduled.

As indicated in the design phase, during the orientation session held at the
beginning of the semester, students were enlightened about the blended
learning strategy. They were presented with the manual, CDs, assignments
and timeframes for the rest of the semester.

After having face-to-face classes for two weeks, students were introduced to
working with the CAL CDs. From then onwards, they were expected to use
the CDs for revision purposes and to teach themselves some new concepts of
the application packages. The researcher observed that, at first, students
were reluctant to use the CDs. It was as if they perceived it as being an
unnecessary activity and did not realise the possible advantages that it held
for them. Students were encouraged to spend more time in the laboratory
using the CDs, however, only a small number of students participated, and
midway through the semester, the researcher decided to set up an
assignment that involved using the CDs. In this way, students were "gently
forced” to explore the benefits of using the CDs.

The remainder of the semester went according to plan, and at the end of the
semester, the instructor and students were interviewed to find out how they
perceived the programme. These interviews are discussed in the following

sub-section.

4.4.4 Cycle 2, Step 1 Collect data and analyse to diagnose the situation -
determine how students are reacting to the new programme (cf.
table 4.1).

This phase of the research process could be classified as summative

evaluation (cf. 2.5.5). In this step the researcher conducted interviews with the

instructor and students involved in the first round of programme

implementation (cf. Table 4.5 and 4.6).
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interview. The following interview guide was used:

1 Comment on any problems (if any) that you encountered in the process of
implementing the use of the CDs.

2 | Describe any positive or negative results that you observed in the process of using the
CDs.

3 | Describe the role that using the CDs played in teaching the students new skills.

4 | Describe the role that using the CDs played in assisting the students with revising and
practising the computer skills that you have already taught them in class.

5 | How, in your opinion, does the frequency of using the CDs relate to the effective
mastering of computer skills by students?

6 | Comment on the ease-of-use of the CDs — both from the perspective as lecturer as
well as what you observed from the students.

7 | Comment on the audio instructions given as part of the lessons on the CDs.

8 | How do you feel about the following statement: “A student will be able to teach himself
by using the CDs and not having a lecturer at all.”

9 | What is your perception on the usefulness of the manual in leaming the computer
skills? Give a reason for your answer.

10 | In your opinion, is there anything that should be done to improve the EUC course?
Explain.

Table 4.5 Core questions used for interviewing instructors

The following became clear from the interviews:

# |n cases where technical problems were encountered, students were
reluctant to use the CDs. It was of vital importance that the software be
installed and tested before the start of the programme.

@ As most students have not worked on computers before, the instructor had
to spend a considerable amount of time showing them how to use the
CDs.

& |nitially students were requested to use the CDs for revision and
enhancing their own skills, however, they perceived the CDs to be an
unnecessary activity and very few of them used the CDs of their own free
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the CDs that they started to explore the CDs.

« Students found it difficult to understand the audio instructions on the CDs,
as the instructor spoke with an American accent, which they found difficult
to follow. Using headphones and controling the volume also gave
problems in some instances, because students did not know how to
control the sound settings on the computer.

< As the semester progressed and students became used to the CDs, the
instructor found that they could gradually learn more on their own, and
relied less on the face-to-face lessons.

# The overall impression of the instructor was that the blended way of
presenting the programme would pay off, if students used the CDs more
often and if the technical problems encountered could be solved.

To continue the process of evaluation, students were interviewed in groups.
Two groups of ten students each were randomly selected from the students
that enrolled for the programme at the Welkom campus. Focus group
interviews not only rely on a question-and-answer format of interview, but on
the interaction within the group (Mertens, 1998:174). This reliance on
interaction between participants is designed to elicit more of the participants’
points of view than would be evidenced in more structured interviewing. In this
study the researcher set up a number of core questions to guide the interview
(cf. Table 4.6), but as a result of the interaction in the groups, students were
prompted with follow-up questions to ensure that their answers were
interpreted correctly and their true feelings understood. The questions were
set up along the guidelines for evaluation as given by Wills (2001:Online). It
has to be mentioned that the first question is not a typical question that would
usually be asked in a qualitative interview, as it does not deal with
establishing the views or feelings of the students. However, the researcher
deemed it necessary to have an indication of how many times students used
the CDs, as this had an impact on the answers to the rest of the questions
(e.g. if most students used the CDs only once, they would not be able to
respond effectively to the rest of the questions).
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Table 4.6 lists the core quesuons nat were used as basis for the interviews
with students.

1 Approximately how many times did you use the CDs during the semester — not even
once, less than 5 times, more than 5 times, on a weekly basis, or on a daily basis?

2 | If you haven't used the CDs more than 5 times, please explain why not.

3 | Describe the role that using the CDs played in assisting you to obtain new computer
skills — if any.

4 | Describe the role that using the CDs played in revising and practising the computer
skills that you have already leamed in class.

5 | How, in your opinion, does the frequency of using the CDs relate to the effective
mastering of computer skills?

6 Comment on the ease-of-use of the CDs.

7 | Comment on the audio instructions given as part of the lessons on the CDs.

8 | How do you feel about the following statement: “A student will be able to teach himselt
by using the CDs and not having a lecturer at all.”

9 | What is your perception on the usefulness of the manual in learning the computer
skills? Give a reason for your answer.

10 | In your opinion, is there anything that should be done to improve the EUC course?
Explain.

Table 4.6 Core questions used for focus group interviews

The general process for analysis of data is referred to as "constant
comparison" (Erlandson, Harris, Skipper & Allen, 1993:30). The analytical
process involves an interactive, creative, and intuitive examination of the data,
all in the search for patterns, themes, or emerging insights, each unfolding
from the research process and grounded in the data. To verify that the
analytical process is legitimate and rigorous, collected data are disassembled,
then reassembled to find uniqueness in pattern or principle of process. Data
are subsequently coded so that they can be traced back to the original
interview, document or observation for purposes of a conformability audit to
verify the process and research method. The data is analysed and
synthesised through a developmental process, continually evolving and
emerging through constant comparison of newly acquired data with previously
acquired materials.
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the responses received from the interviewees. The results were then analysed
and cross-referenced. The following emerging themes were identified from the
interviews with students:

@ Most students used the CDs more than 5 times during the 16 weeks of the
academic programme. A small number of students used the CDs on a
weekly basis, but very few used it on a daily basis. An very small number
of students opted to use the CDs less than 5 times.

@ The reasons given by those students who used the CDs less than 5 times
were that the computer labs were overcrowded and that often students
would get to the lab and found no computer available. Another reason
would be that, at first, students thought the CDs to be “extra” work, and
they did not believe that it was to their benefit to work through the lessons.
Furthermore, some students were uncertain about the technical details of
using the CDs, as this quote indicates: “At first | didn’t know how fo use the
CD, but when | started, | find it very easy and helpful. | should have started
earlier.”

« By far most students were of the opinion that the CDs were most helpful in
teaching themselves new skills. Some remarks received: “The CDs helped
a lot, because the CD can clarify what I did not understand in a lecture
lesson.” “The more you use the CD the better new skills you provide
yourself.”

@ Students agreed that the CDs were helpful in doing revision of what has
been taught in class. The following remarks underline their views: “It helps
a lot because the lesson can be repeated as many times as one can.” “ It
accommodates everyone — unlike the lecturer who does one thing only
once and you might get lost.” “If a student is slow to understand what the
lecturer said in class, they can use the CD. The CD is not too tired to teach
or to repeat.”

< The interviewees were unanimous in feeling that students will learn better
by using the CDs more frequently. The fact that students can work at their
own pace seemed important to them. “The CDs are helpful because you
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factor that students realised is that they can learn even when the lecturer
is not available. “CDs can be used at any time, even on Sundays or
holidays when lecturers are unavailable.” “One can use the CDs at a
convenient time, unlike depending on the lecturer whose time is inflexible
and rigid.” Students were of the opinion that some people learn better by
working and practising alone. The CDs provided an opportunity for these
students.

Most students felt that once they have been shown how to work with the
CDs, it became easy to use them. “It was not easy at first, but after using it
2 times, | was able to use it alone.” “Because it was my first time dealing
with computers, it took me a while to know how to use the CDs.”

On the question whether students understood the audio instructions,
students had different opinions. Some felt that the instructions were clear
and precise, whilst others indicated that they had difficulty in following the
explanations. “The instructor spoke quickly and not clearly. | could not
hear and understand.” “She does not speak clearly and some people can’t
understand the language — her pronunciation was not good enough.” “I
didn’t understand the instructor, she is too fast.” “I had to rewind and listen
again many times.” The researcher came to the conclusion that students
who are not first language speakers of English had problems
understanding the accent of the voice giving instructions on the CDs. To
determine how serious the impact of this problem would be, it was closely
monitored during the second round of implementation at other sites.

When students were asked whether they thought the CDs could be used
alone, i.e. without the assistance of a lecturer, their answers revealed the
importance of the blended learning methodology. All students agreed that
both the CD and lecturer should be used for best teaching results.
“Lecturers are more easily understood so a CD can be used as revision.”
“It is too complicated for some students, - better to first see it in class.”
“Somebody who never had experience of computers would never be able
to teach himself without help from a lecturer.” “Some of the things should
be lectured before one can do it yourself.” "There are some questions a
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CD can’t answer, SO | trmin a swuein will always need a lecturer.” “The

students must have both CD and lecturer.” “Both are needed to
supplement each other.” The researcher found the following remark
received from one of the students particularly interesting: “/ think the CD
and the lecturer must go hand in glove.”

All students were convinced that the manual was most helpful. The
responses indicated that the researcher's efforts to follow good
development guidelines for printed material (cf. 2.5.3) were most
successful. “Yes, the step-by-step instructions provided you practice,
practice, practice!” “The instructions are easy to follow.” “The manual is
very helpful, because if | don't understand then there is a picture
demonstrating the information.” “Everything was explained in simple terms
and that made it easy to understand the computer skills.” “The manual was
very easy to read and very easy to understand — very helpful - clearly set
out!”

Many students were of the opinion that the EUC programme was very
successful. Remarks like “The EUC course is perfect’ and “The course is
fine exactly the way it is" were most encouraging to hear. However, some
students felt that the programme could be improved by providing more
computers in the laboratories and by extending the duration of the course.
“The classes should be extended to one year. We need more time for
practicals, especially for those who do not have PCs at their homes.” “The
course must be improved by increasing the number of computers.” Some
of the other remarks made by students are: “/n my opinion the EUC course
is just perfect — we have all the privileges. All | can say is keep up the
good work!” “Keep up the spirit of using CDs and encourage students to
visit the labs regularly. The way it is utilising both the lecturer and CD was
fine for me.” The researcher concluded that most students were satisfied
and that the method of blending the CAL, self-instructional printed material
and face-to-face lectures definitely had a positive impact on the learning
programme.
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students must have both CD and lecturer.” “Both are needed fo
supplement each other.” The researcher found the following remark
received from one of the students particularly interesting: “/ think the CD
and the lecturer must go hand in glove.”

All students were convinced that the manual was most helpful. The
responses indicated that the researcher's efforts to follow good
development guidelines for printed material (cf 2.5.3) were most
successful. “Yes, the step-by-step instructions provided you practice,
practice, practice!” “The instructions are easy to follow.” “The manual is
very helpful, because if | don’t understand then there is a picture
demonstrating the information.” “Everything was explained in simple terms
and that made it easy to understand the computer skills.” “The manual was
very easy to read and very easy to understand — very helpful - clearly set
out!”

Many students were of the opinion that the EUC programme was very
successful. Remarks like “The EUC course is perfect’ and “The course is
fine exactly the way it is” were most encouraging to hear. However, some
students felt that the programme could be improved by providing more
computers in the laboratories and by extending the duration of the course.
“The classes should be extended to one year. We need more time for
practicals, especially for those who do not have PCs at their homes.” “The
course must be improved by increasing the number of computers.” Some
of the other remarks made by students are: “/In my opinion the EUC course
is just perfect — we have all the privileges. All | can say is keep up the
good work!” “Keep up the spirit of using CDs and encourage students fo
visit the labs regularly. The way it is utilising both the lecturer and CD was
fine for me.” The researcher concluded that most students were satisfied
and that the method of blending the CAL, self-instructional printed material
and face-to-face lectures definitely had a positive impact on the learning
programme.
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After analysing the data collected from the interviews, the researcher was
satisfied that most students felt positive about the programme. The complaints
about not being able to understand the audio instructions raised some
concern, however, it was decided to go ahead with implementing the
programme at the East Rand and Port Elizabeth campuses to find out how
students from other regions react to this specific problem.

445 Cycle 2, Step 2: Distribute the data to others, i.e. revise the
programme (cf. table 4.1).

The only programmatic change requested by a consensus of students was
that they wanted the programme to run over a full year instead of a semester.
As the programme forms part of official qualifications at the university a
change of this nature has to be approved by a series of different committees.
The process could take up to 12 months. It was thus not possible to
immediately adhere to students’ requests, and the researcher decided to
consider the possibility of changing the timeframe at a later stage.

Because it became clear that students initially did not use the CDs out of their
own free will, the researcher added assignments which required students to
access the CDs early in the semester. The purpose was to expose students to
the CDs so that they could discover the benefits of using them.

There were no other reasons for changing the programme in a significant
way, and therefore the researcher proceeded with implementing the
programme at other sites of instruction.

4.4.6 Cycle 2, Step 3: Try a new practice, i.e. implement the revised
programme and monitor the implementation thereof (cf. fable 4.1).

In this step of the action research cycle, the programme was implemented at
two additional sites, i.e. the East Rand and Port Elizabeth campuses of Vista
University. There was also a new intake of students at the Welkom campus.
No significant changes were made to the programme at this stage. However,
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having experienced several technical problems during the first round of
implementation, the researcher took steps to prepare the laboratories at all
campuses well in advance (cf. 4.4.3). This was done to ensure that students
do not encounter any unexpected technical problems. Furthermore, the
researcher trained the lecturers involved in presenting the programme using
the blended learning methodology. They were enlightened about the research

project and knew exactly what was expected of them.

Students were requested to complete a questionnaire to establish whether the
trend of prior experience and the availability of computers at home were
similar to the findings of the first round at the Welkom campus (cf. Table 4.3).
The data collected through the questionnaires is summarised in the following
charts:

Round 2 Welkom Computers at home

3%
' B No computer at
home
B Computer at
. home

97%

Fig. 4.4 Percentage of students from the Welkom campus with computers at home
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Round 2 East Rand Computers at home

ENo computer at home
B Computer at home

94%

Fig. 4.5 Percentage of students from the East Rand campus with computers at home

Round 2 Port Elizabeth Computers at home

7%

EINo computer at home
B Computer at home

Fig. 4.6 Percentage of students from the Port Elizabeth campus with computers at
home

The statistics clearly show that, at all sites, the majority of students do not
have computers at home. This strengthens the decision made in the analysis
phase that the blended programme should not include any form of web-based
delivery, as students do not have access to computers outside the campus.
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The second question Of Liw yucewwmene aimed to establish how many

students had prior experience working on a computer (cf. Table 4.3). The data
is presented as follows:

Round 2 Welkom Prior experience

E Never worked on a
computer before

B Worked less than
10 times

OWork weekly

OWork daily

Fig. 4.7 Percentages indicating prior experience working with computers at the
Welkom campus

Round 2 East Rand Prior experience

[ Never worked on a
computer before

mWorked less than 10
times
O Work weekly

26%

0O Work daily

Fig. 4.8 Percentages indicating prior experience working with computers at the
East Rand campus
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Round 2 Port Elizabeth Prior experience

H Never worked ona
computer before

B Worked less than 10
times

OWork weekly

DOWork daily

Fig. 4.9 Percentages indicating prior experience working with computers at the
Port Elizabeth campus

From the data it is clear that, although fewer students in Port Elizabeth had
never worked on a computer before, the number of students that used the
computer on a daily or weekly basis are very low at all the sites. From these
figures, the researcher deducted that most students will not be able to use the
CDs without initial help from the lecturer. The decision to have face-to-face
classes for the first two weeks and then introduce the CDs was upheld.

There were no significant problems experienced with implementing the
programme at the new sites of instruction.

4.4.7 Cycle 3, Step 1: Collect and analyse data to diagnose the situation
- determine how students are reacting to the new programme (cf. table
4.1).

At the end of the second round of implementation, the researcher interviewed
the instructors involved in presenting the programme. Their responses are
summarised as follows:

& Technical problems related to using the sound were encountered at all the
sites. This was mainly due to the fact that there were specific settings in
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the Windows operating sysweiin wiar nad to be adjusted to enable the

sound, and some students did not know how to do this. The fact that the
lessons had to run through either Netscape or Internet Explorer was also
seen as a problem. “/ do think the manufacturer should have used another
method to simplify the way of presenting the lessons.”

The fact that students were learning in advance was seen as one of the
positive outcomes of using the CDs. The instructors also felt that the CDs
helped students to have a broader insight on the features of the
application packages. “We do not offer intermediate and advance
computer literacy programmes at this university, and using the CDs
provided students with the opportunity to go further than the curriculum we
offer.”

“A negative outcome of using the CDs is that some students did not attend
classes with the hope that they will go through the CD on their own, and
then only to find that they don't find the time to do so, or do not understand
the work without the help of the lecturer. It was also noted that some
students (the minority) were reluctant to use the CDs, and they had to
continuously be shown how to start the process, and work through the
lessons.”

All the instructors agreed that using the CDs definitely improved the
students’ skills. “There is often more than one way of getting the same
result in an application package. Only one method is explained in the
manual. However, using the CDs, students could point out the difference
between the study manual and the CD, and tried out some alfernative
ways of performing certain tasks.”

The instructors all felt that the contents of the lessons on the CDs are
sufficient. “Working through some of the sections myself, | found the CD to
be very resourceful. | have used Word and Excel extensively and learnt a
few more advanced features from the CD.”

The instructors agreed that the students did not find it difficult to work with
the CDs. “Students didn’t take long to understand how to use the CD - it
was really not that difficult.”
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the face-to-face classes, enhanced the learning process considerably. “/
found that the students could do a lot of the basic steps quicker.”

% When the instructors were requested to give recommendations on
improving the programme, they indicated that more time is needed for
students to master the skills. They proposed that the course be extended
to a year and that some more advanced features of the word processor
and spreadsheet packages should be included.

To determine how students perceived the programme, the researcher
conducted focus group interviews, similar to the ones at the end of the first
round of implementation (cf. 4.4.7). There were no major differences in the
feedback from students from the different sites of instruction. Furthermore, the
reactions of students were very similar to those from the first round of
implementation. The following main themes transpired from the interviews (cf.
Table 4.6):

@ The strategy to set up an assignment that involved students using the CDs
paid off, and there was a positive increase in the students that used the
CDs on a weekly basis.

@ Students felt that they have definitely benefited from using the CDs. Some
reasons given were that they could go back after class and revise what the
lecturer explained, and that they could use the CD to catch up on what
they have missed in class.

# Students appreciated the fact that the CDs were “patienf’ and that it
“explains over and over".

@ Some students indicated that the CDs challenged them to think as
opposed to simply sitting in class and listening to the instructor.

@ Most students found the CDs easy to use after the lecturer had shown
them how to do it.

@ The problem of not understanding the audio instructions was experienced
by students at all the sites of instruction.
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should be used in instruction as this enhanced their performance. The
following comments strengthen the believe that blending media with face-
to-face lessons is having a significant impact on the learning process: “/
think the instructor and CDs work hand in hand and to use the two will be
beneficial to a learner.” “A lecturer’s role is still of paramount importance,
but the CD is a wonderful complement to the lecture.”

@ The students involved in the second round of implementation agreed that
the manual was well-structured and easy to understand. The following
comment summarises the importance of the manual: “/ thought |
understood the lecturer, but when | was alone with the computer, | forgot —
then consulted the manual and that helped me to remember things.”

@ When students were asked what should be done to improve the
programme, the researcher received the following responses: “Honestly it
is very exciting, except that we need more computers and more time to
practise.” “No dont change anything - because we have lecturers,
manuals and CDs to help us — so perfect!! | think everything is 100%.”

In analysing the responses the researcher came to the conclusion that overall
the programme was well-accepted. The only problem identified was the fact
that students found it difficult to understand the audio instructions. This fact
could not be ignored and the researcher addressed it in the next step of the
research cycle.

4.4.8 Cycle 3, Step 2: Distribute the data to others, i.e. revise the
programme (cf. table 4.1).

In this step the researcher had to make final changes to the programme. As
mentioned, the only serious problem that was identified, was the indication
that students could not always understand the audio instructions. As most
students are not first language speakers of English, they found it difficult to
follow the pace at which instructions were given. Furthermore, the American
accent was difficult for many South African students to understand.
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To overcome this problem, the researcher selected alternative CAL CDs
(Spear, 2004). The CAL material was evaluated according to the guidelines
as set out in sub-section 2.4.5.

4.4.9 Cycle 3, Step 3: Try a new practice: implement the changed
programme (cf. table 4.1).

As explained in sub-section 4.3.2 the intention was to implement the final
programme at all the campuses of Vista University. However, due to the
unbundling of Vista University and the subsequent mergers with other higher
education institutions, the researcher could only obtain permission to
implement the final programme at the Welkom campus, which now forms part
of the Central University of Technology, Free State. Implementation continued
without any problems. To determine how students reacted to the new CAL
CDs, the researcher decided to conclude data collection by having one more
round of interviews (cf. Table 4.6).

4.4.10 Cycle 4, Step 1: Collect and analyse data to diagnose the situation
- determine how students are reacting to the new programme (cf. table
4.1).

In this final step of data collection, the instructor at the Welkom campus
responded with the following comments:

@ The new CAL CDs were easier to use and presented less technical
problems. Students found it easy to access the training material.

@ By using the CDs the students spent more time in the lab and this
definitely had a positive impact on their skills. They mastered the required
skills in a shorter time span than simply attending face-to-face classes.

@ The instructor could not mention any negative effect from using the CDs,
in fact he was sure that students benefited from using the CDs and that it
should definitely be continued to form part of the programme.
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way that was easy to understand.

< An interesting remark from the instructor was that different students
preferred to learn in different ways. Some students needed one-on-one
contact with the lecturer, some students preferred to study on their own,
and some preferred to work in groups. The instructor observed that
blending the CDs with face-to-face classes provided opportunities for the
different needs of students. This underlines the fact that blended learning
strengthens the principle of good teaching to respect diverse ways of
learning (cf. 3.4.6).

The focus group interviews held with students at this stage produced results
very similar to those of the previous rounds of implementation. The new CAL
material was received well and students reacted very positively about the
programme.

The final data collected indicated that the programme did not need any further
changes. The research process was completed, and the final conclusions and

recommendations are given in the following section.

4.5 CONCLUSIONS AND RECOMMENDATION

e

An overview of the study has been given in sub-section 4.1, where the
researcher explained the method used to fulfil the original aims set out for this
study.

4.5.1 Findings of the study

=
/ In this sub-section the researcher presents the findings of the study by

providing answers to the research questions stated in sub-section 1.2.

L
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What is the role of blended learning in education?
A study of literature in Chapter Two revealed that blended learning has a
number of advantages (cf. 2.2) and is set to play an increasingly important

'; role in future education systems. There exist a number of innovative ways

' to create blended learning programmes (cf. 2.4). The study further

indicated instructional design guidelines that could be followed to design
blended learning programmes (cf. 2.5). One of the phases of instructional
design is evaluation and the literature study indicated a number of ways to
evaluate a blended learning programme (cf. 2.5.5). These guidelines were
followed in evaluating the programme developed in this study, through
action research.

o What influence do the principles of good teaching practice and OBE have

on developing a blended learning, computer literacy programme?

In Chapter Three a literature overview of the principles of OBE and good
teaching practice were discussed. In studying these principles the
researcher was able to construct a clear framework for developing an
effective CL learning programme (cf. 3.4). Literature revealed standards
set for CL programmes and indicated the content that should be covered
by such a programme (cf. 3.2.2). The programme developed through this
study reflects this content and is based on the principles of OBE and good
teaching practice.

— e What factors should be taken into account in developing a blended

.‘\
e

~

learning computer literacy programme for South African students?

As described in Chapter Four the researcher followed action research
techniques to develop, evaluate and implement an OBE CL programme in
blended learning mode for South African students (cf. 4.2.2). The first step
in the research cycle was to collect data to be able to develop the
programme. As blended learning is such a recent trend in education, the
best way of collecting data, was to perform a literature review of content
found on the Internet. The findings are summarised in sub-section 4.4.1.
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After collecting the initial data, the research process was completed by
following a number of steps, i.e. analysing, developing and evaluating the
programme (cf. 4.4.2 — 4.4.10). The end-result of the research is a well-
developed programme that proved to be successful in training the basic
CL concepts, in blended learning mode, to South African students from a
disadvantaged background. The complete programme is given in Chapter

Five.

4.5.2 Problems encountered during the study

)

I The study revealed a number of new, innovative technologies that can be

. used to develop a blended learning programme. However, in selecting the

' blended learning options, the researcher was limited by the following two
'\gj_ggtors_:
e

- Most of Vista University’s students are from a disadvantaged background

and do not have computers at home (cf. 4.4.17).

@ There was no infrastructure available at the univérsity for using
videoconferencing and because of the high cost of installation this could
not be considered a viable option.

= Because of the unbundling of Vista University and the subsequent
mergers, the final programme could only be implemented at one campus,
instead of the seven different campuses, as initially intended.

The study revealed that, in selecting the blended learning options, the most
important factor to consider is what do students have access to (cf. 3.4.7).
The researcher was, in this case, restricted to selecting media that students
could use in the computer laboratories on campus, and could not explore the
advantages of using WBI.

J
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4.5.3 Recommendation

It is recommended that students who have no prior experience in using
computers enrol for the programme presented in Chapter Five. Although
many computer literacy programmes are used in various institutions in South
Africa, this is the first attempt to present CL in blended learning mode. Having
gone through the cycles of action research, this programme can be
recommended as being a well-designed, efficient learning tool through which
students can learn to use the computer effectively. It was developed
according to the principles of OBE and successfully addresses the principles
of good teaching practices.

The programme and manual are divided into the following five sections:

< Section A — Theory. This section was not specifically developed for the
purpose of this study, but is copied from a textbook of which the
researcher is a co-author (Oosthuizen, de Bruyn and Zeelie, 1999:1-40).

& Section B — MSWord. This section covers the basic principles of Word
Processing.

@ Section C — Windows. This section covers the basic principles of using the
Windows operating system.

@ Section D — Internet. This section covers the basic principles of using the
Internet and e-mail facilities.

@ Section E — Excel. This section covers the basic principles of using
spreadsheets.

In addition to the manual, students receive a CAL CD and a study guide which
contains the assignments, and a detailed work scheme indicating the due

dates for assignments. The complete programme is presented in Chapter
Five.
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The researcher identified the following as possible opportunities for further
research:

@ The result of this study is an infroductory CL programme. A similar
programme could be developed at a more advanced level.

@ Students who completed the programme could be observed to determine
the long-term effects of the training on their careers.

@ A quantitative study could be undertaken to statistically compare the
results of a group of students that follow the blended learning programme
as opposed to a group that follow the traditional face-to-face programme.

The final product that resulted from this study is presented in Chapter Five.
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A BLENDED LEARNING COMPUTER LITERACY PROGRAMME
FOR SOUTH AFRICAN STUDENTS

TABLE OF CONTENTS
1. Workscheme

2. Manual
Section A Theory
Section B MS Word
Section C Windows 95
Section D Internet and E-mail
Section E Excel

3. CAL'CD

! Please note that the CD is copyrighted.
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WORK SCHEME EUC 5001
WEEK PRACTICAL THEORY REVISION & DUE DATES
COMPONENT SUPPLEMENT (ASSIGNMENT
LESSONS ON CD S&
EXERCISES)

Week 1 Orientation

Week 2 Windows

Week 3 MS Word Chapter 1

Chapter B1
Week 4 MS Word Chapter 2 | Work through MSWord,
Chapter B2 & B3 Chapter 1, Lesson 1, 2,
3,4, &5
Week 5 MS Word Chapter 3 | Teach yourself new
Chapter B4 concepts by working
through Lessons 6, 7
and 8. Do the interac-
tive Quizz
Week 6 MS Word Chapter 4 | Work through MSWord
Chapter BS & B6 Chapter 2, Lesson 1, 2,
3,4,8,9.

Week 7 MS Word Chapter 5 | Teach yourself new

Chapter B7 concepts by working
through Lesson 10.
Week8 | WORD
PRACTICAL TEST
Questionnaire 1
Student holidays
Week 9 Internet/E-mail THEORY Hand in Word
TEST Assignment
Monday On Friday
@ 12:00

Week 10 | Excel Chapter E1 Work through Excel,
Chapter 1, Lesson 1, 2,
3, & 5. Do the quizz.

Week 11 | Excel Work through Excel,

Chapter E2 & E3 Chapter 2, Lesson 1, 2.
Teach yourself new
concepts by working
through Lesson 3.

Week 12 | Excel Chapter E4 Work through Excel, Hand in Excel
Chapter 4, Lesson 1, 2 | Assignment
and 3. On Friday

Week 13 | EXCEL

PRACTICAL TEST

Week 14 | Practical exam
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Section A (Theory) was re-printed in the study manual with permission
from the publisher Computer Forum (Oosthuizen et al., 1999) and was
not specifically developed for this study. It is therefore not presented as
part of this study.
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CHAPTER B1

OUTCOMES OF THIS CHAPTER ARE TO BE ABLE TO:
Start MSWord 97

Identify the different parts of the Word 97 screen
Create a new document & enter text

Edit text by using the backspace, delete insert keys
Move the cursor to different positions on the screen
Save a new document

Create a new blank document

Switch between different open documents

Close a document

Exit Word

® © ¢ ¢ ¢ & o o o o

INTRODUCTION

Word processing software allows general word processing like typing letters,
assignments, CVs and other types of documents. This type of software replaces the use
of pen, paper and the typewriter which were traditionally used for word processing.
MSWord processing software allows document creation to be easier and faster. The
basic functions of word processing software are typing, editing, formatting, saving and
printing.

» Typing involves the creation of a document.

» Editing involves correcting mistakes made on your document.

» Formatting involves adjusting the appearance of a document.

> Saving involves saving a document for later reference.

> Printing involves producing a paper copy of a typed document.

In word processing, document creation is separate from the printing process. This
separation is what makes word processing software much more convenient than using
a typewriter or traditional pen and paper.

See Chapter A3 for more information on the advanced features of word processors.
MSWord 97 is the word processing software we are going to learn to use in this course.

Other examples of word processing software are: Corel WordPerfect, Lotus Amipro
and WordStar.

B1

© Central University of Technology, Free State



Ny Corirl Unversiy o SECTION B: MS Word

Technology, Free State

STARTING MS Word

1. Click on Start (at the bottom left corner of the screen).

2. Click on Programs.

3. Look for the Microsoft Office 97 icon or Microsoft Word icon.

*wmunm
mwmsuus ,

L

¥ W W W e o

There are different ways to activate a program in Windows 95. Note that your screen
may look different from the diagram shown above. If you have problems activating
MSWord, consult the Windows notes. In any case you will find the following MSWord-

icon:

MSWord will automatically open a new document and the user can start typing
immediately. The insertion point, represented by a blinking cursor [|] shows the position

where the next character that you type will appear.

To enter text, simply start typing.

B2
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IDENTIFYING THE DIFFERENT PARTS OF THE SCREEN

Standard Formatting
Titlg Bar Menu Bar Toolbar Toolbar
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The first thing that you will realize is that the MSWord screen is set up the same way as
your Windows 95 program. It consists of :

>

The Title Bar displays the name of the application and workbook you are currently
working in.

The Menu Bar displays the name of the various application menus available within
MSWord.

The Standard Toolbar is usually displayed below the Menu Bar and contains a
number of icons that can be used to activate functions of MSWord without having to
go through the menus. The user has a choice of displaying a number of different
toolbars by right clicking between icons on the standard toolbar.

The Status Bar is situated at the bottom of the screen. It provides information about
documents, such as cursor position, page and section numbers and the total
number of pages in the document.

The Formatting Toolbar is usually just below the standard toolbar at the top of the
screen. It contains a number of icons that can be used to format the contents of the
workbook i.e. bold, italic, underline, left align, right align or centre text.

The Ruler Bar is situated below the formatting toolbar and is used to set indents,
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tab settings and changing margins settings.

» The Scroll Bars appear at the right hand edge (vertical scroll bar) and at the
bottom (horizontal scroll bar) of the screen. These are used to scroll through the
document.

USING ON - LINE HELP

It can be quite difficult to start using MSWord 97. People without previous experience in
any Windows based MSWord Processor can make use of the on-line help available in
MSWord 97. This allows you to obtain help on certain topics while you are actually
using MSWord 97. To activate the on-line help facility:

(S Click on the Help menu.
2 Click on Microsoft Word Help.
3. Follow the guidelines on the screen. The help facility will direct you to

instructions which will help you to perform the required tasks.

IMPORTANT ICONS ON THE STANDARD TOOLBAR

New Save Preview Cut Paste Undo Insert Table

I I I I I I I

NDSR8RY |  =@ad v« Q@ EOR=E 3 &T »
I | | I I I I

Open  Print Spell Copy Format Painter Redo Percentage view

The following are the most important icons on the toolbars that will be used during this
course:

» The New icon is used to create a new document.

» The Open iconis used to open an existing document that has already been saved.
» The Save icon is used to save a document that has been saved before.

» The Print icon is used to send a document to be printed on the printer.

» The Preview icon displays the document in a small format to enable the user to see
the format in which pages are going to be printed.

»> The Spell check icon can be used to do a spellcheck on the document.

» The Cuticon places highlighted content onto the Clipboard — removing them from
their old position.

» The Copy icon places a duplicate of the highlighted content onto the Clipboard —
the original data stays untouched.
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The Paste icon inserts the current contents of the Clipboard into a new position.
The Format Painter icon can be used to change the format of data to the same
format as that of a selected content.

The Undo and Redo icons can be used to undo or redo previous actions.
The Insert table icon allows the user to insert a small table.

The percentage icon makes it possible to display the document in different sizes.

IMPORTANT ICONS ON THE FORMATTING TOOLBAR

Style Font Fontsize Iltalic Left Right Numbering

justify  justify Outdent
I | I I | I I I

HNurmaI ~ Arial * 12 v’ B I U HE =EE=E=
|

=iy R |
== fEiE i ‘
I I I I |
Bold Underline Centre Full justify Bullets Indent

The Style drop-down box can be used to change the specific style which is used
to type the text.

The Font drop-down box can be used to change the font of text.
The Font size drop-down box can be used to change size of the font used.

The Bold, Underline and [talic icons are used respectively to switch between
boldface, underline and italics.

The Left, Right and Centre Justification icons are used to align text left, right or
centre with reference to the left and right margins.

The Full Justification icon is used to align text automatically so that the left and
right margins form a straight line.

The Bullet and Numbering icons are used to insert bullets and numbering.

The Outdent and Indent icons are used to either move a whole paragraph to the
left or to the right.

The Bullet and Numbering icons are used to insert bullets and numbering.
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ENTERING TEXT
When you open MSWord, a blank new document is immediately made available for
use. It is possible, though, to open a new document at any time.

WHERE TO START TYPING?

The insertion point, represented by a blinking cursor [ | ] shows you the position where
the character you type will appear. To enter text simply start typing. When entering text,
the following rules apply:

» The alphabetic keys’ row start with the letters QWERTY.

»> Capital letters are obtained by either switching the Caps Lock key on or by using
the Shift key in conjunction with the letters A - Z (when Caps Lock is off).

» The Shift key is used to obtain special characters [ @#$ % " &* () _+=-"~]
which are positioned above the number keys situated above the alphabetic keys.

> Spaces between text and words is obtained by using the Space Bar key.

» To move to the next line, MSWord uses a feature called word-wrap, were text
automatically moves to the next line once the end of the previous line has been
reached.

» The user can also proceed to the next line by pressing the ENTER key. Spaces
between lines and paragraphs are thus obtained by using the ENTER key.

TO CORRECT TYPING ERRORS

When typing the user is bound to make mistakes. In MSWord, mistakes could be
corrected without re-typing the whole word, paragraph or page. There are different
ways of correcting mistakes:

» By using insert mode the user is allowed to insert text at any pointin the document
without typing over any other text. In normal circumstances, the insert mode is the
default mode.

» By using overwrite mode the user will type over any text to the right of the cursor.
To switch to overwrite mode, simply press the INSERT key OR double click on
OVR on the status bar (at the bottom of the screen).

» By using the delete key one character to the right of the current cursor position will
be deleted.

> By using the backspace key one character to the left of the cursor will be deleted.
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TUTORIAL B1.1

September 19, 1998
Molehe Leteane
19224 Putswastene
Thabong

Dear Molehe

You are invited to my millennium party on 1 January 2000 at 32 Meyer Street,
Reitzpark. Please phone: 057-355 5555 to confirm your attendance.

See you at my party!!

Sincerely

Mogomotsi

1 Type the letter exactly as given above.

2. Use the arrow keys on the keyboard to move to the end of the name Mohlehe.

g Press the Backspace key to erase the name.

4. Type in the name Nkosi.

5. Move the cursor to the beginning of the name Nkosi.

6. Press the Delete key to erase the name Nkosi.

T Type in the name Martha.

8. Move the cursor to the beginning of the name Martha.

9. Press the Insert key. You now move into Overwrite mode which means that the
text you type, will be typed over existing text.

10. Type the name Molefi.
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MOVING THE CURSOR TO DIFFERENT POSITIONS ON THE SCREEN
The cursor can be moved in your document to suit your different needs. One can use
either the mouse or the keyboard to move the cursor or insertion point to different parts
of your document. It is much faster to move the cursor using a mouse.

TO MOVE THE CURSOR USING A MOUSE
1. Move the mouse pointer to the desired position in your document.
2 Click the left mouse button.

NOTE: The vertical and horizontal scroll bars can also be used to move through your
document with a mouse.

TO MOVE THE CURSOR USING A KEYBOARD
Pressing different keys will move the cursor to different positions in different ways:

» Use the left, right, up and down arrows to move one character at a time to the left,
right, top or bottom.

» Use the Control key (Ctrl) in conjunction with the left and right arrow keys to
move one word at a time.

» Use the Control key (Ctrl) in conjunction with the up and down arrow keys to
move one paragraph at a time.

» Use the Home key to move to the beginning of a line.
» Use the End key to move to the end of a line.

» Use the Page Up (PgUp) and Page Down (PgDn) keys to move between pages.

SAVING DOCUMENTS

As you type, the computer's memory (RAM) holds your work. When you exit MSWord,
or if power to the computer is turned off, your computer erases your work in RAM. To
store your work permanently, you must save it in a named file on your disk. Files /
documents can either be saved on the computer’s hard disk (C:); on the diskette in
drive (A: or B:) or the disk in your network drive (H:). Get into the habit of saving your
work regularly while still busy creating the document. This can help save time in case of
hardware or software failure.

When saving a document for the first time, the document must be assigned a file name.
You must also specify where the file should be stored i.e. in drive A:, C: or H..

B8

© Central University of Technology, Free State



0 SECTION B: MS Word

o Central University of
Technology, Free State

TO SAVE A DOCUMENT FOR THE FIRST TIME

1 Click on the File menu.

2. Click on Save As. A dialog box will appear, giving you the option to assign a
name to the document and choose a specific directory (e.g. H:) where you wish
to save it.

Sl I-J = 7 & o of[= 5l T
bese [
Cancel
Ophions...
!deum
Click here to select the drive Click here to type in a name for the document

3. Click on the Save in drop-down list (see diagram above). A similar dialog box
to the following appears:

[#] Desktop -
=) My Computer
29 3% Floppy (A1)
= Marka (C:)

] eucmanual
Big Game Hunter (E:)
&
"jmnmnm
] Adaptec Easy CD Creator
€2 Internet Locations (FTP)
42| AddModify FTP Locations -

4. Select where you want to save the documenti.e. in the A:, C:, or H: -drive. You
can also select a specific directory to save the file in.

Click in the File name box and type a name for the document.

Click on Save or press Enter.

The title bar should now display the name of your file and the directory where it
is saved.

Mo

TO SAVE A FILE THAT HAS BEEN SAVED BEFORE
When saving a file that has already been saved, Word will save the latest version of
the document and replace the old contents.

1. Click on the File menu.
2. Choose Save
OR

Click on the Save icon.
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NOTE: The Save As option can also be used to make a copy of the document and
save it under a different name. Simply follow the steps above and in step 5, assign a
new name fo the file.

It is advisable to save the file that you are working with every 5 - 10 minutes. 1t may
happen that you experience problems with your computer, the power shuts down or
your network server goes down in which event you will lose all information that has not
been saved.

TUTORIAL B1.2
A Save the file that you created in Tutorial B1.1 with the name PARTY.

2. Change the name of the document to PARTY 1.

CREATING A NEW DOCUMENT

As already stated a new document is immediately made available for use when
MSWord is activated. However, the user may wish to create a new document whilst
already working on an existing document. (It is possible to have more than one
document open at the same time.)

The format of documents is based on templates. A template is a model for a document.
MSWord has different kinds of templates, but in general, most documents you'll create
will be based on the blank document template.

TO CREATE A NEW DOCUMENT
1, Click on the File menu.
2. Click on New. The following dialog box will appear:

General |Letters & Faxes | Mamos | Other Documents | Wb Pages |

Preview not avalable,

8. Click on Blank Document.
9. Click on OK.
A new document will be opened.
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NOTE: A new document can also be created by simply clicking on the New icon.

o

SWITCHING BETWEEN DOCUMENTS THAT ARE OPEN
It is possible to have more than one document open at the same time. Usually MSWord
will only display one document on the screen.

TO SELECT ANOTHER OPEN DOCUMENT

1. Click on the Window menu.
2 Select the document you want to work with.
CLOSING AND EXITING

The computer may never be switched off while working in MSWord. All documents have
to be closed and MSWord has to be exited.

TO CLOSE A DOCUMENT
1. Click on File.
2. Select Close.

If you close a document or exit MSWord without saving, MSWord will ask you if you
wish to save the document or any changes that you have made to the document.
Choose an option which is relevant to your case.

TO EXIT MSWORD
1. Click on File.
2: Select Exit.

TUTORIAL B1.3
) Close all open documents. (Do not save the empty document.)

2 Exit MSWord.
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CHAPTER B2

OUTCOMES OF THIS CHAPTER ARE TO BE ABLE TO:
e Open a saved document

e Edit a document using

Various Selection Techniques

Cut, Copy & Paste

Undo/Redo

Editing text

VVVV

OPENING A SAVED DOCUMENT

To edit or make changes to an already existing saved document, one has to first open it
from a disk where it is saved. When it is opened, MSWord displays it on the screen.
Opening or retrieving a document onto the screen does not remove it from the disk; it
just places a copy of it in your computer's memory. If you already have another
document opened, MSWord will open a new window for the new document.

TO OPEN A DOCUMENT
i 8 Click on File.
3 Select Open. A dialog box similar to the one below will appear.

TR e i i TR A = 1] L o At o o S i ot e = 2§ >:
Lockin:  [S2 Misyn-m on wiavait\users' () ] G| @ ca|@S) (== mse ]| 3|
Brillacc | Qpen j

Doctor
Exam

Find files that match these search criteria:
File pame: | ~| Text or property: | =1 Eind Now J

Files of type: IWnranumnts 3 Last modified: Ianytlme ;' New Search J
|3Fflle(s) found. ; i p i

If the filename is not listed on the screen, click on the Look in drop-down list.
Choose the appropriate drive and / or directory.

Select the file you want to open or type in the file name in the File name box.
Click on Open.

The document will appear on the screen.

O ok w
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EDITING A DOCUMENT
To edit a document entails making changes to the document. We are going to learn
how to edit a group of text simultaneously. The general procedure is:

» Open the document.
» Select the text that has to be changed / edited.
> Perform the editing.

SELECTION TECHNIQUES

To make changes to text, words or paragraphs that have aiready been typed, first
select (or highlighf) the text. Either the keyboard or the mouse can be used to select /
highlight text.

TO SELECT USING A MOUSE

% Click the mouse to position the cursor at the beginning of the text to be selected.
2 Hold down the Shift key.

3. Point the mouse at the end of the portion to be selected.

4, Click the right mouse button.

All text between the first mouse click and the last mouse click will now be highlighted.

There are other ways to select text using a mouse:

Select Procedure

Characters Drag the mouse while holding the left mouse button down.
Changing directions when you drag will increase or decrease the
selected area.

A word Double click the word.

A line of text Click in the selection bar to the left of the lines.

Multiple lines Click and drag in the selection bar to the left of the lines.

A sentence Hold down the Ctrl key and click anywhere in the sentence.
A paragraph Double-click in the os;lection bar to the left of the paragraph.

Triple click anywhere in the paragraph.

An entire document |Press Ctrl and click in the selection bar.

A rectangular block |Hold down the Alt key, click and drag.
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TO SELECT USING A KEYBOARD

1 Move the cursor with the arrow keys to the beginning of the text to be selected.

2 Hold down the Shift key and move with the arrow keys to the left, right up or
down direction to the end of the portion to be selected.

As the cursor is moved, text will be highlighted.

There are other ways to select text using a keyboard:

Select Procedure

To the end of a word Ctrl+Shift+Right arrow
To the beginning of a word Ctrl+Shift+Left arrow
To the end of a line Shift+End

To the beginning of a line Shift+Home

One line up Shift+Up arrow

One line down Shift+Down Arrow

To the end of a paragraph Ctrl+Shift+Down arrow
To the beginning of a line Ctrl+Shift+Up arrow
One screen up Shift+PgUp

One screen down Shift+PgDn

To the end of a document Ctri+Shift+End

To the beginning of a Ctrl+Shift+Home
document

Once you have selected text that you want to edit, you can then make changes to it.

CUT, COPY AND PASTE

MSWord allows a user to move text that has been typed in one position to another
position without having to retype it. This process is called Cut and Paste. It is also
possible to copy text that has been typed in one position to another position in the
document. This process is called Copy and Paste.

Once text has been cut or copied it can be pasted multiple times at different positions in
the document. It can also be pasted into other documents or even to other Windows-
based applications.
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The difference between cut ana copy 1s:

» Copy leaves the text block in the original position and places an exact duplicate of
the text at the new position.

» Cut removes the text block from its original position and places it at a new position
that the user selects.

TO COPY AND PASTE
1. Select text that you want to copy, using one of the selection techniques
described.

2. Click on the Copy icon. Eﬁ_
3\ Move the mouse pointer to the position where text has to be copied to.
4 Click on the Paste icon. ®

TO CUT AND PASTE (MOVE TEXT)

1 Select text that you want to copy, using one of the selection techniques
described. l ¥

2. Click on the Cut icon.

3. Move the mouse pointer to the position where text has to be copied to.

4. Click on the Paste icon. e

UNDO /REDO

Mistakes happen! Itis all too easy to perhaps delete characters you do not really want
to delete or make changes and then change your mind about them. MSWord gives us a
quick and easy way to correct our mistakes using the Undo and Redo icons.

TO UNDO THE LAST CHANGE THAT YOU HAVE MADE

1. Click the Undo icon on the standard toolbar. KD

NOTE: MSWord remembers up to 29 changes that you have made to your document.
To view them click on the drop-down list of the Redo / Undo icon and a menu will
appear showing the sequence of Redo / Undo activities you have done. Select the
appropriate action to undo.

TO REDO THE LAST CHANGE THAT YOU HAVE MADE

If you undo something and then change your mind, you can use Redo to reverse the
Undo action:

1. Click the Redo icon on the standard toolbar. u
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TUTORIAL B2.1.

1. Open the document PARTY1 that was saved in tutorial B1.2.
2. Type the following just below Dear Molehe:

The theme of the party is traditional wear. My cousin has a shop in Liberty Center which
sells traditional clothing.

Please contact her at this number: 057 - 353 2222.
The prices range from R 100.00 to R 3000.00.

3. Move the paragraph you have just typed to directly above the sentence “See you at
my party!!”

4. Copy the same paragraph at the end of your document.
5. Click on the UNDO icon to undo the copy action.

6. Save the document as PARTY2.
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CHAFIEK B3

OUTCOMES OF THIS CHAPTER ARE TO BE ABLE TO:
e Format text by changing font styles and sizes

e Format text by justifying it

¢ Print a document

FORMATTING
Formatting is the process of adjusting the appearance of a document. You can format
an entire document, several paragraphs, one paragraph or a single word.

Formatting text includes activities like displaying text in boldface, italics,underlining

words, and changing the size and fonts of text. The user can format text that has

already been typed or format text as it is typed.

» To format existing text, you first select it and then select the formatting options you
want.

» To format text as you type, first select the formatting option you want, then type the
text and then turn the formatting options off.

TO FORMAT EXISTING TEXT USING THE FORMAT MENU
1. Select or highlight the text you want to format.

2 Click on the Format menu.

. Click Font, and the following dialog box will appear:

Font | Character Spacing | Animation |

Eont: Font styvie: Size:
lm lﬂ.'uular 10
721 BIkEx BT - -
iy = HE -
'homaat o ﬂnaﬂ:
= -] .

Underline: Color:
[tnone) =] Il Ao i |
Effocts — — —— — —— R e
™ Striksthrough ™ Shadow ™ Small caps

™ Double striksthrough ™ Qutline ™ all caps

™ Supsrscript I~ Emboss ™ Hidden

™ Subscript ] ave
Preview ————— = s e ————
- Times New Roman [
Thiz s a TrueType font. This font will be used on bath printer and tcreen.

In the dialog box, one will see the different formatting options available:

» different types of fonts and their respective available sizes

» different appearance styles such as boldface, underlining, italics, shadow,
strikeout and even a combination of all

» adrop-down menu for underline featuring different styles of underlining
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» different effects i.e. superscnipt © - (use. x“+ x + 1) and subscript sypscript (US€!
H.0)
» color options, which allow you to change the colour of your text.

Instead of working through the Format menu, the user can format text by using the
formatting toolbar.

”Normai ~ Arial - 12 vi B I U H—E_E ==

EEEE| -
The following options are available on this toolbar:

CHANGING FONTS USING THE FORMATTING TOOLBAR
; Select / highlight the text which font you wish to change.
2. Click on the Fonts drop-down button on the Formatting =, . =

toolbar: f

Click here

3. A drop-down list with a number of fonts appears:
il =12 =

-~
!AbadMTCondensedl.id‘ul:"'
& Albertus Extra Bold f—
& Albertus Medium
& Antique Olive

4. Click on the font you want to select.

CHANGING THE SIZE OF FONTS USING THE FORMATTING TOOLBAR

s Select / highlight the text which size you wish to change. 12 - |
2. Click the Size drop-down button on the Formatting /
Toolbar.
Click here

3. This will give you a drop-down list with a list of sizes.

o -

¢ N

9

10 =

11

14

16

18

20

22

24

P3|
4, Click on the font size you want.
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CHANGING THE COLOUR OF TEXT USING THE FORMATTING TOOLBAR
y Highlight the text that you wish to change.
2. Click on the Font color drop-down icon on the Formatting A -
Toolbar. This will give you a drop down list with colours:
T el S
(M Automatic I
EREENEEER
OCmMCONEEN |

3. Click on the colour you want to select.

CHANGING THE APPEARANCE OF TEXT USING THE FORMATTING TOOLBAR
B I U

I | I
Bold /talic Underline

Select / highlight the text that you wish to change the appearance of.
2 Click on the appropriate icon according to what you wish to select i.e.
Bold, /talicor Underline.

—

JUSTIFICATION

Justification, sometimes called alignment, is an option which allows you to specify
how your text should be aligned with respect to the left and right margins. There are
four justification options i.e. Left, Centre, Right, and Full Justification.

> Left Justification = allows text to form a straight line with the left
margin, whilst the right margin is uneven.

» Right Justification = allows text to form a straight line with the right
margin, whilst the left margin is uneven.

» Centre Justification centres the text between the left and right
margins, with uneven left and right margins.

=
» Full Justification - aligns text along both the left and right margins.
Extra spaces are added when necessary to make the text aligned fully. This
option does not affect the last line of a paragraph.
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TO JUSTIFY TEXT USING THE FORMA I I1ING TOOLBAR

I I I I
Left Centre Right Full Justification

1. Move the cursor to a point in the paragraph / sentence where you want the
justification to take place.
2. Click on the Justification icon desired on the Formatting Toolbar for the type

of justification you require.

TUTORIAL B3.1
1. Open the file PARTY2 that was saved in CHAPTER B2.
2. Change the appearance of the word “Molehe” to a Boldface.
3. Change the appearance of the word “Mantsho” to /falic.
4, Underline the phrase “Liberty Center”.
5. Change the phrase “Traditional wear” to any other font.
6. Right justify the date at the beginning of your document.
7. Centre the sentence “See you at my party!!”
8. Change the word “Dingi” to 20 points and the colour to green.

9. Save the file as PARTY3.
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PRINTING

Printing involves an activity which enables a user to obtain hard copy or paper copy
of the document you are busy with. In MSWord a document can be printed at any
time though it is more efficient and convenient to print a document after you have

finished writing, editing, formatting and saving it.

TO PRINT A DOCUMENT
1 Click on the Print icon on the Standard Tool Bar
OR

2. Click on the File menu and then on Print. The following dialog box appears:

VO"BT-O: WWLACOSLAB_P2
Comment:

~Page range 1
& al

€ Currgnt page s of |
C pages: | 1

Enter page numbers andjor page ranges
separated by commas., Foroxcnplu 1,3,5-12

@lﬁlpm

Print what: [Docu'nent

|All pages in range

Lo« 1]

|

Cose |

The dialog box features certain options including:

All which will print all the pages in the document.

»

» Current Page which will print the page in which thie cursor currently is.

» Pages which allows the user to specify which pages should be printed i.e.
10-15. The page numbers must be typed into the box provided.

» Selection will only print the text that is highlighted in the document.

» Number of Copies allows the user to specify the number of copies to be

printed.

3. Select the desired option, then click on OK.

NOTE: Advanced printing options are discussed in more details in CHAPTER BS5.

TUTORIAL B3.2
1. Print the document PARTY3.
2. Close the file.

3 Exit MSWord.

B21

© Central University of Technology, Free State



0 SECTION B: MS Word

Central University of
Technology, Free State

vrnAricrs B4

OUTCOMES OF THIS CHAPTER ARE TO BE ABLE TO:
Change page view

Change line spacing

Insert page numbers to documents

Change page margins

Insert headers, footers and footnotes

PAGE FORMATTING
PAGE VIEW

» The user can change the way that pages are set up and displayed in MSWord. The
default page layout or setup in MSWord is normally the Portrait view. This
orientation displays and prints text parallel to the short side of a page.

1)

» Page view can also be changed to Landscape, depending on a need to do so. This
orientation displays and prints text parallel to the long edge, making the printed,
page wider than long.

il

The user can change the paper orientation for the entire document or for a selected
portion only.

TO CHANGE THE PAGE ORIENTATION
1. Click on File menu.

2. Click on Page Setup.
3. Click on Paper Size tab. The following dialog box will appear:
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Page Setup kd E3 I

Margins  Paper Jize | Paper Source I Layout I

Paper size: —Preview
Letber (2 15w 11 in)
width: |8.5" = ———
Height: f11" | —
ientation —
& Portraijt e
A ~ Landscape
apply to: |Whole document EI
Default... | ok | cancel
4, Leave the Paper Size as it is.
5. Click on Landscape under Orientation to select the new orientation.
6. Click on OK.
LINE SPACING

MSWord automatically sets the document to single spacing between lines. It might
sometimes be preferable to double space or even triple space the document lines. The

spacing can be set for the whole document or for selected text only.

TO CHANGE LINE SPACING
1.
paragraph you want to double space.
p Click on the Format menu.
3.

B 23

Move to the beginning of the document you want to double space or select the

Click on Paragraph. The following dialog box will appear:
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| Paragraph

Indents and Spacing | Line and Page Breaks |

Alignment: FET— | Qutiine level:  [Level1 v |
Indentation

Left: fo" | Special: By:

Right: |o* | jHangng  ¥] fos* &
Spacing
N L T
© ARer: [3ap = [Mutiple =] f12 £
Preview

4. Click on Indents and Spacing.
5. Click on the Line Spacing drop-down list and select the desired line spacing.
6. Click OK.

PAGE NUMBERING

Page numbering allows a user to insert page numbers at different positions of a page.
You can number your document from its very beginning or from a different positioni.e.
if necessary, make the second page Page 1.

TO NUMBER PAGES

1. Move the cursor to the page where you want numbering to start.
2, Click on the Insert menu.

3. Click on Page Numbers. A dialog box will appear:

Page Numbers 7] x|
Postion: [y e— |
Eoe mE—
Hpmer: —
& =] |
W Show number on first page - “
[x ] cod | _eoma.

B2
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4 Click on the Position drop-down list and select the position of the page
numbers.
5. Click on the Alignment drop-down list and select the required alignment.
6. The format of the numbers could be specified by clicking on Format:
Page Numhber Format
Number format:
I™ “Include chapter pumber
Chapter starts with style
Use separator:
Examplas:  1-1, 1-A
Page numbering
£ Continue from previous section
C Start at: I 5‘
oK cancel |
7. Select the required format under Number format.
8. If necessary, the starting value of the pages could be changed by specifying the
correct number in the Start at box.
9. Click OK. This will return to the Page Numbers dialog box.
10. Click OK.
PAGE MARGINS

Margins are the borders on all four sides of a page, where the text is confined in. The
top, bottom, right, or left margins can be changed. Before you make any changes to
your document margins, you must remember that all changes in MSWord apply to
either selected text or the position in the document where the cursor is situated. If you
want your margins to change the entire document, you must move your cursor to the
beginning of the document or page you want to format.

TO CHANGE PAGE MARGINS

1 Click on the File menu.

2. Click on Page Setup.

3. Click on Margins.

4, In the Top, Bottom, Left and Right text boxes, enter the desired margin size or

4

click the increment arrows to set the desired value.
Click on OK.
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CHANGING THE MARGIN SETTINGS ON THE RULER

Instead of using the menu, the user can change margins using the Ruler. This can only
be done when working in Page Layout view (click View menu and then select Page
Layout). In the Page Layout view, MSWord displays both a horizontal ruler at the top
of the document page and a vertical ruler on the left edge of the document page.

Left margin line Right margin line

Top margin line

2
L <
= ¥
UL BEIKE| | »
TO CHANGE MARGINS USING THE RULER
1. Place the mouse pointer on the ruler at the margin line that you wish to change.
2. Move the mouse pointer around slightly, until you see it change into a double-
sided arrow. <P
3. Click on the left mouse button and drag the mouse until the desired new location

for the margin is obtained. Whilst dragging you will notice a black dotted line
following the double-headed arrow. This line indicates where the margin will be
positioned, should you let go the mouse button at that time.

4. Release the mouse button when you have reached the desired margin setting.

NOTE: The grey areas on the left and right sides of the Horizontal Ruler and at the top
and bottom of the Vertical ruler indicate the margin settings.
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TUTORIAL B4.1

i Open the file PARTY3 created in CHAPTER 3.

2. Change the page orientation to Landscape.

3. Change the line spacing from single to 1.5 for the whole document.

4. Insert page numbers at the bottom right of each page.

5. Insert a centre justified header which reads “PARTY!!!PARTY!!!IIPARTY!!!”
6. Re-adjust the margins to make your document narrower.

7. Save the document as PARTY4.

HEADERS AND FOOTERS
Pages of a long document can easily get separated. They can get out of order or be

misplaced. Headers and Footers help to identify the pages of your document, as well as
the document itself.

» A Header is text that is displayed and / or printed at the top of every page.
» A Footer is text that is displayed and / or printed at the bottom of every page.

Two common uses of headers and footers are for page numbering and to repeat the
document’s title on each page. (ltis not necessary to have headers or footers if all you
want to do is number your pages. See section 3.3 for page numbering.)

TO CREATE A HEADER OR FOOTER

% Move the cursor to the page where you want to insert the header or footer.

2. Click on the View menu.

3. Click on Header and Footer. MSWord displays the current page’'s header
enclosed in a non-printing dashed line. The Header and Footer toolbar appears,
and regular document text is dimmed:

Header and Footer

Insert AutoText + |@E|m®|ﬂ%|l§ﬁﬁﬂm

Switch button
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4. Select Header or Footer by clicking on the Switch button on the Header and
Footer toolbar. Type the text for the header or footer.
5. Click on Close on the Header and Footer toolbar.

NOTE: To discontinue an already existing header or footer, you follow the above steps
and instead of typing text at step 5, delete all information from the Header or Footer.

FOOTNOTES

» Footnotes provide references for text or paragraphs in a document. The process of
creating footnotes involves inserting a number as a note reference and then typing
the text (which refers to the number) at the bottom of the document. The footnote
appears at the bottom of the page where it has been inserted. An example is’.

» Endnotes are more or less the same as footnotes. Unlike footnotes which appearin
a page were you have inserted them, endnotes appear right at the end of the
document.

TO INSERT A FOOTNOTE / ENDNOTE

i Place the cursor where you want to insert the footnote.
= Click on the Insert menu.

3. Click on Footnote. A dialog box appears:

Footnote and Endnote Ed |

Insert
 §ootnote! Bottom of page
" Endnote End of document
Numbering
% AutoNumber Y. 2,8, {
€ Custom mark: | :

Symbol... I

'Example of an Footnote
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Select Footnote to create a footnote
OR
Select Endnote to create an endnote.

An appropriate number will be inserted in your document and your cursor will
move to the bottom of your page, where you can type in the reference.

Click on the position inside the document where you want to continue typing.

TUTORIAL B4.2

Work with the document PARTY4.

1.

Insert a left justified footer which reads “The best party of the year”. Change the
point to 16 points.

Next to contact number for confirming attendance, insert a footnote which read
RSVP.

Save the document as PARTYS.
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CHAFIEK B

OUTCOMES OF THIS CHAPTER ARE TO BE ABLE TO:
Use the spell checker

Use the thesaurus

Use the find and replace feature

Use advanced printing options

THE SPELL CHECKER

MSWord'’s spell checker is an indispensable tool that you can use to correct spelling
errors and other typing mistakes. If you misspell a word the spell checker will offer a list
of possible corrections from a dictionary file contained in Word. Words that are
unknown are flagged. The user can then ignore it, correct it, or add it to the dictionary.

Spell checkers cannot detect language usage problems. They will not recognize a
problem if for example, a sentence reads “They room is cold” in stead of “The room is
cold”. Further remember that the spell checker questions only the words that do not
match a word in MSWord's dictionary.

TO SPELL CHECK A DOCUMENT

1. Move the cursor to the beginning of the document. E:J
2. Click the Spelling and Grammar icon on the Standard tool bar. A dialog box
similar to the following will appear:

Spelling and Grammar: English [United Kingdom)

Not in Dictionary;
When you just can=t think of the correct ﬂ [__wore |
word to use, make use of the thesaurus.

can't

Fa changedl |

EJJ ™ Check grammar Options. .. I Linda l Cancel |

3. Take ONE of the following actions to respond:

» Click on the correct spelling in the Suggestions list and click on Change.
» To correct the word manually, edit it in the Not in Dictionary list box, and
then click on the Change button.
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To replace all instanc.. .. ..< wev.< .. .he document with either the manual

correction you have made or the word which you have selected from the
Suggestions box, click the Change All button.
To ignore the word, click on the ignore button.

To ignore this and all other instances of the word in the document, click the
Ignore All button.
To add the word to the MS-Word dictionary, click on the Add button.

4. When the Spelling and Grammar is complete, click on OK to return to your
document.

TO SPELL CHECK A WORD OR A PART OF A DOCUMENT

1.  Select / highlight the word or part of the document that has to be spell checked.
2. Follow steps 2 - 5 as described above.

THE THESAURUS
The Thesaurus can be used when the user just can't think of the correct word to use.

The Thesaurus displays a list of synonyms (words that are written differently but have
similar meaning).

TO VIEW A LIST OF SYNONYMS FOR A WORD

4 00! hyrex

Move the cursor inside the word whose synonyms you want to view.
Click on the Tools menu.

Click on Language.

Click on Thesaurus. The Thesaurus dialog box appears:

Thesaurus: English [British])

Looked Up: Replace with Synonym:
_Irneat ;l janimal Flesh

[ -
Replace I :m Previous J Cancel l

5. Toreplace the word in the document with a synonym, highlight the desired word in
the list and select Replace. The word will be replaced.
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TUTORIAL B5.1
1.  Open the file PARTY5 which you have saved in CHAPTER 4.
2.  Spell check the whole document.
3. Use the thesaurus to replace the word “shop” with “boutique”.

4. Save the document as PARTY®6.

THE FIND-AND-REPLACE FEATURE
The Find-and-Replace feature of MSWord can be a real time saver.

» The Find option can be used to locate the exact position of a word / text. Instead of
scrolling through the entire document MSWord can locate the word and move the
cursor to the exact position.

» The Replace part of the command allows the user to replace the word or text
located. This means that you can easily correct an error in several locations, or
change a specific word to another word at every position it occurs.

TO FIND AND REPLACE TEXT
1.  Click on the Edit menu.
2. Click on Replace. A dialog box appears:

I i e e e 7] | l
Fnd  Reglce | GoTo |
i e
I Concsl |
| SR 2| e |
Replace Al 1
_Mres |

Type the word you want to find in the Find what box.

Type the word you want to replace in the Replace with box.

Click on Replace to replace one occurrence of the word, or choose Replace All
to immediately replace all occurrences of that word in a document.

6. Click Cancel when finished.

O b o
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ADVANCED PRINTING OF 11urvo
To print a document the user can simply click on the Print icon and press Enter.

8

There are, however, a number of different printing options which could be selected
from:

PRINTING SELECTED PAGES ONLY
1.  Click on the Print icon on the Standard Toolbar.
2. The Print dialog box appears and different options are available:

Name:
Status:

where:

~Page range
= ol meﬂfw R |

" Current page € Selection

¢ Pages: |  cCollate
Enter page numbers andfor page ranges L
supnrat-dbv:m For example, 135—12

Print whak: IDo::\.mnt IAI pages in range El

options... | otow ] cose |

» To print the current page only, click on Current Page.
» To print selected pages, click on Pages under Page Range. The pages you
will be entering should be separated by a comma, i.e.
type 4 to print only page 4
type 4,6,8 to print pages 4,6, and 8
type 4-6 to print pages 4 to 6
type 4-6,8 to print pages 4 to 6 and 8

3. Click on OK.

NOTE: If you want to print selected text instead of selected pages, just select the text
you want to print, click on the Print button and then click on OK.

PRINTING MULTIPLE (MORE THAN ONE) COPIES

Click on the Print icon on the Standard Toolbar.
The Print dialog box similar to the one shown above.
Click in the Number of copies box.

Type the number of copies you want to be printed.
Click on OK.

o1 00 1) =
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TUTORIAL B5.2

Work with the document PARTY6

1.

2.

Open the file PARTY®6 saved in TUTORIAL B5.1.

Use the Find - and - Replace feature to find all instances of the word “party” and
replace them with the word “bash”.

Use the print-option to print 3 copies of the document.

Save the file as PARTY?7.
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CHAFIEK B6

OUTCOMES OF THIS CHAPTER ARE TO BE ABLE TO:
e Create & edit tables
e Insert graphics in a document

CREATING AND EDITING TABLES

A table consists of a set of rows and columns. Columns are vertical whilst rows are
horizontal. The rows and columns intersect to form boxes called cells. Text are typed
into the cells. In the diagram below, the set of “Cs” represents columns while the set of
“‘Rs” represents rows. “RC” is the cell, i.e. the position where a row and a column
intersect.

C
R RC R R R
C
TO CREATE A TABLE
: Click on the Table menu.
2 Click on Insert table. A dialog box similar to the following appears:
Insert Table ——_ EAE3|
Number of columns: IE —| [ oK I
Number of rows: |2 = Cancel |
Column width: |auto —- | AutoFormat. .. I

Table format: {none)

3. Click in the Number of columns box and type the required number of columns
you want in the table.
4, Click in the Number of rows box and type the required number of rows you
want in the table.
5. Click OK.
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It is possible to add extra rows and / or columns after a table has been created.

2
3.

Select the row or column of cells next to the location in the table where you want
to add / insert a new row or column.

Click on the Table menu.

Click on Insert Cells. The following dialog box appears:

Insert Cells k4 E3

€ shift cells right

= Shift cells down}

¢ Insert entire row

¢ Insert entire column

oK 1 Cancel I

Click on
> Insert entire row if you want to insert a row
OR
» Insert entire column if you want to insert a column.
Click OK.

TO DELETE ROWS AND / OR COLUMNS
It is possible to delete extra rows and / or columns after a table has been created.

1.
2.
3.

Select the row or column of cells in the table where you want to delete.
Click on the Table menu.
Click on Delete Cells. The following dialog box appears:

Delete Cells 2| X

" Delete entire row
" Delete entire column

OK Cancel I

Click on
» Delete entire row if you want to delete a row
OR
» Delete entire column if you want to delete a column.
Click OK.
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GRAPHICS

In most Word Processing software, graphics such as clip art images and drawings can
be inserted into a document. The user can insert clipart (pictures) from other
applications or from Word or create own drawings by using a Drawing Toolbar.

When an image is inserted, it appears in a graphics box at the insertion point (where
your cursor is positioned). The user can then use the mouse to:

» change the size of the graphic

» move the graphic

» change the appearance of the image.

TO INSERT AN IMAGE

1. Position the cursor where you want the image to appear.

2. Click on the Insert menu.

3. Click on Picture.

4 Click on Clip Art (If a message box titled Cannot open Previews File appears,
click the OK button until it disappears. Click on the Clip Art tab on The
Microsoft Clip Gallery 3.0.)

W £ ) S €1R) ¢ 2|2 o)1=
!j@ﬂ ]‘x Miciosolt Clip Gallery 3.0 X
.]@
L A -
£
)
Etil:m_l Ciip Propesties... I I @ [
slofs Ci At Kepwords: Rlewasd Accamlishment Misione Guarantse >
| Draw- %
|Page ¢  Sec 2 45 (A3 1n9 Col21 I“p"f[wn il e T e

Hsia| @S BA YD || BPooss.| Whicos. | e |[Fiwer | EING B 12397
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5. Scroll through the list Of yiap nee e e categories to find the graphic you

want.
Click the graphic you want to insert in the document.
Click OK.

e

TUTORIAL B6.1

Design the following poster and save it with the name POSTER.

NOTICE

THERE WILL BE DOCTORS FROM CUBA VISITING OUR COMMUNITY. EVERYONE
IS WELCOME TO ATTEND!!!

DATE 3/5/2000

TIME 18HO0

VENUE THABONG COMMUNITY HALL
ADMISSION FREE

PLEASE COME PREPARED AS THEY WILL BE ANSWERING ANY QUESTIONS
THAT YOU HAVE CONCERNING THE NEEDS OF OUR COMMUNITY.

BY ORDER

The Manager
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OUTCOMES OF THIS CHAPTER ARE TO BE ABLE TO:
e Create a data source file

e Create a main document file

e Perform mail merge

MAIL MERGE

Mail merging is a feature of MSWord used to mass produce letters, mailing labels,
memos and other documents. Mail merging consists out of creating two different kinds
of files and then merging them to produce one new file which contains several printed
copies of the main document.

» The main document is the letter, memo, mailing lable or other document that has to
be sent to different individuals.

» The data source is a database containing records with information like names and
addresses of the people you want to send the letters to.

» The merge process produces a new file with several copies of the main document
where each copy contains specific information from records in the data source.

For example, to write the same letter to a number of people without typing the original
letter more than once, you can create the main document (the letter) and a data source
(address file). Then merge the two files to create multiple copies of the original letter.
The text will be the same for each printed letter, but the names and addresses will
differ.

PERFORMING MAIL MERGE BY CREATING NEW DOCUMENTS

As explained, before mail merge can take place, the user must create TWO different
documents. The Mail Merge Helper guides the user in setting up the documents
required and performing the mail merge.

TO CREATE A MAIN DOCUMENT

Click on the Tools menu.

Click on Mail Merge.

Click on Create.

Click on Form Letters.

Click on New Main Document to work on a new document.

St

@ mmhfmhﬂns.ﬂmmmmmm

lesson7-modified or a new

[—y L
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OUTCOMES OF THIS CHAPTER ARE TO BE ABLE TO:
o Create a data source file

e (Create a main document file

e Perform mail merge

MAIL MERGE

Mail merging is a feature of MSWord used to mass produce letters, mailing labels,
memos and other documents. Mail merging consists out of creating two different kinds
of files and then merging them to produce one new file which contains several printed
copies of the main document.

» The main document is the letter, memo, mailing lable or other document that has to
be sent to different individuals.

» The data source is a database containing records with information like names and
addresses of the people you want to send the letters to.

» The merge process produces a new file with several copies of the main document
where each copy contains specific information from records in the data source.

For example, to write the same letter to a number of people without typing the original
letter more than once, you can create the main document (the letter) and a data source
(address file). Then merge the two files to create multiple copies of the original letter.
The text will be the same for each printed letter, but the names and addresses will
differ.

PERFORMING MAIL MERGE BY CREATING NEW DOCUMENTS

As explained, before mail merge can take place, the user must create TWO different
documents. The Mail Merge Helper guides the user in setting up the documents
required and performing the mail merge.

TO CREATE A MAIN DOCUMENT

Click on the Tools menu.

Click on Mail Merge.

Click on Create.

Click on Form Letters.

Click on New Main Document to work on a new document.

hWh -

9} Tocreats the form letters, you can use the active document window

« lesson7-modified or & new document window,

L S

B 39

© Central University of Technology, Free State



Q SECTION B: MS Word

Central University of
TO CREATE A DATASOURCE _ ___..._...

Technology, Free State
1. With the Mail Merge Helper dialog box still open, click on Get Data.
2. Select Create Data Source from the drop-down list that appears.

Mail Merge Helper EdE3
immmmm&qmﬁnmdmktospﬁyad&am. ;
|C|'|omeﬂ1eGutD&abmhm.
]$Mmdou.nmt

gowe~ | - |

Merge type: Form Letters
Main documant: Document2

2% Data source

_ Concel |

Create Data Source EdE3 |

A mail merge data source is composed of rows of data, The first row is called the
header row. Each of the columns in the header row begins with a field name,

Word provides commonly used field names in the list below. You can add or remove
field names to customize the header row.

Eield name: Field pames in header row:

fl

Add Figld Name »» ’

Remoave Field Name J

M5 Query. .. ] OK Cancel |

3. MSWord gives a list of fields commonly used when creating data records.

The user can decide to use these fields as they are given or to remove the
fields you don’t want to include in your data.
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» To remove a field, selcut uial speuing neld and then click on Remove
Field Name.

» To add a field that does not appear on the list, type the field name in the
Field Name box and then click on the Add Field Name button.

Click OK.

Type a name for the data source in the Save Data Source dialog box.

After assigning the name, click OK. MSWord displays the following dialog

box.

Microsoft Word E3 l

r-’:,* The data source you just created contains no data records. You can add new records
_*_/ o your data source by choosing the Edit Data Source button, or add merge fields to
your main document by choosing the Edit Main Document button.

Click Edit Data Source to display the following dialog box, where you begin
entering records in the data source.

Data Form ﬂ[ﬂ
FirstName: I ﬂ K |
LastName: mﬁm l
Company!:

Address1: Dolete l
Restors |
End |
view Source |
=
Record: NI!II blﬂl

Type the information you want to save into the different fields.
Click Add New to add a new record.
Click OK to close the dialog box and return to creating the main document.

COMPLETING THE MAIN DOCUMENT

The Main Document is created after a Data Source has been created as the main
document refers to fields in the data source file. The Main Document can be made up of
text, graphics and merged codes. The text and graphics in the document will be printed
exactly as given but at the position of the merged codes, data will be extracted from the
data source file.
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The following is the merge tool k...

View me[ged data Clheck for errors

| Insert Merge Fekd + | Insert wordFeld» | 50| 14 4 1| o1 B D %5000 Gy el

Merge to New Document

1 Type the text you want and insert the graphics into the main document.

2, To refer to a field from a data source, click on the Insert Merge Field icon from
the Mail Merge tool bar.

3. Click on the field name you want to insert in the document from the drop-down

list.

4. Repeat steps 9 and 10 as often as you need to place the fields where you want
them to be.

5. Save the main document.

NOTE: Once the Main document and Data source document has been created, the
user can proceed with the merge.

PERFORMING A MERGE
; Click the Check For Errors button to display these options on the Mail merge
tool bar.

Checking and Reporting Errors

€ Simulate the merge and report errars in a new document,
& ‘Complete the merge, pausing to report each error as it occurs. |
" Complete the merge without pausing. Report errors in a new document.

[ox ] conel |

2. Click the Merge To new Document button. MSWord will open a new document
window called Form Letters 1 and then print all copies of the letters to that
document. There will be a section break (page break) between each letter.

3. Now print the document Form Letters 1. Multiple copies of the original main
document will be printed.

4. Use the Save As option to save the document Form Letters 1 by giving it a
new name.

PERFORMING MAILMERGE BY USING PREVIOUSLY CREATED
DOCUMENTS

It is not always necessary to create completely new documents when performing a mail
merge. The user can set up one data source document, create several different main
documents and then merge data whenever required.
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TO PERFORM MAIL MERGE WITH EXISTING DOCUMENTS
1. Open the Main document.

2, Click on the Tools menu.

3. Click on Mail merge.

goate~ | - |
Mergs type: Form Letters
Main document: D:\eucmanualiDocument4,doc

2 e T
Ceome ] e~ |

% QOpen Data Source. ..
3 Use ddress Bock... I

Options in effect:
Suppress Blank Lines in Addresses

Click on Get Data.

Click on Open Data Source.

Click on the name of the data source document.
Click on Merge in the Mail Merge Helper .

N oA

7

Metge to: Merge
ErE———] o | %

to be merged e ————————]
ca Cgem | Ip:l—‘ Ok

Query Options.

~When merging records
& pon't print blank lines when data fields are empty.
€ Print blank lines when data fields are empty.

No query options have been set.

8. Select the options required from the dialog box (usually it will be to a new
document).

9. Click on Merge.
10. The new file with copies of the main document will be created.
11.  Print the merged file.
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TUTORIAL B7.1
Perform a printed mail merge using the following two documents:

Main document

STUDENT RECORDS

Dear ..........

According to our records, your accountis in arrears. Please come and pay the amount
due shown below before .........

Amount due: ......
Yours sincerely

{Type your name & surname here} - Principal

Data source document

Title FirstName Surname StudNum Amount due
Miss Rose Hakuta 98001 R 100.00
Mr Masana Pawula 98002 R 212.00
Mr Walter Leshoma 98003 R 315.00
Mr Irvin Riet 98004 R 419.00
Miss Lerato Khalema 98005 R 154.00
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CHAPTER C1

OUTCOMES OF THIS CHAPTER ARE TO BE ABLE TO:
Start Windows 95

Identify the different parts of the Windows 95 screen

Shut down Windows 95

Activate program applications in Windows 95

Use certain facilities in Windows Explorer

Open Windows 95 accessories

INTRODUCTION TO WINDOWS 95

WHAT IS WINDOWS 957

Windows 95 is classified as system software (also called an operating system).
System software are computer programs that controls the functioning of a
computer. In a way it helps the user organise the work done with your PC. The most
obvious part of Windows is the graphical user interface i.e. the colourful screen and
the pictures called icons. Once you have learned how to move the mouse pointer
around the screen, Windows enables you to perform most tasks by pointing at an
icon and clicking a button. By clicking on the icon, the user actually tells Windows to
get to work on his / her behalf. Behind the scenes, beneath the surface and just out
of sight, Windows then acts as your personal executive staff, complete with the PC
equivalent of file clerks, messengers, switchboard operators, administrative
assistants, and a full-time maintenance crew. Best of all, you're the boss; every time
you tap a key or click the mouse, the staff swing into action to carry out your
requests.

WHY USE AN OPERATING SYSTEM?

Imagine how chaotic an office would be without an office manager. Well without an
operation system, things inside a PC gets just as disorganised. The Windows
operating system is there to act as a ruthlessly efficient office manager. Windows
knows every part of your PC, inside and out, so it can send your work to the right
place. (When you ask your PC to print a file, you want it to go to the printer and not
the trash can, right? That's the operating system's job.) It also knows all the rules for
storing and retrieving files, so you can find your work without a lot of hassle. In fact,
it controls every move that takes place inside the computer.

The icons and menus in Windows make it easy for the user to ask your PC to do
some work but the operating system is the actual part that performs the instructions.

C1
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WHAT IS AN ACRONYM?
An acronym is an abbreviation that is commonly used as a full word in computer
language. Examples of acronyms are:

» SCSI (Small Computer System Interface)
» GUI (Graphical User Interface)
» LAN (Local Area Network).

WHAT IS A GUI?
Pronounced “gooey” the acronym stands for the most obvious part of Windows
namely its Graphical User Interface.

A user interface is simply the way that the user communicates with a machine. Most
machines have some type of user interface i.e. a microwave oven's control knobs,
the 12 buttons on the telephone, etc. We need an interface because the user has to
be able to tell the machine / computer to perform certain instructions. You don't
really need to know much about your computer’s operating system - just what kind
you have and how you can get it to do what you want it to do!

Some operating systems use a command-line interface, where you type commands
at the computer's keyboard (and it beeps back at you when you type a command
wrongly). Windows is much easier to use because it allows the user to tell the
computer what to do by pointing at pictures on the screen. There is no need to
memorise a whole manual full of commands — simply point at what you want and
click the mouse button.

GUIs are powerful, but they only work on powerful computers with large RAM and
disk space. Command-line interfaces, like DOS, are powerful, too, but the average
computer user find them harder to use. That's why GUIs are rapidly showing up
everywhere and has become the standard user interface for cable TV boxes, in
cars, even on refrigerators and washing machines!

SMS-DOS Prompt

[ Aawe =1 Clloslm| 5| == A

The command-line interface of DOS
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Greetings
Workshop

Asan| E SV | By Microsoh word - W [[F untitied - Paimt |\ b 2 11:39 A

I
(Start button) The graphical user interface of Windows 95

THE DESKTOP

Because there are so many ways to set up the Windows 95 desktop, the screen
shown above is only one example of what you might see when working in Windows
95. It is clear to see the graphical user interface that consists of icons. The exact
icons that will appear on a specific user's screen, depends on the programs that are
used. There are however some standard icons that appear on most Windows 95
setup screens. Two of these icons are:

My Computer

An icon which leads to more information on how the computer is
set up.

Recycle Bin . . i i
An icon which leads to a list of items that has been deleted.

Cc3
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THE START BUTTON 9 Start I‘

At the bottom of the Windows 95 screen you can see the fask bar. At the far right of
the bar you can see the current time. At the far left, you can see the START button.
(This is where everything in Windows 95 starts.)

When an application has been activated in Windows, the program’s name will
appear in the Task Bar indicated by a small icon of the program. When more than
one application is active, the user can click on the icon in the task bar to switch from
one application to another.

TO ACTIVATE A PROGRAM
1. Click on the Start button.

L

E Open Office Document

2. Move the mouse over Programs.
| Documents
() Kik & Py
| Logtech Senteware
[ Miciosoh Muimedia
2] Microsch DDBC
) Micsosoh Offics
= Mictosch Publsher 20
(] OLE 201 Tookk
] Programs
2] Sound Blaste: 16
2 Stantlip
L&) System Programmes
(] System Tools
{8 MsDOS Prompt
=] The Microsolt Netwark

v ¥ P Y T YT VYT ET YT ETYT YTV

3. Click on the program that you want to activate.
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8

My Computer

=

Dosdisk (C)

Compressed (E) Audio CD (H)

£
Dial-Up
Networking

Printers

=
Ms windows (D)

D &

Control Panel

8 object(s) I

7~

This is My Computer
the place to turn
when you want to
find a file, setup a
printer or change
your PC’s settings.

Each icon leads to something in your computer setup that can be explored further.
The icons indicating letters A:, C:;, D:, etc. indicate disks where information can be

stored.

If you click on the icon that looks like a hard disk (C:), you will get a window similar

to the following:

mDosdiek (] - =
fie Edt Yiew Help
[ = Dosdik (€) =] Bl tlw| 3(ml@] o X
ion25, CtTve o] Corfig.sys Msdmm
Cvge =] Config.vgd 2] Netlog
(2 Windows ] Config win ] Path.edc
] Aacgecen Dbispace.bin ¥ Qed
[Slauto Dblspace 8] Scandisk.log
Flauwol &) Deting @) Setuplag
%] Autoesec [&1Dire #] Suhdiog.dat
s8] Autoenec.dos %Dim ] System. 1st
(] autoexec. old 8] Drvspace bin ] Track01.cda
] Bootlog.prv | Eadata. sf &) W roat. of
@] Bootlog 4] lo.dos
™ command ] lo.sps
|#] Command dos #] Lipro.tre
%] Conf.sys Lotus 1-2-3 Manual
Suegnet se foldsr | %] Confl.sys M Lotus
] Canfig.dos %mm-—-
|] Canfig.spd ] Msdos.dos
[10.4MB 0
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The name of the drive (C:) is at the top of this window. This is also the name that
appears at the bottom of the screen in the Task Bar. We will later look at the icons
and menu commands. The list of names displayed can be either files or folders.

» Information is saved in the form of files on disk. Each file has a unique filename.

> The computer’s disks can be divided into different sections, called folders. A
folder is like a drawer that you can put (save) your files in. The folders are
indicated by yellow icons.

NETWORK NEIGHBORHOOD ICON

The Network Neighborhood icon is only active when you work on a computer where
Windows 95 is connected to a network. In Network Neighborhood you can connect
to other computers on your network or you can chat with users connected to the
same network.

INBOX ICON

This icon leads to the Microsoft Exchange program that allows you to receive faxes
or electronic mail. To be able to use this program, you will have to have a modem
connected to your PC.

MY BRIEFCASE ICON

If you have a laptop (portable computer) and want to work on files at home or while
travelling, you can use Briefcase to help keep the various copies of the files
updated. To use Briefcase, files are dragged from shared folders on the main
computer to the Briefcase icon on the portable computer. When finished working on
the files on the portable computer, reconnect to the main computer, and then click
Update All in Briefcase to automatically replace the unmodified files on your main
computer with the modified files in your Briefcase.

The files on your main computer are automatically revised; you do not need to move
the files you worked on out of Briefcase or delete the existing copies.

MOUSE ACTIONS
The following is a list of words that has to be understood when using windows and a
mouse:

Drag To move the mouse while holding one of the mouse
buttons down. This is a very useful function and is often
used in Windows applications.

Click To click the mouse button by tapping the finger on the
leftmost button on the mouse.

Right-Click To click the rightmost button on the mouse.

Double Click To double click you must click the left mouse button twice
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— one click following the next one immediately.

Minimise To close a window only partially so that it can be re-
opened later on. The program is still active, but is only
displayed as an icon at the bottom of the screen.

Maximise To restore a window that has been minimised to full size.

TASK BAR

The Task Bar is a graphical representation of the Task List. All programs / windows
that are active, are listed in the task bar by icons.

s

le:—-:n- DANIEL _@
g‘““ﬁ“’f(ﬁ’r’:;"] L=
PR e

€0 Crastor

‘err P
@ Lterr
& «ccrrr B

_EW [zt E naman

Task bar indicating the Task list

SHUTTING DOWN THE COMPUTER

WHY MUST YOU SHUT DOWN YOUR COMPUTER?

If a computer working with the Windows 95 operating system is not shut down in the
appropriate way, the user can loose important settings and even data. When the
computer is turned on again, it might have problems operating. /It is important NOT
to switch off your computer without following the proper Shut down procedure.

TO SHUT DOWN THE COMPUTER
s Click on the Start button.
2, Click on the Shut down button. The following dialog box appears:

Shut Down winaows
@ Wwhat do you want the computer to do?
& Shut dowry
 Restart
€ Restart in MS-DOS mode
[ ok | cecel | Hep
c7
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3. Ensure than the Shut down option is selected.
4. Click on OK.

WINDOWS EXPLORER

Windows explorer is the program that allows a user to manipulate the different
resources of the computer. The user can create new folders, copy, move or rename
files. The following sections explains how to perform some of these actions using
Windows Explorer.

TO OPEN WINDOWS EXPLORER

i Click on Start.

2, Move the mouse over Programs.
3. Click on Windows Explorer.

TO CREATE A NEW FOLDER IN THE C:-DRIVE
1.  Click on C: on the left side of the Explorer window.

£X Exploring - Dosdisk (C:) =] E3
File Edit View Iools Help
| All Folders  Contents of Dosdisk (C:}
{23 Desktop a1 JAction25 _1PShow
=& My Computer ] Admaltoi (. Ramesan
+-=J 3% Floppy [A]) _1Dos &7 Recycled
= e ] Faisafe.drv (1 Sbed
r Actlon2§ [;3 Games (1 Suegnet :
-4 gdmaltnl l; Isfyzqvo.twj (O Temp
- oy _1Llpro (D Tools
#-{_] Failsafe.drv
e — 1 Mouse CTve
- [#] Games i =
00 Isfyzgqvo.twi ] Pictures vgd
. {30 Lpro _1 Program Files () Windows
(e B i [ = 0 M ;I Ll—l Ll
|61 objectfs) |10.4MB (Disk free space: 2.59MB) A
Click on this position in Windows
Explorer. ]

2. Click in the File menu.
3. Click on New.
4 Click on Folder.

This will appear on the right hand side of the Windows Explorer.
5. Type in the name of the new folder.
6. Click once on the left side of the name to go directly to that folder.
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TO COPY A FILE FROM ONE FOLDER TO ANOTHER

When a file is copied from one folder to another, the user ends up with two files of
exactly the same content in different folders. A copy is thus made of the original file
in another folder.

Assume you want to copy a file with the name FILE from a folder with the name
FOLDER-A to a folder with the name FOLDER-B:

1. Select the folder FOLDER-A.

2. Move the cursor to the file with the name FILE.

3. Right-click on the filename FILE.

Open with....
Addto Zp

Send Jo _D

Cut
Copy

Create Shortcut
Deleta
iloie e S

heewr
4. Click on Copy in the sub-menu that appeared.
5

On the left side of explorer, click on the folder FOLDER-B with the right mouse
button.

6. Click on Paste in the sub-menu.

The file FILE has been copied from FOLDER-A to FOLDER-B.

TO WORK WITH A GROUP OF FILES

It is possible to work with a group of selected files. These files may or may not be
adjacent.

| size |
1427 KB

69 KB

86 KB

1005 kB

302 KB

288 KB

145 KB

302 KB

1A KR

/A mannakdne

Example of a selection of adjacent files
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TO SELECT A GROUP OF ADJACENT FILES
1.  Click on the first file.
2. Keep the shift-key down and click on the last file in the group to be selected.

| size |

57 KB

18KB

1427 KB

69 KB

86 KB

] Lesson~4 1005 KB
W) LESSON~S 302 KB
] Lesson~S 288 KB
145KB

302 KB

Example of a group of non-adjacent files

TO SELECT A GROUP OF NON-ADJACENT FILES

1. Click on the first file.

2. Keep the ctrl-key down and click on the next files to be selected.
3. Repeat step 2 until all required files have been selected.

TO COPY A GROUP OF FILES FROM ONE FOLDER TO ANOTHER

1.  Select the folder FOLDER-A.

2. Select the group of files to be copied by using one of the selection techniques
described above.

3. Right-click inside the selection.

Open with...
Add to Zip
SendTo »

Cul
Copy

Create Shortcut
Delete
Rename

Properties

4. Click on Copy in the sub-menu that appeared.

5. On the left side of explorer, click on the folder FOLDER-B with the right mouse
button.

6. Click on Paste in the sub-menu that appeared.

All selected files will be copied from FOLDER-A to FOLDER-B.

c10

© Central University of Technology, Free State



TO RENAME A FILE

1:
2.

3.
4.
5.

Open with...
Add to Zip

SendTo »

Cut
Copy

Create Shortcut

Delste

Rename

Properties

Click on Rename.
Use the keyboard to change the name.
Press enter when finished typing the new name.

O
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Move the cursor to the filename you want to change.
Right-click on it. The following sub-menu appears:

TO MOVE A FILE OR GROUP OF FILES FROM ONE FOLDER TO ANOTHER
When a file is moved form one folder to another, the user ends up with only one file.
The original file is taken from its original folder and literally moved to another folder.

Assume you want to move a file / files from a folder with the name FOLDER-A to a
folder with the name FOLDER-B.

1.
2.

3.

Select the folder FOLDER-A.
Select the group of files or single file to be moved by using one of the selection
techniques described previously.
Right-click with the mouse.

Open with...
Add to Zip

Send To

»

Cut
Copy

Create Shortcut
Delete
Rename

Properties

4. Click on Cut in the sub-menu that appeared.
5. On the left side of explorer, right-click on the folder FOLDER-B.
6. Click on Paste in the sub-menu that appeared.

All selected files will be moved from FOLDER-A to FOLDER-B.
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TO VIEW FILES IN WINDOWS EXPLORER

Files could be viewed in different formats i.e. List, Details, lcons and Small Icons.
1. Click on View.

2. Click on the view required i.e. Large Icons, Small icons, List or Details

View Go Favoites Jool
Toolbars i
Status Bar
Explorer Bar »

& Wab Page

Large lcons

Small lcons
® List

Details

d

The Details view displays information like what kind of file it is, the date and time it
was last modified or created, etc.

TO FORMAT A DISKS

Any new stiffy disk has to be formatted before it can be used. It is possible to buy
pre-formatted disks but a user has the option to format a disk to either prepare it for
use or erase all data that was previously saved on the disk.

Insert a stiffy in the stiffy drive.

Click on the A:drive icon (usually the stiffy drive is the A:-drive).
Click on the Drive with your right mouse button.

Click on Format Disk. The following window appears:

B 9 Py =

Format - 3% Floppy [A:) ki E3 I

Capacity:

Start
 Foimat type _;bw
@ Quick (erase) -
 Full
' Copy system fles anly

- Other options——————————

iMWEMFlHULTI

[ Nolabel
| ¢ Display summary when finished
! [™ Copy system files

You can select the type of format you want for your disk. If you've finished with the
selection you can click on Start and formatting will start.

NOTE: NEVER FORMAT YOUR HARD DISK (C:). IT WILL ERASE ALL DATA!!
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COPY INFORMATION FROM HARD DISK TO STIFFY

1. Select the file you want to copy in Explorer.

2. Right-click with the mouse on the file you want to copy to the stiffy drive.
3. Click on Send to in the menu.

4. Click on 3%z Floppy.

Data will be transferred from the hard disk to the disk in the stiffy drive.

COPY FROM STIFFY TO STIFFY
It is possible to make a complete copy of one stiffy onto another stiffy:

1. Click on the 3% Floppy with the left mouse button, make sure the original disk
that has to be copied is in the drive.

Now right-click on 3%z Floppy.

Click on Copy Disk in the menu that appears.

The screen shows two drives i.e. from Drive A to Drive A.

Click Start to start copying.

Follow the instructions set out on the screen.

OO kWN

ACTIVATING A PROGRAM

To start a program from within Explorer, look out for files labelled as Application file
type. Double click on the name of the application and it will be activated. If the
program can run in Windows, the user will stay in Windows and the program will
execute. If the program requires a DOS session, Windows will ask you if you want to
switch to MS-DOS session. If you press OK then windows will terminate and shut
down, then DOS will start again.

TO START THE MS-DOS WINDOW

Because of the fact that DOS was such a popular operating system, many programs
still operate in DOS. To start a DOS session do the following :

1. Click on the Start button.

2. Move over Programs.

3. Click on MS-DOS Prompt.

When you are in MS-DOS Prompt you can use the following commands :

Exit Will exit DOS and return to Windows.

Alt + TAB Pressing TAB while holding down Alt, allows you to switch
between programs.

Alt + Enter | Pressing Alt and Enter simultaneously allows you switch
between full screen mode and window mode.

Some DOS programs can only function when the computer is re-started in DOS-
mode. In this case a message will appear informing the user that the computer is
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busy re-starting in DOS-mode. When the program is exited, the computer re-starts
in Windows-mode.

RETRIEVING DELETED FILES

When a file is deleted in Windows 95, a backup of the file is automatically placed in
the Recycle Bin. The Recycle Bin keeps the deleted information until it receives an
instruction to remove all data. Only then will the file finally be deleted. All files in
Windows 95 must actually be deleted twice!

If a user accidentally deleted a file it can be retrieved by the following steps:
Right-click on the Recycle bin.

Click on Open.

The recycle bin opens and it displays all the files it contains.

Select the file(s) you want to undelete.

Click on the File menu.

Click on Restore.

9. 60 4 fe Ba

USING ACCESSORIES
Windows 95 contains a number of accessory programs that are very useful to the
computer users. These programs include:

» Cardiile which can be used like a personal telephone directory to store
information about important persons or businesses.

» Calendar which is a diary program that can be used to diarise events on a day by
day or month by month bases.

» Paint which is a graphics program that enables the user to create graphical
drawings / pictures.

» Calculator which is an on-screen calculator that can either be used as an
ordinary or a scientific calculator.

Instructions are given to open each of the accessory programs but if you would like
to use any of the accessories, please consult the on-screen Help-file for further
information.
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TO ACTIVATE CARD FILE
1. Click on Start.

2. Move over Programs.

3. Move over Accessories.
4. Click on Card File.

& Cardfile - (Untitled)

TO ACTIVATE CALENDAR
Click on Start.

2. Move over Programs.

3. Move over Accessories.
4. Click on Calendar.

—

TO ACTIVATE PAINT

1. Click on Start.

2. Move over Programs.

3. Move over Accessories.
4. Click on Paint.

Cc15

© Central University of Technology, Free State



O

SECTION C: WINDOWS 85

Central University of

Technology, Free State

FEr BRBRET BEEGT

For e, ciok Holp Topics on e Hep Menu. 1

B

TO ACTIVATE CALCULATOR
1. Click on Start.

2. Move over Programs.

3. Move over Accessories.

4. Click on Calculator.

e Ealculatm
Edt View Help
| 0.

l__ _B'mks_pacal CE I c

MC 7| s g fl 2 sa

Mal 4] s s} «| %

Ms'1‘2"_3 o

M+ 5] +7- ] 1A -

" The Calculator in standard view
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e
Edt View Help
| 0
FiHen G Dee (O Oa CBn g #®. @0
Civ CHe || | Backl CE| c

Sta F-E | ] MC 7 8 9 { | Mod| And

Ave dms} Exp| In MR 4 2 A A Or | Xor

Sum| sin| x'y | log MS 1 2 3 J Lsh| Not

s cos | X3 n! M+ 0 - : + = Int

Dat tan | X2 | 1ix Pl A B C D E F

Calculator in scientific view

THE CONTROL PANEL

The Control Panel is used to change the system'’s settings and all other settings
that control your computer. It is dangerous to play around with settings in the control
panel if you are not absolutely sure what you are doing. However, one part of the
control panel that most users find easy to use, is the settings of the display (screen).
Feel free to experiment with the settings of the display.

TO CHANGE THE SETTINGS OF THE DISPLAY
1. Click on Start.

2. Move over Settings.

3. Click on Control Panel.

T S _ 1]
... 2 8 9
AR s =B
g 2 2 .9 =5
2
4. Double-click on Display.
c17

© Central University of Technology, Free State



O SECTION C: WINDOWS 95

Central University of
Technology, Free State

5. A dialog box appears which you can use to change different settings. You can
change the background, with this dialogue box :

Display Properties

ki | This screen is
Background I Screen Saver | Appearance | Settings | ﬁf;e:ﬁzw of

windows will
look. N

You can click
on one of the
bitmaps in this
box.

— Patten

Edit Pattern,. l Browse... I

Display: @ Tie  Center

oK Cancel l Apply I

Display Properties

Background  Screen Saver | Appeasance | Settings |

-~ Screen Saver |
¥ jes s Colsis ; Seftings... I Prayiew J
I Password protected  Liarce I Wait 1_1 E minute:

;Ewmhmudm
™ Shyt off monitor 0 =] minutes l

[ ok | caeel | oy |
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CHANGING THE DATE AND TIME

The computer has a built-in clock which should display the correct date and time. If

this is not the case, the user can set the date and time:

1. Double-click on the right hand corner of the screen where the time is
displayed. The following dialog box appears:

Date/Time Properties K Eli' !

Date & Time | Time Zone |

Click in this
g box and type
2 it the correct
time.
a - a A=
- t,,,—’ -
4 5 6 7 8 9 10 R
1112 13 14 15 16 17 = e i
1813 20 21 22 23 24 ey e
ae
25 26 [ 28 29 _
[3:05:42PM =

Current time zone: South Africa Standard Time

l OK I Cancel ] Aopli

2.  Click in the appropriate box and change the time and /or date as required.
3. Click on OK.

The computer can even be set to display the time of a different time zone:

Date/Time Praperties Ei1Ed |

Date & Time Time Zone |

Fis Click in the
area which
your country
is in.

BMT <07 00] Harsie, Fretona

| Autarmaricaly adjust clock for dayiight saving chenges

K | Caosl | ———rt
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CHAPIER D1

THE OUTCOMES OF THIS CHAPTER ARE TO BE ABLE TO:

¢ To explain the relationship between the World Wide Web and the Internet

e To describe the uses of the Internet.

e To effectively search for information on the Intemet using Netscape Navigator

INTRODUCTION TO THE INTERNET

WHAT IS THE INTERNET?
The Internet is a collection of computer networks that communicate with each other
by using the same standards (protocols) of communication. The Internet connects:

» Government computers

» Computers run by hundreds of different universities and schools
» Systems owned by large corporations

> Systems belonging to non-profit organisations

» And many more ...

The Internet connects millions of people throughout the world, from Russia to Rhode
Island, Austria to Australia and even to the computer lab at Vista University or your
private home. If you know where you are going and how to get there, you can cruise
around in cyberspace, traveling from computer to computer from one continent to
another.

Did you know?

The Internet began in 1969 as a government-sponsored research network called
ARPANET (Advanced Research Projects Agency Network). This network linked
Department of Defense (DOD) research centers with university researchers. The
network grew to include contractors and subcontractors with DOD. Many
universities and colleges then joined. Libraries, other government agencies and
interested businesses also joined.

D1
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HOW WILL THE INTERNET hewr rvur

The question often asked is “But what can it do?” This question may never be
answered to the full because the options are unlimited. In simplest terms, the
Internet can send information from one computer to another.

INTERNET USES
The Internet has three basic services:

> Telnet that is the Internet service that allows the user to access remote
computers. Through Telnet, a user can access libraries, databases and other
public services all over the world.

» File Transfer Protocol (FTP) is the Internet service that allows a user to obtain
computer programs and files i.e. files can be downloaded to a local computer
through FTP.

> Electronic Mail (is discussed later in this chapter).

WORLD WIDE WEB (WWW)

The World Wide Web is a worldwide hypermedia system. When you read a Web
document (Web site), you will probably see underlined words. Each underlined word
refers to a computer resource like a program, graphic, or document. Concealed
“under” the word is the address of another Internet computer. When you select or
click the word the Web software connects you to that computer. You do not have to
know where exactly the resources are located — simply click and you will be
connected!

Businesses have found a new venue for two-way communication with customers in
the Web site. Not only do they advertise but provide much more information to
customers, students and investors.

Did you know?

You can access the web site of ABSA, SABC, VW, other universities?
You can access a web site (which you have seen on TV, or Magazines) by typing
in the internet address in the address line.

USING NETSCAPE NAVIGATOR

GETTING STARTED

Upon starting Netscape Navigator the first page you see is your current home page.
If you work in a Vista computer lab, this page will be the CIT Department’s Intranet
page.

D2
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if you work at any other computer, the home page will display as set-up by the

installer of your Internet connection.

The computers in the lab are all set to start with the following screen once you have

activated Netscape from the Program Manager.

Lty Netscape - [CIT Intranet]
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Get the Latest News

tion, be sure to reload the

1

Scroll bar

e e

=7

D3

Frames

© Central University of Technology, Free State




0 SECTION D: INTERNET/E-Mail

o Central University of
Technology, Free State

TO VIEW WEB PAGES
There are different ways to access web pages:

> In the current web page, click on highlighted words, pictures or menus to bring
another page of related information to your screen.

» Click the Back or Forward tool bar buttons to go back (or forward) to a page
you have previously seen.

> Type the web address of a web page that you want to visit in the address line.

It is important to familiarise yourself with the different screen components and
terminology as outlined below:

Home Page | The document, or page, that you first see is called a home page.

Title Bar It is similar to other title bars of other Windows applications.

Address The address bar shows the URL (Universal Resource Locator)
Bar that you are viewing.

Menu Bar | It is similar to the menu bar in other Windows application and
works the same way.

Tool Bar Shortcut buttons have been placed on a toolbar where you have to
click to access them. See the next section outlining the toolbar.

Scroll Bar | Itis used to scroll up and down through the page you are viewing.

Status bar | The status bar is used for several reasons. When you view a page
it tells you if a piece of text is a shortcut to another page. If you
use the menus the status bar give a brief description of the menu
command. When a page is being transferred to your computer, the
status bar will show the progress of the transfer.

D4
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TOOL BAR
The following icons are found on the tool bar.

1 2 3 4 5 6 7 8 9

elo|n| @lw|z(s|a) o

(1) Back Displays the previous page in the history list. A history list
references a hierarchy of pages you've already viewed.

(2) Forward | Displays the next page in the history list. When you use Back
or a history menu item to retrieve a page, using Forward gets
the proceeding page. Forward is only available after you
use Back or a history item.

(3) Home Displays the home page designated in the General
Preferences Appearance panel. The default is the Netscape
home page location.

(4) Reload Redisplays the current Netscape page, reflecting any changes
made prior to the original loading. Netscape checks the
network server to see if any change to the page has occurred.

(5) Images | Loads images into pages. This is useful when the Options Auto
Load Images menu item is unchecked and icons have been
substituted for images. By loading images, you replace the
icons with the intended images.

(6) Open Allows you to enter a URL to display the specified page in the
content area.

(7) Print Prints the content area of the current Netscape page. A dialog
box lets you select printing characteristics.

(8) Find Allows you to specify a word or phrase to locate within the
current Netscape page. You can specify case sensitivity and
search direction. If a match is found, the text is selected and
displayed.

(9) Stop Halts any ongoing transfer of page information.
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FINDING INFORMATION
As previously explained, to locate a known web site, simply type in the address in
the address line.

It is often the case that a user is simply looking for information. A search engine may
be used for this purpose. Search engines create their own “table of contents” for the
Internet in one of two ways.

» Some scan the Web, jumping from site to site and automatically “reading” all the
pages they find.

» Others require individual authors of web pages to submit description to the
search engine. These descriptions are then placed in a database that users can
access and in this way find what they are looking for.

In terms of basic use, most search engines are very similar. The only noticeable
difference is how the retrieved information is organised and displayed. The basic
steps for use are:

» Type in one or more keywords into a form.

» A search will be done and a temporary “customized” Web page presented.

> Browse the list and select the sites that match the keyword(s) that were entered.
INTERNET ADDRESSES (UNIVERSAL RESOURCE LOCATION- URL)

A code to identify resources in the Internet is called the Uniform Resource Locator.

Data is moved within a network or between networks according to established rules
called profocols. The protocol of the World Wide Web is HTTP or Hyper Text

Transfer Protocol. Note the following address:

Protocol > http:ll/v:ww.cs.vista.ac.zalcitl
Caﬁrputer Science department at Vista University which is
World Wide Web an academic institution in South Africa

TO USE THE SEARCHENGINE YAHOO @ & YAHOOL O @

ifhar's Mew Checkd Emalt Parsonsiize

Yahoo is one of the most popular search engines. To access this site:

1. Type address: http://www.yahoo.com in the address box. The screen on the
following page appears:

2. The introductory screen of Yahoo has a number of major categories to choose
from. Each category is divided into sub-categories. Many of the resources
include a short description and the links to the site. Click on the category /
sub-category and you are on your way!

3. You can also use Yahoo to search more directly if you do not want to browse
through subject categories. Do the following:
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Type a keyword in the window provided and then Click on search.

\

Yahoo! Mail \ z{] YTy vahoo! Page Win $100K

free email account now works with chgt Shopping Spree

Yahoo! Auctions -- bid on and sell merchandise for free!

Shopping - Vellow Pages - People Search - Maps - Travel Agent - Classifieds - Personals - Games - Chat
Email - Calendar - Pager - My Yahoo! - Today's News - Spotts - Weather - TV - Siock Quotes - more.

Search | options

USING A SEARCH ENGINE EFFECTIVELY

To help you focus your search and avoid most of those unwanted sources, search
engines offer a system known as Boolean logic. This enables you to combine search
terms in different ways. By using Boolean operators: AND, OR, and NOT, a user can
describe the logical relationship of two or more terms.

» AND means that both terms must be present.
» OR means that either term must be present but that both are not necessary.

» NOT means that the term should not be present i.e. if it is present, the source
should be excluded.

Look at the following examples: (Note that the inverted commas “ “ should not be
typed in the search.)

» |f you wanted to see sources on the “Easter Bunny”, you could request “Easter”
AND “Bunny’. If you did not include the AND operator, you would get every
reference for “Bunny” as well as every reference for “Easter”.

» If you requested “Movie” OR “Film”, you will get all references that includes the
word “Movie” and all references which includes the word “Film".

» If you wanted to find references to “Stars” but only those in astronomy you might
use, “Stars” NOT “Movie”. This search would not remove references to rock stars,
but it would reduce the number of irrelevant matches.
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MORE TERMINOLOGY

» Search items are words that describe the search topic.

» False drops are items that are found in a search but are not what you wanted.

» Results ranking is an attempt to put the resources returned by the search in an

order based on each resource’s relevance to your query.

» Hits are returned items that match your search terms.

TUTORIAL D1.1

Complete the following statements:

| A search is a piece of software that gives you the ability to
search for Internet resources.

Z In a search, the returned items that match your search terms are called

3. The terms AND, OR and NOT are called

4. Yahoo is an example of a(n)

5. The protocol of the World Wide Web is called

6. The software that allows you to go from one resource to another by following
hyperlinks is called a(n)

T A code developed to identify resources on the Internet is called the

Something to do.

1. Yahoo (http://www.yahoo.com) is a search engine that use subject
directories. Browse these subject categories provided and then decide
whether these categories represent the subjects you are interested in.

2. Alta Vista (http://altavista.digital.com) and Infoseek Guide

http://guide.infoseek.com) are two popular Web database search tools. Lycos
http://www.lycos.com) and HotBot (http://www.hotbot.com) are similar search
tools.

Think of a topic you would like to retrieve information on (for example, your
favourite television show, movie, hobby, sport, or career,) and perform a

search for that topic, using all four search engines. How did the results from
each engine differ?
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CHAPTER D2

THE OUTCOME OF THIS CHAPTER IS TO BE ABLE TO:

o Successfully send and read electronic mail using Pegasus Mail

Pegasus Mail

for Windows
An Introductory Tutorial

INTRODUCTION TO ELECTRONIC MAIL
Electronic mail is as the name indicates mail that are being sent electronically. In
short we refer to e-mail.

The Internet is now the world’s largest electronic mail system. Millions of people all
over the world are connected to the Internet and can send and receive electronic
mail. Effectively it means that you can send a message to any person who has an e-
mail address.

USING PEGASUS MAIL

E-MAIL ADDRESS

The Internet uses an addressing method known as the domain name system
(DNS) to assign addresse to people and computers. The system divides an address
into three parts:

» The user name name identifies the person who sends or receives the e-mail.

» The domain name identifies the computer system on which the user has an
account.

In the example: mitr-g@pelican.vista.ac.za,

» the user name is mitor-g

» the domain name is pelican.vista.ac.za
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The following table shows a sunmary ur umerent codes and their meanings:

CATEGORIES OF DOMAIN NAMES

Domain Code Description

AC Academic Institution
COM Commercial organisation
GOV Government agency

MIL Military sites

NET Network resource

ORG Private organisation
Country Codes

Domain Code Country

ZA South Africa

AU Australia

CA Austria

FR France

IE Ireland

JP Japan

UK United Kingdom

Us Unites States of America

HOW TO SEND A MAIL MESSAGE
1. Click on one of the following buttons that could be found either on the toolbar

or button panel:
5 5 i Send
a3 :
}\‘ or % mal

A message editing window will be opened. You can click on most parts of this
screen and get a description of the function of that particular part of the
window.

Type the address of the recipient in the To- field.

Click in the Subj- field and type a heading for your message.
Click in the Text part of the screen and type the message.
Click on the Send-icon on the left hand of the screen.

Oy B N
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MENU BAR

Pegasus Mail's menu bar gives you access to all of the features of the program as
well as a range of configuration options. The configuration screens can be reached
from the Tools menu and give you complete control over the way in which Pegasus
Mail operates. The user can specify everything from the name, which is written into
outgoing mail messages, to the details of the Internet provider's mail system.

' Pegasus Mail M=

Fie Edt Addwesses [IEE Folders Window Help

NEEE

E7|7 P

Mail fitering rules

Glossary
[Check spelling

TOOL BAR

Pegasus Mail's toolbar or button panel is a set of tools which provide access to the
most commonly-used parts of the program at the click of a button. Depending on the
setting specified in the Button Panel Preferences (see under the Tools/Options
menu), the button panel can appear in different formats and at different positions on

the screen.
X & o 8] =l 60l 1971 X 20/ 0vf o8] B = 1] 10/ @@ ]S

The floating button panel can be horizontal or vertical, though they both have the
same buttons. We show the horizontal button panel here:

“ Button Panel

USING THE ADDRESS BOOK

To open an address book, click on the or button on the

toolbar or the button panel.

This will open the Address Books Manager as shown below:

Sample Address Boak
D Sepport Team address buok
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58 Addresses M [=] E3
o Add | =sDelete| ™\ Edit | aLﬁpaml .Chsel
Henning Stams -
James Ford —l
Julia Smit

Hihar lEVEﬂSDI'I
MIME test mails

mime-test@relay. surfnet.nl
See mail from Andrew Momow, in useful information, dated 25 Apni

There are several ways to save a person's information into your address book:

»

You can drag a message from a mail folder to an open or minimized address
book, and the name and electronic mail address of the sender of the message
will be added automatically. An address editing window will open to let you fill in
any other details that are relevant to that person's entry.

You can drag from an address field (such as To:, From:, CC:, or Reply-to:) in
an open mail message to an open or minimized address book. Again, an editing
window will open to let you complete the entry.

You can open a message, then click on the address book's "Add" button
without clicking on any other of Pegasus Mail's windows in the meantime, and an
editing window will open, partially filled in with the details of the author of that
message.

You can open an address book and click on the "Add™ button, which will open a
blank editing window for you to fill in.

TUTORIAL D2.1

Send a mail message to the following address:
Cher-J@pelican.vista.ac.za.

In the subject line write, Impressions.

Provide a copy to Mskl-A@weasel.vista.ac.za.

You want to make sure that message concerning you impression about EUC are
being delivered, that it is urgent and also want feedback in terms of when the
receivers read your mail.

D12

© Central University of Technology, Free State



Q SECTION D: INTERNET/E-Mail

= Central University of

Technology, Free State

& Message 1 =i E3
|2
Tz
iy el __| Encrypt..
_ | Urgent + Signature (1)..
=
[ ad
ey
Cancel
=]

Send the answer of question 2 in the previous unit to your lecturer using
Pegasus Mail (you will be provided with an address).

Obtain your own e-mail address at Hotmail.com.
Provide this address to your lecturer and explain how you went about
obtaining this address
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CHAPTER E1

SECTION E: EXCEL

OUTCOMES OF THIS CHAPTER ARE TO BE ABLE TO:
Explain what a spreadsheet is

Start Excel

Identify the parts of the Excel screen
Explain and use cell addresses
Navigate around a spreadsheet
Enter numbers / text / formulas

Save a workbook

Close a workbook

Start a new workbook

Exit Excel

INTRODUCTION TO SPREADSHEETS

A spreadsheet is created by a computer program to organise information into
columns and rows. The aim is to manipulate numbers, do calculations, analyse and
draw graphs of data. A major feature of a spreadsheet is the easy and fast way in
which the computer can do calculations. Data is entered in cells and can be one of
different data types i.e. numbers, dates, time or text.

Popular spreadsheet packages are Quattro Pro, Lotus 1-2-3 and Excel. In Excel a
spreadsheet document is referred to as a workbook.

NOTE: For the information on the application and advantages of using a
spreadsheet, refer to Chapter A3.

BASIC CONCEPTS

The screen is divided into rows and columns which create a grid of cells. These
cells are identified by a row and column position, called the address of the cell. The
information the cell contains, is called its contents. Each cell may contain one of the
following types of data:

Values that can be any numeric data.

Text that can be any combination of characters.

Formula that uses mathematical operands (i.e. + , -) and cell addresses to
calculate values.

Date which can be displayed in different formats.

Time which can be displayed in different formats.

VYV VYVV

Consider the following very simple spreadsheet and take note of the remarks:

E 1

© Central University of Technology, Free State



E SECTION E: EXCEL

Central University of
Technology, Free State

Cell E5
A B C D E V52

1 Yearmark | Gr12 1997 /
2
3 NAME CLASS | MARCH JUNE SEPT / | YEARMARK
4
5 Smith K A 70 80 70 J 73.33
6 NaidooR | B 60 65 70 65.00
7 |Claminiw | A 55 75 70 66.67
8
» Row 1 contains the heading for the workbook.
» Row 3 contains the labels for each column.
» Row 5, 6 and 7 contain the data for the individual students.
» The cells B5, B6 and B7 contain the classes of the students.
» Cell E5 contains the September mark for Smith K.

TEST YOUR UNDERSTANDING

1. Give the cell address for the label NAME.

2 What type of data (value, text or formula) is entered in Cell C5?

3 What is the content of cell C77?

4. What is the March mark of Naidoo and in which cell does it appear?

5. Give the cell address for the value 65 and state what it represents.
GETTING STARTED IN EXCEL

As you would have learned when working through the Windows 95 section, there are
a number of ways in which programs can be activated. Use one of these methods to
activate Microsoft Excel. Look out for the icon:

| 35|
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THE EDITING SCREEN
The Excel application and spreadsheet screen follows:

Active Title Menu Formula Standard Formatting
Cell Bar Bar Bar Toolbar Toolbar

|Eleeaesﬁewmn s Toos ata fundo 18]
ID\@Blé[ﬁle%gﬁ.s gwt AH BYS - O
=H s %, B ﬂjiﬁrs]«& A

A
[l A o
| [ \ 7 M
= ?EJWW'P---"HWNV%JLQ 613PM
Status Bar Workbook Sheet Spreadsheet Scroll Bars

WINDOW ELEMENTS

Here are certain elements of the Excel application window which are of particular
importance when working within a spreadsheet. They are shown in the previous
diagram and a brief explanation of their use is outlined below:

» The Title Bar displays the name of the application and workbook you are
currently working in.

» The Menu Bar displays the name of the various application menus available
within Excel.

E3
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The Formula Bar shows paiucwai> ui uie w@xt font and size. It also displays the

cell reference address for the active cell and the contents of the cell.

The Standard Toolbar is usually displayed below the Menu Bar and contains a
number of icons that can be used to activate functions of Excel without having to
go through the menus. The user has a choice of displaying a number of different
toolbars by right clicking between icons on the standard toolbar.

The Status Bar is situated at the bottom of the screen and is used to keep the
user informed as to what functions are taking place in the spreadsheet, i.e. if it
displays Ready the user can proceed with entering data. When the contents of a
cell is being changed, the status bar will display the message Edit, etc.

When working in Excel the Active Cell at any particular time is “framed” as
shown in the above diagram.

A Workbook consists out of a number of Sheets (pages). The user can choose
to go to a certain sheet in the workbook by clicking on one of the tags at the
bottom of the screen.

The Formatting Toolbar is usually just below the standard toolbar at the top of
the screen but can also be displayed at the bottom of the screen. It contains a
number of icons that can be used to format the contents of the workbook i.e.
bold, italic, underline, left align, right align or centre content in cells. This toolbar
resembles the formatting toolbar of MSWord.

IMPORTANT ICONS ON THE STANDARD TOOLBAR

New Save Preview Cut Paste Undo Speedsum Descending Sort

|
D2RI8RY 1B P -

I I I I I I
@ = AN De S
I I I I I I |

Open Print Spelling Copy Format Redo Ascending Graph

Painter Sort

The following are the most important icons that will be used during this course:

>

>

The New icon is used to create a new spreadsheet.

The Open icon is used to open an existing document that has already been
saved.

The Save icon is used to save a document that has been saved before.

The Preview icon displays the document in a small format to enable the user to
see the format in which pages are going to be printed.

The Spelling icon can be used to do a spelicheck on the spreadsheet.

E4
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» The Cut icon places highligntea ceus onto the Clipboard — removing them from

their old position.

» The Copy icon places a duplicate of the highlighted cells onto the Clipboard —
the original data stays untouched.

» The Paste icon inserts the current contents of the Clipboard into the
spreadsheet.

» The Format Painter icon can be used to change the format of data to the same
format as that of a selected cell.

» The Undo and Redo icons can be used to undo or redo previous actions.

» The Speedsum icon automatically enters a function that will add all the values in
the highlighted text.

» The Ascending and Descending Sort icons sort the rows in the selected block.

» The Graph icon allows the user to create a graph within the spreadsheet.

IMPORTANT ICONS ON THE FORMATTING TOOLBAR

Font Font Bold Underline Centre Merge Percentage Decrease Borders
Size &Centre Decimal

I | I I I I I I I

| -0 - BZU ESEEE %, §3 == _

Italic Left Right Cumrency Increase
Align  Align Decimal

Most of the icons are known from MS Word. The ones that are particularly used in
Excel are:

» The Merge & Centre icon is used to centre a heading over a series of cells
instead of one cell.

» The Currency icon is used to display numbers as currency i.e. a $ or R sign is
automatically inserted in front of the number. It is important to type the numbers
as ordinary numbers and then use this icon to display the R. If the user types in
a R followed by the numbers, it will be seen as text and not as numeric values
and it will not be possible to do calculations with the numbers.

» The Percentage icon is used to convert and display numbers as percentages.
The numbers are multiplied by 100 and a % sign is inserted after the number.

ES
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» The Decrease indent and ivicase musie iCONS are used to position content at

a specific position within the cell.

SECTION E: EXCEL

» The Borders icon is used to draw borders around selected cells.

» The Increase decimal and Decrease decimal icons are used to specify how
many digits after the decimal point should be displayed. In the case of currency,
this option should be set to 2 decimal digits.

NAVIGATING AROUND THE SPREADSHEET
Any individual cell in a spreadsheet can be made “active” simply by clicking on it with
the mouse pointer. Click on any cell in the window to move to that cell.

You can also click on the scroll button at either end of the vertical or horizontal scroll
bars which appear at the bottom and right-hand edges of the spreadsheet in order to
move one row or column in the direction indicated by arrows.

However, when typing large amounts of data into adjacent cells, or when working on
a large spreadsheet, it is often far easier and quicker to move the cell pointer using
the keyboard. The following options are available:

KEYS ACTION

Arrow keys Move one by one cell in the direction of the arrow.
Shift + Arrow Extends the selection by one cell.

Home Moves to the beginning of the row.

Ctrl + Home Moves to the beginning of the worksheet.

Ctrl + End Moves to the lower-right corner of the worksheet.

Ctrl + Shift + End

Extends the selection to the end of the data.

Ctrl + Spacebar

Selects the entire column.

Ctrl + Shift
Spacebar

+

Selects the entire worksheets.

Shift + Spacebar

Selects the entire row.

Page Down Moves down one window.

Page Up Moves up one window.

Tab Moves right one page.

F5 Goes to a cell, block or page address to which you want

to go.
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ENTERING DATA INTO A CELL

To enter data into a cell, you can simply move to the cell and start typing. The first
character of what is typed, determines what type of data is entered i.e. a Numeric
Value, Text or a Formula (except if the cell was pre-formatted to be able to take only
values or a specified type i.e. date or time).

» A Numeric Value is entered by simply starting to type any digit (i.e. 0, 1, 2, ...9).
A value is automatically right-aligned in a cell and can be used in calculations.

» Text consists out of words or sentences (i.e. any combination of characters).
Text is automatically left-aligned in a cell. Numbers can also be typed as text by
starting to type the prefix * followed by the number. If numbers are entered as
text, they cannot be used in calculations.

» A Formula refers to cell addresses in the spreadsheet and performs some sort of
calculation using values contained within these cells. A formula therefore
represents a calculated result. A formula is accepted when the user starts typing:
+or =

TUTORIAL E1.1

Create the next spreadsheet by following the instructions carefully:

A B
1 MY BUDGET 1999
2
3 EXPENSE JAN
4 Car 500
5 House 600
6 Petrol 100
7 Food 200
8 Clothes 50
1. Use the arrow keys and move the cursor to cell A1.Type the text “MY

BUDGET 2000" and press ENTER.

2. Use the arrow keys to move to cell A3. Type the text “‘EXPENSE” and press
ENTER.

3. Complete typing the rest of the data as given in the table above.

4. Save the spreadsheet as BUDGET1.

E7
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ENTERING DATA INTO A CELL

To enter data into a cell, you can simply move to the cell and start typing. The first
character of what is typed, determines what type of data is entered i.e. a Numeric
Value, Text or a Formula (except if the cell was pre-formatted to be able to take only
values or a specified type i.e. date or time).

» A Numeric Value is entered by simply starting to type any digit (i.e. 0, 1, 2, ...9).
A value is automatically right-aligned in a cell and can be used in calculations.

> Text consists out of words or sentences (i.e. any combination of characters).
Text is automatically left-aligned in a cell. Numbers can also be typed as text by
starting to type the prefix * followed by the number. If numbers are entered as
text, they cannot be used in calculations.

» A Formula refers to cell addresses in the spreadsheet and performs some sort of
calculation using values contained within these cells. A formula therefore
represents a calculated result. A formula is accepted when the user starts typing:
+0r =

TUTORIAL E1.1

Create the next spreadsheet by following the instructions carefully:

A B
1 MY BUDGET 1999
2
3 EXPENSE JAN
4 Car 500
= House 600
6 Petrol 100
7 Food 200
8 Clothes 50
: | Use the arrow keys and move the cursor to cell A1.Type the text “MY

BUDGET 2000" and press ENTER.

2. Use the arrow keys to move to cell A3. Type the text “EXPENSE" and press
ENTER.

3. Complete typing the rest of the data as given in the table above.

ES Save the spreadsheet as BUDGET1.
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EDITING DATA IN A CELL
Data entered in a cell can be changed / edited in a number of ways:

TO CHANGE PART OF THE CONTENTS OF A CELL

1L

2:
3.
4.

Select the cell to be edited.

Press the F2-key or double-click on the cell.

Edit data as required by using backspace, delete or typing.
Press ENTER.

TO OVERWRITE DATA IN A CELL

L
2
3.

Select the cell which contents you wish to overwrite.
Start typing the new data.
Press ENTER.

TO CLEAR INFORMATION FROM A CELL

1
2.

Select the required cell.
Press Delete.

TO USE THE UNDO COMMAND
If you clear a group of cells and then immediately realise that you have made a
mistake, you can undo the action by using the Undo command.

1.

Click on the Undo icon on the standard toolbar.

TO USE THE RE-DO COMMAND
The re-do command is used to undo the undo-command.

1.

Click on the Re-do icon on the standard toolbar.

SAVING DOCUMENTS

>

The Save command will place a copy of the workbook on a disk. If a previous
copy has been saved already, the save command will replace the previously
saved versions of the workbook with the current version, including all changes
that you have made. The newly saved workbook will still be displayed on the
screen.

The Save As command allows you to save another copy of the workbook under a
different name or on a different drive / directory.

E8
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TO SAVE A DOCUMENT FOk 1ne rimor 1mE

1. Click on the File menu.
2. Click on Save. The following dialog box appears:
Jﬂﬂemmmmmmmw _ =18 x|
DR 8RY 1R d -~ QR LI B - B
| il 10 - BIUEEEES%, 3 FTE _.O-A-
-| =/
i 5ove As A=
;smp [} My Documents = & 6] o == 8= =
| 3 B asreerian | sve | |
el |
8
E]
Al
kS
1.
%. Save astype: |Microsoft Excel Workbook Ra|
167 =
4470 T)\Sheet1 { Sheetz [ Sheets / | mcanarome r yaw| [T
Ready | T N fj_ﬁ_ﬁ_ﬁ
Asae| @ A Y 2 | W Miciosot... | §junttied - P |[3g Microso.. | Yz 2 626PM
3. Click in the File name box and type the name that you wish to give to your
workbook.
4. If you want to change the drive and directory specification, click in the Save in

box. Click on the down arrow next to the box and then select the drive and
directory you wish to save your workbook in.
5, Click on Save.

TO SAVE A DOCUMENT WHICH HAS ALREADY BEEN SAVED
1. Click on the Save icon on the Toolbar. The workbook will be saved with the

same name as used previously.

TO SAVE A DOCUMENT USING ANOTHER NAME, DRIVE OR DIRECTORY
;| Click on the File menu.

2. Click on Save As.

3. Click in the File name box and type the new name that you wish to give to
your workbook.

4 If you want to change the drive and directory specification, click in the Save in

box. Click on the down arrow next to the box and then select the drive and
directory you wish to save your workbook in.
S Click on Save.
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TO SAVE A DOCUMENT FOk 1 nc rimar 1miE

- Click on the File menu.
2 Click on Save. The following dialog box appears:
]ﬂammmmmmmw =18 x|

DR &RY 1@ - Q@ A HU DB v O
 Avia 10 - BZU EEEEBSX, 43T _-S5-A
Al ~| =

t Save As FiE3 L-:
jav-n [ My Documents = &l o e [= gl 7 |
3 JAARBEPLAN I Save | j
4 kseef ‘
_"_? optirs... |
8
E
n ‘
3 ‘
E3
1) Fegame: [N =] ||
%. Save as type: |Microsoft Excel Workbook =l
IH.«.L_L M\Sheet1 { Sheet2 {Sheet3 / Kl i
Roady (=7, o
Asat| @AY Y | Wy Miciosott... | E7unttled - P..|[SgMicroso.. Yo b & B25PM
3. Click in the File name box and type the name that you wish to give to your
workbook.
4. If you want to change the drive and directory specification, click in the Save in

box. Click on the down arrow next to the box and then select the drive and
directory you wish to save your workbook in.
5. Click on Save.

TO SAVE A DOCUMENT WHICH HAS ALREADY BEEN SAVED
1. Click on the Save icon on the Toolbar. The workbook will be saved with the
same name as used previously.

TO SAVE A DOCUMENT USING ANOTHER NAME, DRIVE OR DIRECTORY

4 Click on the File menu.

2 Click on Save As.

3. Click in the File name box and type the new name that you wish to give to
your workbook.

4 If you want to change the drive and directory specification, click in the Save in
box. Click on the down arrow next to the box and then select the drive and
directory you wish to save your workbook in.

5. Click on Save.
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CLOSING A DOCUMENT

When you have finished working with a workbook, you can close it and it will no
longer be available on the screen. The workbook can however, at any time be re-
activated by retrieving it from the disk (IF IT HAS BEEN SAVED ON DISK).

TO CLOSE A DOCUMENT

1 Click on the File menu.

2, Click on Close.

3. If you have not yet saved your workbook, then Excel will open a dialog box

which will prompt you whether you would want to save the workbook. You
could now choose Yes (which will lead to the Save-As-dialog box) or No
which will result in the workbook being closed and not being saved or Cancel
which will result in the workbook not being closed and will allow you to
continue working in the workbook.

CREATING A NEW DOCUMENT

When you open Excel, it automatically creates a new workbook. If you are already
working in Excel and you want to create yet another workbook, then the following
steps could be taken:

TO CREATE A NEW DOCUMENT
1. Click on the File menu (or click on the New icon).
2. Click on New. The following dialog box appears:

T Preview not available. i
. |
[Tk ] caxa |
i,.‘J e e T e il AN — . - S—— _ll—
Ready [T==1T ]
MAstan| | & 24V 2 || Wy Microsoh | $7)untied -P_|[3g Microso... |Yof B 627PM
3. Select the Workbook option.
4, Click on OK. The new workbook will appear on the screen.
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EXIT EXCEL

1. Click on the File menu.

Z Click on Exit.

3. If prompted, indicate whether or not you would like to save the workbook.

TUTORIAL E1.2

Work with the spreadsheet BUDGET1 created in TUTORIAL E.1.1. Change the
spreadsheet by following the instructions carefully:

A B
1 MY BUDGET 2000
2
3 EXPENSE JAN
4 Car 600
5 House 600
6 Petrol 100
7 Food 200
8 Clothes 50

1. Move the cursor to cell A1. Change the text to read “MY BUDGET 2000”.
2. Move the cursor to cell B4. Change the number 500 to 600.
3. Delete the value in cell B8.

4. Save the spreadsheet again using the name BUDGET1.

E 11
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EXIT EXCEL

1. Click on the File menu.

2. Click on Exit.

3. If prompted, indicate whether or not you would like to save the workbook.

TUTORIAL E1.2

Work with the spreadsheet BUDGET1 created in TUTORIAL E.1.1. Change the
spreadsheet by following the instructions carefully:

A B
1 MY BUDGET 2000
2
S EXPENSE JAN
4 Car 600
5 House 600
6 Petrol 100
7 Food 200
8 Clothes 50

1. Move the cursor to cell A1. Change the text to read “MY BUDGET 2000”.
2. Move the cursor to cell B4. Change the number 500 to 600.
3. Delete the value in cell BS.

4. Save the spreadsheet again using the name BUDGET1.
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CHAPTER E2

OUTCOMES OF THIS CHAPTER ARE TO BE ABLE TO:
Open an existing file

Work with more than one workbook at a time

Insert / delete rows and columns

Hide and unhide columns

Change column widths

Change row heights

Use different formatting techniques

Print a workbook

® @ @ © © © @ o

WORKING WITH EXISTING FILES
When a file has been saved, the user can open the file and work with it.

TO OPEN AN EXISTING WORKBOOK

y Click on the File menu (or click on the Open icon).

2. Click on Open. The following dialog box appears:
3% Micr - docll =18 x|
%) Fle Edt view Insert Format Tools Data window Help =2

DERSRY yBBI - - Q@(ZAUU BB w0 &

R T e o e R POy P S B D SRR T 7] |

_ Lookin: iﬁ My Documents -j E-I ¥ o
| | name | size | Type odfied | & | Open | =
k] ] 14 KB Microsoft Excel ... 7/13/99 6:29PM
E doclo 14 KB Microsoft Excel ... 7/13{99 6:30 PM Cancel |
- | docti 14 KB Microsoft Excel ... 7/13/99 6:30 PM A
| |®] doc2 14 KB Microsoft Excel ... 7/13/99 6:29PM =
| |%®]doc3 14 KB Microsoft Excel ... 7/13/99 6:29PM
|| docd 14 KB Microsoft Excel ... 7/13/99 6:29 PM
E docs 14 KB Microsoft Excel ... 7[13/99 6:29 PM
i dock 14 KB Mcrosoft Excel ... 7/13/99 6:29PM
) doc? 14 KB Microsoft Excel ... 7[13{99 6:29 P
| |B]docs 14 KB Microsoft Excel ... 7113{99 6:30PM o
- Find files that mabch these search criteria;
|- File pame: |] ﬂ Tegorpmpuby:! E] Find Now ,"‘
: Fles of type: IMicmsd’t Excel Files :’ Last modified: ]a‘wt‘ma :’ New Search
~ | 13Fike(s) found, 3 e
(LB ) =7 Ml
Ready | | w | | I
Astr| | @AY | 7 icwosch . | §juritied P |[3E Microso {2 630PM
3. If you need to change the drive or directory click on the arrow next to the

Look in box and select the drive and directory where the file can be found.
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4. Click on the name of the file that you want to open or type the name of the file

in the File name box.
5. Click Open.

MORE THAN ONE WORKBOOK OPEN AT THE SAME TIME
It is possible to have more than one workbook open at the same time.

TO SWAP BETWEEN OPEN WORKBOOKS

1. Click on the Window menu.
2 All the names of the active books will be displayed. Select the one you want
to work with.

INSERTING AND DELETING ROWS / COLUMNS
It is possible to insert rows and/or columns to an existing spreadsheet.

TO INSERT ROWS / COLUMNS

1. Move the mouse pointer to anywhere in the column / row where you want to
insert a new column / row.
2. Click the right mouse button. The following menu appears:

&' Format Cels...
Pick From List. ..
A Click on Insert. The following dialog box appears:
set B
Insert
€ shift cells right IL.I
& Shift cells down Carcel |
" Entire row
€ Entire column l
4. Click on Entire row or Entire column — whatever is applicable.

5. Click on OK.

© Central University of Technology, Free State
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TO DELETE ROWS / COLUMN>
Select the row / columns that you wish to delete.

Click on Delete.

aOhON =

Click on OK.

HIDING ROWS AND COLUMNS

Click the right mouse button in the row / column. A menu appears.

Click on Entire row or Entire column whichever is applicable.

Excel allows the user to hide a row or column. This option would be used when
sensitive information should not be displayed on the screen.

TO HIDE ROWS / COLUMNS

i Select the row or column you wish to hide.
2. Click on the Format menu.

3. Click on Row or Column.

4, Click on Hide.

|®)He Edt view Insert | Format Tools Data Window Help

DESE &R Y B s Ctrk+1 iEqu £ 4% OB w0
| A il . B EE| L
D14 ~| et e
A TR Unfid el o . et il
1 AutoFormat... :
2 Conditional Formatting. ..
3 Style
4
5
TO UNHIDE ROWS / COLUMNS
1. Select the rows or columns adjacent to the rows / columns that are hidden.
2 Click on the Format menu.
3. Click on Row or Column.
4 Click on UnHide.
TUTORIAL E2.1
A B C
1 MY BUDGET 2000
2 ,
3 EXPENSE INCOME JAN
4
5 Car 600
6 House 600
e Petrol 100
8 Food 200
9 Clothes 50
E 14
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1. Open the file BUDGET1 that was created in CHAPTER E1.

2. Insert an empty row between rows 3 and 4.

3. Insert a new column between EXPENSE and JAN and type the heading
INCOME.

4. Hide the new column with the heading “INCOME”.
5. Unhide the column with the heading “INCOME”"

6. Save the file as BUDGET2.

SELECTING CELLS AND BLOCKS
It is often necessary to select cells or a block of cells in a workbook.

» To select a cell, click on the cell.

» To select a block, drag it by clicking a cell in one corner, holding down the left
mouse button, moving to the opposite corner and releasing the mouse button.

» To select a non-contiguous block (a selection consisting of more than one
disconnected block of cells), select the first block and then hold down the CTRL
key while you click to select other cells.

» To select a complete row, click on the row number.

» To select a complete column, click on the column letter.

> To select the entire workbook, click on the position between the first row and the
first column.

Click here to select Click here to select
the entire workbook column D
Click here
to R I T T - s T <) [ <O - S
select 1
row2___§o
3
4
5
B
E 15
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RESIZING COLUMNS ana rxuvv>
There are several ways to change the width of columns and the height of rows with
the mouse i.e.

» drag the row or column border to the correct size.

» specify an exact numerical setting through the Format menu.

TO DRAG ROW AND COLUMN BORDERS

1. Move the pointer over the right edge of the column border to be resized, or

over the bottom edge of the row border to be resized. The pointer turns into a
double arrow.

| Aial -0 - B 7D EEEE S %
Al = =| _Width: 8.43 |
A B e D s E | F |
1 1
5 :
3
4
5
6
2. Drag the double-arrow until the row or column is the required size.

TO RESIZE SEVERAL ROWS OR SEVERAL COLUMNS IN THE SAME PAGE TO

A UNIFORM SIZE

1 Select contiguous rows or columns (by clicking and dragging their borders).

2. Decide on a row or column within the selection that you want to govern the
uniform size, then drag the double-arrow. All the rows or columns are resized
to the same dimension even if they started out with different sizes.

TO RESIZE ROW HEIGHT THROUGH THE FORMAT MENU

1. Select the row / column you wish to change.
2. Click on the Format menu.
3. Click on Row or Column.
4. In the case of row, click on Height - in the case of column click on Width.
%) e Edt Yew Insett Fomat Ioos Data Window LHeb =
DR 8R ¥ & . Cut+1 llzli’lz&ﬂﬂm!é
: Row 3 L Height... P i
“Anal -1 ok 3 AutoFt 3 .63-»"3“:??]_
D14 | chpet NI =
phes| i B o R Lt
1 AutoFormat... =
2 Conditional Formatting. ..
[ 3 Style
3
[ 5 |
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The following screen appears:
Row Height (2] %]
oo (W o]
__Concel_|

3. Type the required row height.
6. Click on OK.

CHANGING THE WAY DATA LOOKS

A simple way to enhance your workbook’s appearance is through the use of different
fonts and style options such as Bold, /falic and Underline.

TO CHANGE THE APPEARANCE OF CONTENT

1. Select the cells that have to be changed.

2. Click on the appropriate icon on the Formatting Toolbar as explained in
Chapter B1 (i.e. change the font type or font size or select Bold, italic,
Underline).

”p.rial 10 ~ B I U

TO CHANGE THE ALIGNMENT OF DATA

Text is automatically left-aligned in a cell and numeric values are automatically right-

aligned in a cell. The user can however, select to place data to the left, right or

centre of the cell.

1. Select the cells you want to change.

2. Click on the appropriate icon on the Formatting Toolbar as explained in
Chapter E1 (i.e. choose Left aligned, Centre or Right aligned).

TO CENTRE A HEADING OVER A SERIES OF CELLS

Using the icons showed above, the content will be aligned within one cell. Itis also
possible to centre a heading over a series of cells i.e. the user might want to centre
the main heading of the workbook across several columns.

1. Select the cells in which the content should be centred.
2; Click on the Merge & Centre icon. = '
3. Type the content into the merged cells. ==

EN7
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SHADING CELLS

Cells could be shaded to a number of different colours. If you use a colour printer,
the colour selected will be printed. If you use a black and white printer, different
shades of grey will be printed.

TO SHADE CELLS
1. Select the cells that you wish to shade. &
2. Click the arrow on the Fill Color icon 5

on the Formatting Toolbar.The following window appears:
— .
I No Fil |

EEEEEEEN
ENEEEREEN
EOfEEEEN
RO ENERD
BT ]

3. Click on the colour you would like to use. If you do not have a colour printer,
you will have to select one of the shades of grey.

ADDING BORDERS

Excel allows you to add borders around your data in order to emphasise important
parts of a workbook. Excel has a number of borders to choose from i.e. thin, thick,
solid or double lines. You can also select to place the border above, below, right, left
or around all four sides of a cell.

TO ADD A BORDER TO CELLS
1. Select the cells you wish to apply a border to.
2. Click the right arrow next to the Borders icon on the Formatting Toolbar.

3. Select the type of border that you wish to be applied to the cell(s).

E 18
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TO CHANGE THE FORMA 1 OF DATA
Data in a cell can be displayed in different types of formats. The most important
formats are:

>

General where the content is determined by the first character of input and
numbers are not displayed in any pre-set format.

Numbers where the user can specify how many decimal digits should be
displayed. If it is set to 2 decimal digits and the number 5 is typed in, it will be
displayed as 5.00.

Currency where the user can specify which symbol should be displayed in front of
the numbers. [t is important to type in values without the currency symbol and
then format it to display the symbol otherwise it cannot be used in calculations.
Date where the user can specify in which format a date should be displayed.
Time where the user can specify in which format time should be displayed.

Percentage where the number will automatically be multiplied by 100 and the
percentage sign % will be displayed in the cell.

TO SET THE FORMAT OF A CELL

2.
3.

Select the cell(s) you want to change the format of.
Click on the Format menu.
Click on Cells. The following window appears:

Format Cells 7] x|
fRiumber :| aignment | Font | Border | Pattems | Protection |
General format cells have no
specific number Format,
E19
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TO CHANGE THE FORMAT OF DATA
Data in a cell can be displayed in different types of formats. The most important
formats are:

>

General where the content is determined by the first character of input and
numbers are not displayed in any pre-set format.

Numbers where the user can specify how many decimal digits should be
displayed. If it is set to 2 decimal digits and the number 5 is typed in, it will be
displayed as 5.00.

Currency where the user can specify which symbol should be displayed in front of
the numbers. It is important to type in values without the currency symbol and
then format it to display the symbol otherwise it cannot be used in calculations.

Date where the user can specify in which format a date should be displayed.

Time where the user can specify in which format time should be displayed.

Percentage where the number will automatically be multiplied by 100 and the
percentage sign % will be displayed in the cell.

TO SET THE FORMAT OF A CELL

; 1
2.

3.

Select the cell(s) you want to change the format of.
Click on the Format menu.
Click on Cells. The following window appears:

Format Cells | 7] x|

s

(Humber :| migrment | Font | Border | Patterns | Protection |

et

Category:
MNumber
Currency
Accounting General Format cells have no
Date specific number format.
Time
IPercentage
Fraction
Scientific
Text
Special

Custom _';J
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Select the desired format. Win most or e options further selections have to be
made i.e. if you click on currency the following screen appears:

Format Cells EE3 !
Mumber | Alignment | Font | Border | Patterns | Protection |
Category:

Text R 1,234.10
Special R -1,234.10
Custom Fl Ir-1,234.10

The number of digits after the decimal point; the symbol displayed in front of the
numbers and the way negative numbers are displayed, can be selected.

PRINTING WORKBOOKS

Before a spreadsheet is printed, the user has to decide whether it must be printed in
Portrait or Landscape view.

Portrait view Landscape view

E 20
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TO SELECT PORTRAIT OR LAanwovarc vicl

1. Click on the File menu.
2. Click on Page Setup. The following dialog screen appears:
Page Selup [ 7] B!
Page 1| Margins | HeaderfFocter | shest |
@ € portra € Landscape prnt Previens |

@ pdustto:  [100 =] % normalsee

Papersze:  |Letter 8 1f2x 11in =l
Print gualty: {600 o 5
First page number: Im

3. Click on Portrait or Landscape.
4, Click on OK.

There are many other printing options available in Excel that can be selected from
the print dialog box.

TO PRINT A SPREADSHEET
1. Click on the Print icon in the Standard Tool bar. The following dialog box

appears:
T T I TS 7] x|
~Printer -
Name: |5 HP LaserJet 6L PCL ~|  Properties | !
Status:  Idie i
Type: HP LaserJet 6L PCL L
Where: LPT1: i
Comment: ™ Print to file
~Print range ~Copies

“al Number of copies: lﬁ

C Page(s) From: | STo:| =

~Print what

" Selection " Entire workbook ﬂ Iﬂ K

% Active sheet(s)

Preview | ok« | cacel |
2. Select the desired options.

3. Click on OK.
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TUTORIAL E2.2

A | B C
1 MY BUDGET 2000
2
3 EXPENSE INCOME JAN
4 R2000-00
S Car R600-00
6 House R600-00
4 Petrol R100-00
8 Food R200-00
9 Clothes R50-00

Open the file BUDGET2 created in TUTORIAL E2.1.

Resize Column A to be wider than the other columns.

Change the row height of the whole spreadsheet to 14 points.

Centre the headings in row

3.

Centre the main heading “MY BUDGET 2000” over columns A, B and C.

Shade the text in row 3.

Add a grid border to the wh

ole spreadsheet.

Change the format of the values in column B and C to be displayed as

currency with 2 decimal pla

Enter the value 2000 in cell

ces.

B4.

Save the spreadsheet as BUDGETS3.

Print the spreadsheet.

E 22
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CHAPTER E3

OUTCOMES OF THIS CHAPTER ARE TO BE ABLE TO:

° Use formulas in Excel
° Use functions in Excel
. Move and copy data in a workbook

INTRODUCTION TO FORMULAS and FUNCTIONS
In Excel we can use formulas and functions to quickly calculate values from the data
contained in cells of the workbook.

IMPORTANT TERMS

> A prefix is a character that indicates that a formula / function will be following. The
most commonly used prefixes in Excel, are + and =

» Operators are used to indicate arithmetic calculations i.e.
+ used for addition
- used for subtraction
*  used for multiplication

| used for division

» Cell addresses are letters and numbers that refer to a cell's location in the
spreadsheet i.e. A4, B7, etc.

» A range of cells is a reference that indicates a contiguous block of cells i.e.
A1:A50 indicates all the cells from cell A1 to cell A50.

» A constantis a fixed number used in calculations.

FUNCTIONS

Functions are pre-defined modules that are built into the spreadsheet and can be
used to do calculations. Most functions consist of a prefix, function name and range.
An example of a function is

=SUM(B1:B5)
In the example,
» the prefix is =
» the name is SUM
» the range is B1:B5
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FORMULAS

Formulas are arithmetic expressions that consist of a prefix, operators, relevant cell
addresses and / or constants. It is used to calculate values. Formulas could also
include functions. An example of a formula is: =C5 + D3

Both formulas and functions are created by starting to type the prefix = or +
Functions and formulas could be understood better by studying some examples.
Consider each of the following formulas /functions and the explanation of what result
it will calculate:

Formula Formula/ Description
function

+C3+C7 Formula Add the contents of cell C3 to the
contents of cell C7

=sum(B1:B10) Function Add all the values of range B1 to
B10

=average(F5:F50) | Function Determine the average of the
values in the range

=sum(A1:F1)/6*100 | Formula Calculate the sum of the values in

the range; then divide by 6 and
then multiply by 100

THE ORDER OF CALCULATIONS
If you combine several operations in a single formula / function, Excel will perform
the operations according to the order of the operators as listed in the table below:

Operator Description

() Expressions in parenthesis will be
evaluated first

: Range

Space Intersection

) Union

- Negation

% Percentage

A Exponentiation

*and / Multiplication and Division

+and - Addition and Subtraction

& Text joining

=< > <= 5= <> Comparison

If the formula / function contains more than one operator with the same priority level,
Excel will evaluate the operators in the formula / function from left to right. However,
parenthesis can be used to alter the order of evaluation. Consider the following
examples:

+3+6*5 = +3+30 = 33 BUT +(3+6)*5=+9*56=45
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TO CREATE A FORMULA BY 1 1ruvs

1. Select the cell where you want the result of the formula / function to appear.
2. Type the + (plus sign).

3 Type the desired cell addresses and mathematical operators.

4 Press Enter.

TO CREATE A FORMULA BY POINTING

Select the cell where you want the result of the formula / function to appear.
Type the + (plus sign).

Click with the mouse or move with the arrows to the first cell required in the
formula / function.

Press the desired mathematical operator (+, *, -, /).

Click with the mouse or move with the arrows to the next cell required in the
formula / function.

Repeat steps 4 and 5 until the formula / function has been finalised.

Press Enter.

N ke W=

TO CREATE A FUNCTION BY TYPING
Every function is typed by starting with the prefix = (equal sign).

Most functions have the following format: =FUNCTIONNAME( RANGE ) where:
» the prefix is usually =

» FUNCTIONNAME is the name of the function i.e. SUM, MAX or MIN.

» RANGE specifies the range of values in the spreadsheet that should be used.

The following table gives a summary of functions that are often used by end users:

Function Description Example

=SUM(RANGE) Calculate the sum of the | =SUM(A1:A20)
values in the specified
range

=MIN(RANGE) Determine the smallest | =MIN(B7:B15)
value in the specified
range

=MAX(RANGE) Determine the highest | =MAX(C1:C10)
value in the specified
range

=AVERAGE(RANGE) Calculate the average of | =FAVERAGE(A1:A30)
the wvalues in the
specified range
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The most efficient way to calculate the sum of a group of cells is by clicking the
Speed Sum icon on the standard Tool bar.

1. Select the range of cells that must be added - including one empty cell. g
2. Click on the Speed Sum icon. Excel will automatically enter the
=SUM-function with the appropriate range and place the result in the blank
cell.
3. Press Enter.
TUTORIAL E3.1
A | B [ C
1 MY BUDGET 2000
2
3 EXPENSE INCOME JAN
4 R2000-00
5 Car R600-00
6 House R600-00
7 Petrol R100-00
8 Food R300-00
9 Clothes R50-00
10
11 | Total RXXxX-Xx
12
1. Open the file BUDGET3 that was created in TUTORIAL E2.2.
2. Type the text “Total” in cell A11.
3 Use a function in cell C11 to calculate the total expenses of the “JAN” column.
(the Rxoxxx.xx indicates that a formula / function is used in this cell)
4. Change the value of cell C8 to 300. (Note that the total is adjusted
automatically
5. Save the spreadsheet as BUDGET4.

COPYING DATA FORMULAS / FUNCTIONS

Data (including formulas and functions) in any cell or range of cells can be copied or
moved to another cell / range of cells.

TO COPY DATA

1.

hWON

Select the data to be copied. B

Click on the Copy icon.

Click on the cell or select the range where data has to be copied to.
Click on the Paste icon.
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TO MOVE DATA

Data in any cell or range of cells can be moved to another cell / range of cells.
1. Select the data to be moved.

.3 Click on the Cut icon. |¥

3. Click on the cell or select the range where data has to be copied to.

4. Click on the Paste icon. =

NOTE: Formulas and functions can also be copied from one cell to another cell or to
a range of cells by using the same procedure as described above. Keep the
following in mind:

REFERENCES

A reference identifies a cell or group of cells in a spreadsheet. There are two basic
types of references in Excel i.e. relative references and absolute references. If you
want to refer to cells relative to a cell containing a formula / function, then a relative
reference should be used. If you want to refer to a cell by its exact location, then an
absolute reference should be used.

» To indicate a relative reference type the formula / function as usual i.e.
+A1+ A2 or =SUM(A1:A10)

» To indicate an absolute reference, type a $-sign in front of the cells that should
not be changed when copied i.e. +$A$1 + A2 or =SUM($A$1:$A$10). The $-
sign indicates that the reference to the cell is absolute. The result will be that
when the formula / function is copied to other cells, the cell address $A%$1 will not
be changed but will be repeated exactly in the new position.

Summary: When you copy a relative cell address, the cell address in the copied
formula / function will change accordingly. When you copy an absolute
cell address, the cell address in the copied formula /function will stay

the same.

Example:

A B C D = F
1 Yearmark Gr12 2000
2
3 NAME CLASS | MARCH JUNE SEPT YEARMARK
4
5 | Smith K A 70 80 70 73.33
6 NaidooR | B 60 65 70 65.00
7 |Claminiw | A 55 75 70 66.67
8

Assume the following function is typed into cell C6 =sum(C3:C5) and it is copied to
cell D6 then it will be changed to =sum(D3:D5). The reason is that the cell
references are relative.
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If the function were typed as =sumipuas:pu35) and then copied to cell D, it will
remain to be displayed as =sum($C$3:$C$5) because the cell references were
typed as absolute references.

TUTORIAL E3.2

A ] B | C D
1 MY BUDGET 2000
2
3 EXPENSE INCOME JAN FEB
4 R2000-00
5 Car R600-00 R600-00
6 House R600-00 R600-00
T Petrol R100-00 R150-00
8 Food R300-00 R250-00
9 Clothes R50-00 R150-00
10
11 | Total Rx000¢-xx RXOxx-xx
12 | Difference RX000¢-xx RXXXX-XX

Work with the file BUDGET4 that was created in TUTORIAL E3.1.
2 Enter the new data, as shown above, in column D.

3. Copy the function that was used in C11 to cell D11. (Note how the cell
references change when the formula is copied.)

Type the text “Difference” in Cell A12.

5. Use a formula and absolute referencing in cell C12 to determine the
difference between the Income given in cell B4 and the total Expenses given
in cell 11.

6. Copy the formula from cell C12 to cell D12. (Note how the absolute cell
references stay the same when the formula is copied.)

£ Save the file as BUDGETS.

8. Print the spreadsheet.
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CHAFIEK E4

OUTCOMES OF THIS CHAPTER ARE TO BE ABLE TO:
o Sort data in a workbook into either ascending or descending order
« Create different types of charts in Excel

SORTING DATA IN EXCEL

INTRODUCTION

Sorting data in a specific order has many uses. Data can be sorted into ascending
(from the smallest to the highest) or descending (from the highest to the smallest)
order and according to any specified column. When sorting data in a workbook the
following should be kept in mind:

» all numeric values come after text values and are sorted in order to magnitude

» numbers entered as text are sorted character by character and therefore ‘12’ will
come before ‘3’

» where two characters are the same, lower case letters will be sorted before
capitals.

TO SORT DATA IN A WORKBOOK

1. Highlight / select ONLY the block of data that should be sorted. Note that
usually column labels are not included but all columns that should form part of
the sorting process must be selected.
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2. Click on the Data menu.

3. Click on Sort. The following screen appears:
Sort | 2] |
Sort by

(ETTT—-] © oo
 Descending
Then by
| =]  hssendng
" Descending
Then by
| =] & ascending
" Descending
My list has
¢ Header row % No header row

4. Indicate which column should be sorted by in the Sort by box. The user can
choose to sort by any column which contains values i.e. column A, B, C, D,
efc.

B If necessary more than one column can be indicted to sort by. To do this,
click on the two boxes Then by and specify the columns.

6. Next to each box the user can specify whether the content should be sorted in
Ascending (from low to high) or Descending (from high to low) order.

7. If the selected area includes a row of labels (headers), click on Header row.

If only the data that has to be sorted is selected, click on No header row.
8. Click on OK and the data will be sorted.

TUTORIAL E4.1
A I B I G D
1 MY BUDGET 2000
2
3 EXPENSE INCOME JAN FEB
4 R2000-00
5 Car R600-00 R600-00
6 House R600-00 R600-00
7 Petrol R100-00 R150-00
8 Food R300-00 R250-00
o Clothes R50-00 R150-00
10
11 Total RX000-xX RY0OO-XxX
12 Difference Rxooot-xx Rxaoo-xx
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1 Open the file BUDGETS uiaw was vicawu in TUTORIAL E3.2.

2. Sort the data in the spreadsheet in descending order of column C.
3. Print the spreadsheet.

4. Sort the data in descending order of column D.

5. Print the spreadsheet.

6. Save the file as BUDGETS.

CREATING CHARTS IN EXCEL

INTRODUCTION

In EXCEL (as in most spreadsheet packages), a chart may be defined as a graphic
representation of spreadsheet data. When you create a chart, Excel plots the chart
shape based upon the data contained within the range of selected cells, as well as
the type of data in the rows and columns.

You can create a chart to be displayed directly on a spreadsheet and save it as part
of the spreadsheet. This is called an embedded chart. Alternatively, you can create a
separate chart sheet. In this case the worksheet and the chart are kept separate.

CHART TYPES

The user can create different types of charts. The best chart to choose, will depend
on the data that has to be represented. The following table is a summary of the most
commonly used chart types:

Chart type Purpose

Pie This chart can be used to show the relationship amongst
parts of a whole.

Bar This chart is used to compare values at a given point in
time.

Column This chart is used to emphasise the difference between
items.

Line This chart is used to emphasise trends and values over
time.
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EXAMPLES OF CHARTS

Column Chart

TERMINOLOGY USED WITH CHARTS

TERM EXPLANATION

Data series The cell references to values that are represented as
bars, pie wedges, lines or other plotted values in
charts.

Categories Categories reflect the number of elements in a series.
Categories usually respond to the columns in the
spreadsheet.

Axis The axis is one side of the spreadsheet. A two-

dimensional chart has an X-axis (horizontal) and a Y-
axis (vertical). The X-axis contains all the data series
and categories in the chart. The Y-axis gives an
indication of the values of the bars, lines or plotied
points.

Gridlines Gridlines emphasise the Y-axis or the X-axis scale of
the data series.

Legend The legend gives a definition of each series of a chart.
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CREATING A CHART
When data is entered into a well organised worksheet, the user is ready to create a
chart. The following example creates a bar chart. The steps given will guide you in
creating a chart.

1. Create the following workbook:
Budget
Description | Jan Feb March
Clothing 100 150 200
Food 20 250 200
Travelling 50 70 30

2. Select the data that will be displayed on the chart.
Budget
Description | Jan Feb March
Clothing 100 150 200
Food 20 250 200
Travelling 50 70 30

3. Click on the Insert menu.

4, Click on Chart. The following dialog box appears:

‘ Chart Wizard - Step 1 of 4 - Chart Type

’Fi.stered Bar, Compares values across
I1:a|:eg:wies.

5. Select the type of chart that has to be created. In the example we want to
select Bar. A number of different bar-chart options are given on the right hand
side of the screen. Select the one you prefer.

6. Click on the Next button. The following dialog box appears:
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O Travelling
B Food
@ Clothing

Series in: & Rows

(2] x]

F Make sure the data range is correct. If necessary, type the correct range in
the required box. Click Next. The following dialog box appears:

Chart Wizard - Step 3 of 4 - Chart Options

s ]| Aves

| Gridines | Legend | DataLabels | Data Table |

Charlgue:
March
Edieww(x)wds
. O Travelling
Yalue (Y) axis: Feb s
@ Clothin
Second category (X) axis:
| sa
Second value (Y) axis: | I ] |
I 0 S0 100 150 200 250 300
Ql Cancel I < Back l Next> |  Finish l

is Rand.

Type in the title Budget in the Chart title box.

Type in a description for the Category (X)-axis i.e. in this case the description

10.  Type in a description for the Category (Y)-axis i.e. in this case the description

is Month.

11.  Click on Legend. The following dialog box appears:

E 34

© Central University of Technology, Free State



Q SECTION E: EXCEL

= Central University of

Technology, Free State

Chaii Wizard - Step 3 of 4 - Chart Dptions 2| X/ l
[ Tiles }| Axes | Gridines | Legend | DataLabels | Data Table |
Chart title: .
[ r
gatlgngmands: b
Value (Y) axis: Feb :::::m '
r & Clothing
Sacond category (X) axis:
r Jan
Second value (Y) axis: } }
I 0 S0 100 150 200 250 300
@) | Cancel | <gack [ wext> |  mnish ]

12.  Select the position of the legends in the Placement option. If you do not want
the legend to be displayed, click on the option Show legend to remove the
check mark in the box.

13.  Click on Next. The following dialog box appears:

Chart Whizaid - Step 4 of 4 - Chart Location Bl |

~Place chart:

|
|l | € Asnewshest:  [charti

—

R cromn T —

_@J Cancel I < Back l Next > “ Finish I

14. In this dialog box, you can choose whether the chart should be displayed As a
new sheet or As object in a specific sheet. In the case of the example, click
on As object in Sheet 1.

15.  Click on Finish. The chart will be displayed in the workbook.
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16.  The chart can now be cuswnnseu vy nanipulating it as an object i.e. it can be
enlarged, moved to different positions in the sheet, etc.
" Microzolt E xcel - manualdoc1 .
®)Ele £t Yew lwent Fgmat Iook Data Window Heb =181 ]
DSW &8RT t&E@S »- Q@ I AN DESE - §
| Arial - 10 -‘n:m}llﬁﬂx.iﬁﬂ‘.## _."&’&'i
E4 F- | =
A BEaiise 1] Eals—Ea| e [ N i |
1_Budget 2
3 Description Jan Feb March
| 4 |Clothing W 150 w1
5 Food 250 200
B Travelling 5 7m0 30
T
3
N
10
KN
2
13 i}
B |
l_.ﬂ |
—:ﬂ il 100 200 300 <
i 470 W \Sheet1 { Sheetz [ Shests / 1«1 i i
Ready I [T WM _
Asn| E9AY Y | mMicoson | Sfjuted -P_|[SMicresa..  of 2 masPm
TO SAVE A CHART
1 Click on the File menu.
2. Click on Save. The chart will be saved in the warkbook.

TO PRINT AN EMBEDDED CHART

i &
Z:

Click on the File menu.
Click on Print.

TO PRINT A SEPARATE CHART

2.

3.
4.

Select the Chart sheet where the chart is displayed.
Click on Print.

|

Nome: jo5HP Leserdet I |
et 1de ‘
Tbe:  HPLaserltmm |
Where:  LPT1: [
|

Select Active sheet(s).
Click on OK.
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